Eleventh Edition, version 9.3

To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in “About MicroStrategy...” in the Help menu of your software.

Document number: 09540930

Copyright © 2012 by MicroStrategy Incorporated. All rights reserved.

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor, the following terms apply:

This software and documentation are the proprietary and confidential information of MicroStrategy Incorporated and may not be provided to any other person. Copyright © 2001-2012 by MicroStrategy Incorporated. All rights reserved.

This software and documentation are provided “AS IS” and WITHOUT EXPRESS OR LIMITED WARRANTY OF ANY KIND BY EITHER MICROSTRATEGY INCORPORATED OR ANYONE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, GOOD TITLE AND NON-INFRINGEMENT, QUALITY OR ACCURACY. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE OR DOCUMENTATION PROVE DEFECTIVE, YOU (AND NOT MICROSTRATEGY, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DISTRIBUTION) SHALL BE LIABLE TO YOU FOR THE TOTAL COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

In no event will MicroStrategy, Inc. or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid to you by any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In no case, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract warranty, negligence, strict liability for the negligence of indemnity or contribution, the failure of any remedy to achieve its essential purpose or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy shall not exceed, at the option of MicroStrategy, Inc., either a full refund of the price paid, or replacement of the Software. No oral or written information given out expands the liability of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc., are prohibited. U.S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplemental to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at FAR 52.227-19, as applicable. Contractor is MicroStrategy, Inc., 1650 Towers Crescent Plaza, Tysons Corner, VA 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.


All other company and product names may be trademarks of the respective companies with which they are associated. Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or commitments concerning the availability of future products or versions that may be planned or under development.

Patent Information

This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,393, 6,279,033, 6,567,796, 6,597,547, 6,606,596, 6,859,093, 6,658,432, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,741,980, 6,765,997, 6,768,788, 6,772,137, 6,788,768, 6,789,867, 6,801,890, 6,820,073, 6,823,334, 6,836,537, 6,850,603, 6,859,798, 6,873,693, 6,885,734, 6,940,953, 6,964,012, 6,979,992, 6,996,568, 6,996,569, 7,003,512, 7,010,518, 7,016,480, 7,020,251, 7,039,165, 7,082,422, 7,113,993, 7,127,403, 7,174,349, 7,181,417, 7,194,457, 7,197,461, 7,228,303, 7,260,577, 7,266,181, 7,272,212, 7,302,639, 7,324,942, 7,330,847, 7,340,040, 7,356,758, 7,356,840, 7,415,438, 7,428,302, 7,430,562, 7,430,563, 7,460,898, 7,486,780, 7,509,671, 7,516,181, 7,559,048, 7,574,376, 7,617,201, 7,725,811, 7,861,967, 7,861,161, 7,861,253, 7,881,443, 7,925,616, 7,945,584, 7,970,782, 8,005,870, 8,051,168, 8,051,369, 8,094,788, and 8,190,818. Other pending patents are pending.

Various MicroStrategy products contain the copyrighted technology of third parties. This product may contain one or more of the following copyrighted technologies:

Graph Generation Engine Copyright © 1998-2012. Three D Graphics, Inc. All rights reserved.

Actuate® Formula One. Copyright © 1993-2012 Actuate Corporation. All rights reserved.

XML parser Copyright © 2003-2012 Microsoft Corporation. All rights reserved.

Xalan XSLT processor. Copyright © 1999-2012. The Apache Software Foundation. All rights reserved.

Xerces XML parser. Copyright © 1999-2012. The Apache Software Foundation. All rights reserved.

FOP XSL formatting objects. Copyright © 2004-2012. The Apache Software Foundation. All rights reserved.

Portions of Intelligent Server memory management Copyright © 1991-2012 Compuware Corporation. All rights reserved.

ASIHTTPRequest library. Copyright © 2007-2012. All-Seeing Interactive. All rights reserved.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)
CONTENTS

Book Overview and Other Resources

Description of this guide ............................................................ ix
About this book ........................................................................... x
Additional formats ................................................................... x
How to find business scenarios and examples ......................... xi
What’s new in this guide ......................................................... xi
Prerequisites ............................................................................ xiii
Who should use this guide .................................................... xiii
Resources ................................................................................ xiii
Documentation ........................................................................ xiii
Education ................................................................................. xxii
Consulting ................................................................................. xxii
International support ............................................................. xxii
Technical Support .................................................................... xxiii
Feedback .................................................................................. xxviii

1. Designing Reports and Documents for iOS and Android Devices

Introduction ................................................................................... 1
Best practices for designing reports and documents for viewing on mobile devices ................................................................. 2
  Best practices for using prompts to filter data .......................... 3
  Best practices for enhancing performance on a mobile device ....................................................................................... 3
  Best practices while planning reports and documents ............. 4
  Best practices while designing reports and documents .......... 6
Creating documents for display on mobile devices .................. 8
  Creating documents for mobile devices using a template ...... 8
  Formatting documents for mobile devices .......................... 10
Contents

Allowing users to access information easily: mobile-friendly panel stacks .............................................................. 18
Creating documents that use Transaction Services to update your data warehouse ................................................. 25

Allowing users to filter data: prompts........................................... 25
  Allowing users to filter data based on a single value:
  Value prompts........................................................................ 27
  Allowing users to choose from a list of attribute elements:
  attribute element prompts ...................................................... 31
  Prompting users for their location: Geo Location prompts..... 34
  Creating Barcode Reader prompts ........................................ 35

Displaying data as interactive visualizations: widgets .......... 36
  Displaying a Data Cloud widget ............................................. 39
  Displaying an interactive event calendar: Date Selection widget .......................................................... 40
  Displaying data in an interactive graph: Graph Matrix widget ........................................................................ 43
  Displaying data in a Heat Map widget...................................... 45
  Displaying data as an overlay on an image: Image Layout widget .......................................................... 45
  Displaying images: Image Viewer widget .............................. 46
  Displaying data in rows and columns: Interactive Grid widget ........................................................................ 49
  Displaying geographical data: Map widget ....................... 53
  Visualizing trends: Microcharts widget ................................. 70
  Visualizing relationships: Network Visualization widget ...... 73

Downloading and viewing multimedia files: Multimedia widget ........................................................................ 74
  Uploading images: Photo Uploader widget ............................. 75
  Displaying RSS feeds: RSS Reader widget ............................. 79
  Displaying data trends: Time Series widget ......................... 82
  Displaying a Timeline widget ................................................ 85
  Displaying widgets using the entire screen on mobile devices ........................................................................ 88

Opening a device’s installed applications from documents .... 90

Linking to documents and reports from a mobile document .... 95
  Creating a link for a mobile document ................................... 97
  Using links to access features within the MicroStrategy Mobile application .................................................. 103

Storing links on NFC tags to open reports, documents, or folders on Android devices ..................................... 105
## 2. Designing Reports and Documents for a BlackBerry

**Introduction** ................................................................. 107

- Best practices for designing Mobile-friendly reports .......... 108
- Best practices for designing Mobile-friendly documents .... 110
- Selecting a data view for a report or document .............. 111
  - Tabular interactive data view ...................................... 111
  - Original layout data view .......................................... 112

## 3. Administering MicroStrategy Mobile

**Introduction** .................................................................. 113

- Overview: MicroStrategy Mobile architecture ................ 114
- Installing and configuring Mobile Server ....................... 115
  - Authentication settings for the Mobile Server application .... 115
  - Privileges and permissions ....................................... 116
  - SSL encryption ......................................................... 117
  - Client authentication with a certificate server .............. 117
  - Destination folder for the Photo Uploader widget ..... 122

- Deploying and configuring the MicroStrategy Mobile application .................................................. 123
  - Deploying MicroStrategy Mobile for iPhone or iPad ...... 123
  - Configuring MicroStrategy Mobile for iPhone or iPad .... 127
  - Deploying MicroStrategy Mobile for Android ................ 134
  - Configuring MicroStrategy Mobile for Android .......... 135
  - Configuring connectivity settings for iPhone, iPad, Android, and BlackBerry devices ............ 140
  - Configuring the home screen for iPhone, iPad, and Android devices ............................................. 144
  - Installing MicroStrategy Mobile for BlackBerry .......... 160
  - Configuring MicroStrategy Mobile for BlackBerry .... 162

- The Mobile subscription workflow ................................... 177
  - Scheduling the report or document ......................... 178
  - Executing the report on Intelligence Server ................. 178
  - Retrieving the report in MicroStrategy Mobile .......... 178
  - Data security in Mobile .............................................. 179

- Managing Mobile report subscriptions ............................. 179
  - Before you subscribe ................................................ 180
  - Managing subscriptions ........................................... 180
  - Managing multiple subscriptions at once with Desktop .... 182
  - Managing subscriptions using Command Manager ....... 186
  - Managing your subscriptions through MicroStrategy Web .................................................. 187
  - Managing subscriptions in MicroStrategy Desktop .... 189

- Enabling real time updates for BlackBerry .................... 191
Enabling real time updates in the project ......................... 191
Enabling real time updates for the user ............................ 192
Troubleshooting MicroStrategy Mobile ............................. 194
Troubleshooting connection issues ................................. 194
Troubleshooting reports and documents .......................... 194
Troubleshooting prompt answers .................................... 195

Glossary .......................................................................................................................... 197

Index .................................................................................................................................... 209
BOOK OVERVIEW AND OTHER RESOURCES

Description of this guide

MicroStrategy Mobile gives users access to MicroStrategy reports and documents on their mobile devices, and allows users to analyze and interact with business data. There are different applications for use on the BlackBerry® smartphone, the Apple© iPhone®, the Apple iPad®, and Android® devices.

This guide discusses how an administrator can install and configure MicroStrategy Mobile on mobile devices and how a designer working in MicroStrategy Desktop or MicroStrategy Web can create reports and documents for use with MicroStrategy Mobile.

Specifically, this guide includes the following:

•  Chapter 1, Designing Reports and Documents for iOS and Android Devices provides best practices for MicroStrategy Desktop and MicroStrategy Web report designers creating or editing reports and documents for use with MicroStrategy Mobile for iPhone. It discusses creating widgets and prompts, and gives tips on creating reports and documents that are easily viewed and understood on a mobile device.
• **Chapter 2, Designing Reports and Documents for a BlackBerry** provides best practices for MicroStrategy Desktop and MicroStrategy Web report designers creating or editing reports and documents for use with MicroStrategy Mobile for BlackBerry. When a report or document is viewed on a mobile device, it can be difficult to see all of its data. These best practices are intended to help designers create reports and documents that users can easily analyze on a mobile device.

• **Chapter 3, Administering MicroStrategy Mobile** describes how to install and configure MicroStrategy Mobile on an Intelligence Server, and how to install and configure the MicroStrategy Mobile client on mobile devices. It also explains how to subscribe to reports and discusses the ways in which administrators can manage multiple subscriptions simultaneously.

### About this book

This book is divided into chapters that begin with a brief overview of the chapter’s content.

The following sections provide the location of additional examples, list prerequisites for using this book, and describe the user roles the information in this book was designed for.

Dates in the MicroStrategy Tutorial project are updated to reflect the current year. The sample documents and images in this guide, as well as the procedures, were created with dates that may no longer be available in the Tutorial project. Replace them with the first year of data in your Tutorial project.

### Additional formats

This book is also available as an electronic publication in the Apple iBookstore, and can be read on an iPhone or iPad with the iBooks app.
installed. To download this book, search for the book’s title in the iBookstore search bar, or scan the QR code below using your device’s camera.

How to find business scenarios and examples

Within this guide, many of the concepts discussed are accompanied by business scenarios or other descriptive examples. Many of the examples use the MicroStrategy Tutorial, which is MicroStrategy’s sample warehouse, metadata, and project with reports. Information about the MicroStrategy Tutorial can be found in the MicroStrategy Basic Reporting Guide.

Other examples in this book use the Analytics Modules, which include a set of pre-created sample reports, each from a different business area. Sample reports present data for analysis in such business areas as financial reporting, human resources, and customer analysis.

Detailed examples of advanced reporting functionality can be found in the MicroStrategy Advanced Reporting Guide.

What’s new in this guide

MicroStrategy 9.3

- You can create a Network Visualization widget to show relationships between items, with each item displayed as a node in the network. For steps, see Visualizing relationships: Network Visualization widget, page 73.

- You can create an Image Layout widget to overlay an image, such as a floor-plan, with data about different areas of the image. For information, see Displaying data as an overlay on an image: Image Layout widget, page 45.
In documents for iPad, you can determine whether a panel stack resets to the first panel when an attribute selector that targets the panel stack is changed. For steps to enable this option, see *Resetting panel stacks when selectors are changed, page 24*.

The Microcharts widget is supported for Android tablets. For steps to create a Microcharts widget, see *Visualizing trends: Microcharts widget, page 70*.

When generating a mobile configuration for Android devices, you can shorten the URL and distribute it to users in an email. For steps to create a mobile configuration URL, see *Generating a URL for a configuration, page 156*.

You can display a progress bar at the bottom of the home screen when you display a report or document as the home screen on the iPad. For steps to display a report or document as the home screen, see *Displaying a single report or document as the home screen, page 146*.

**MicroStrategy 9.2.1m**

You can use Mobile Views to format documents for various screen sizes and device orientations. For instructions, see *Formatting documents for various screen sizes and different orientations: Mobile Views, page 10*.

The following widgets have been added for display on mobile devices:

- Multimedia widget for iPhone and iPad, which allows users to download and view multimedia files, such as videos, PDFs, and ePub books (see *Downloading and viewing multimedia files: Multimedia widget, page 74*).

- Timeline widget for iPad, which allows users to view events or important milestones in the status of a product (see *Displaying a Timeline widget, page 85*).

Where applicable, the instructions for features have been updated to indicate whether they are supported on Android devices. For information on designing documents for mobile devices, including those based on Android, see *Chapter 1, Designing Reports and Documents for iOS and Android Devices*. 
Prerequisites

Before working with this manual you should be familiar with:

- The nature and structure of your company’s data that you will analyze in your business intelligence reports and documents
- The information provided in the *MicroStrategy Basic Reporting Guide* about analyzing report data—and the information about designing reports, if you plan to create reports in MicroStrategy Desktop or MicroStrategy Web for use with MicroStrategy Mobile

Who should use this guide

This document is designed for the following users:

- Administrators who intend to install and configure MicroStrategy Mobile on mobile devices.
- Analysts who intend to run and analyze MicroStrategy reports and documents using MicroStrategy Mobile on a mobile device.

Resources

Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

- **Manuals**: In general, MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started
The steps to access the manuals are described in *Accessing manuals and other documentation sources, page xx*.

Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.

- **Help:** In general, MicroStrategy help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

**MicroStrategy overview and evaluation**

- **Introduction to MicroStrategy: Evaluation Guide**

  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide also includes a detailed, step-by-step evaluation process of MicroStrategy features, where you perform reporting with the MicroStrategy Tutorial project and its sample business data.


  Overview of the installation and evaluation process, and additional resources.

- **Evaluate MicroStrategy for Linux Guide: In a Windows or Linux Environment with the MicroStrategy Evaluation Edition Virtual Appliance**

  Evaluate MicroStrategy for Linux, in a Microsoft Windows or Linux environment, with the MicroStrategy Evaluation Edition Virtual Appliance. This guide provides all details to download, activate, and evaluate MicroStrategy software running in a Linux environment.

- **MicroStrategy Reporting Suite: Quick Start Guide**

  Evaluate MicroStrategy as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Reporting Suite.
• **MicroStrategy Mobile Suite: Quick Start Guide**

Evaluate MicroStrategy Mobile as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Mobile Suite.

### Manuals for query, reporting, and analysis

• **MicroStrategy Installation and Configuration Guide**

Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, as well as basic maintenance guidelines.

• **MicroStrategy Upgrade Guide**

Instructions to upgrade existing MicroStrategy products.

• **MicroStrategy Project Design Guide**

Information to create and modify MicroStrategy projects, and understand facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.

• **MicroStrategy Basic Reporting Guide**

Instructions to get started with MicroStrategy Desktop and MicroStrategy Web, and how to analyze data in a report. Includes the basics for creating reports, metrics, filters, and prompts.

• **MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application**

Instructions for advanced topics in the MicroStrategy system, building on information in the Basic Reporting Guide. Topics include reports, Freeform SQL reports, Query Builder reports, filters, metrics, Data Mining Services, custom groups, consolidations, and prompts.


Instructions for a business analyst to execute and analyze a document in MicroStrategy Desktop and MicroStrategy Web, building on basic concepts about projects and reports presented in the MicroStrategy Basic Reporting Guide.

• **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**
Instructions to design and create Report Services documents, building on information in the *MicroStrategy Report Services Document Analysis Guide*. It is organized to help guide you through creating a new document, from creating the document itself, to adding objects to the new document, and formatting the document and its objects.

- **MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for your Data**

Instructions for designing and creating MicroStrategy Report Services dashboards, a type of document that is optimized for viewing online and for user interactivity. It builds on the basic concepts about documents presented in the *MicroStrategy Report Services Document Creation Guide*.

- **MicroStrategy OLAP Services Guide**

Information on MicroStrategy OLAP Services, which is an extension of MicroStrategy Intelligence Server. OLAP Services features include Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

- **MicroStrategy Office User Guide**

Instructions for using MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, Word, and Outlook, to analyze, format, and distribute business data.

- **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**

Information and instructions for using MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

- **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

Information and instructions to install and configure MicroStrategy Mobile, as well as instructions for a designer working in MicroStrategy Desktop or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.

- **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting your MicroStrategy Business Intelligence System**

Concepts and high-level steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.
• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

Information and instructions for MicroStrategy administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

• **MicroStrategy MDX Cube Reporting Guide**

Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.

### Manuals for Analytics Modules

• **Analytics Modules Installation and Porting Guide**

• **Customer Analysis Module Reference**

• **Sales Force Analysis Module Reference**

• **Financial Reporting Analysis Module Reference**

• **Sales and Distribution Analysis Module Reference**

• **Human Resources Analysis Module Reference**

### Manuals for Narrowcast Services products

• **MicroStrategy Narrowcast Server Getting Started Guide**

Instructions to work with the tutorial to learn Narrowcast Server interfaces and features.

• **MicroStrategy Narrowcast Server Installation and Configuration Guide**

Information to install and configure Narrowcast Server.
• **MicroStrategy Narrowcast Server Application Designer Guide**  
  Fundamentals of designing Narrowcast Server applications.

• **MicroStrategy Narrowcast Server System Administrator Guide**  
  Concepts and high-level steps to implement, maintain, tune, and troubleshoot Narrowcast Server.

• **MicroStrategy Narrowcast Server Upgrade Guide**  
  Instructions to upgrade an existing Narrowcast Server.

**Software Development Kits**

• **MicroStrategy Developer Library (MSDL)**  
  Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.

• **MicroStrategy Web SDK**  
  The Web SDK is available in the MicroStrategy Developer Library, which is sold as part of the MicroStrategy SDK.

• **Narrowcast Server SDK Guide**  
  Instructions to customize Narrowcast Server functionality, integrate Narrowcast Server with other systems, and embed Narrowcast Server functionality within other applications. Documents the Narrowcast Server Delivery Engine and Subscription Portal APIs, and the Narrowcast Server SPI.

**Documentation for MicroStrategy Portlets**

• **Enterprise Portal Integration Help**  
  Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page xx*. 
Documentation for MicroStrategy GIS Connectors

- GIS Integration Help

Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

This resource can be accessed using the MicroStrategy Product Manuals page, as described in Accessing manuals and other documentation sources, page xx.

Help

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

- Help button: Use the Help button or ? (question mark) icon on most software windows to see help for that window.

- Help menu: From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

- F1 key: Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

  For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.
Accessing manuals and other documentation sources

The manuals are available from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Acrobat Reader is required to view these manuals. If you do not have Acrobat Reader installed on your computer, you can download it from http://get.adobe.com/reader/.

The best place for all users to begin is with the MicroStrategy Basic Reporting Guide.

To access the installed manuals and other documentation sources, see the following procedures:

- To access installed manuals and other documentation sources on Windows, page xx
- To access installed manuals and other documentation sources on UNIX and Linux, page xx

To access installed manuals and other documentation sources on Windows

1. From the Windows Start menu, choose Programs (or All Programs), MicroStrategy, then Product Manuals. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2. Click the link for the desired manual or other documentation source.

3. If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select Open this file from its current location, and click OK.

   If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Acrobat Reader.

To access installed manuals and other documentation sources on UNIX and Linux

1. Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is /opt/MicroStrategy,
or $HOME/MicroStrategy/install if you do not have write access to /opt/MicroStrategy.

2 From the MicroStrategy installation directory, open the Documentation folder.

3 Open the Product_Manuals.htm file in a web browser. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

4 Click the link for the desired manual or other documentation source.

5 If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select Open this file from its current location, and click OK.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Acrobat Reader.

### Documentation standards

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| **bold** | • Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions  
Example: Click **Select Warehouse**. |
| *italic* | • New terms defined within the text and in the glossary  
• Names of other product manuals and documentation resources  
• When part of a command syntax, indicates variable information to be replaced by the user  
Example: The *aggregation level* is the level of calculation for the metric.  
Example: Type `copy c:\filename d:\foldername\filename` |
<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| Courier font  | • Calculations  
• Code samples  
• Registry keys  
• Path and file names  
• URLs  
• Messages displayed in the screen  
• Text to be entered by the user  
Example: \( \text{Sum(revenue)/number of months.} \)  
Example: Type `cmdmgr -f scriptfile.scp` and press Enter. |
| +             | A keyboard command that calls for the use of more than one key (for example, `SHIFT+F1`).                                                    |
| !            | A note icon indicates helpful information for specific situations.                                                                      |
| !            | A warning icon alerts you to important information such as potential security risks; these should be read before continuing.            |

**Education**

MicroStrategy Education Services provides a comprehensive curriculum and highly skilled education consultants. Many customers and partners from over 800 different organizations have benefited from MicroStrategy instruction. For a detailed description of education offerings and course curriculums, visit [http://www.microstrategy.com/Education](http://www.microstrategy.com/Education).

**Consulting**

MicroStrategy Consulting Services provides proven methods for delivering leading-edge technology solutions. Offerings include complex security architecture designs, performance and tuning, project and testing strategies and recommendations, strategic planning, and more. For a detailed description of consulting offerings, visit [http://www.microstrategy.com/Services](http://www.microstrategy.com/Services).

**International support**

MicroStrategy supports several locales. Support for a locale typically includes native database and operating system support, support for date formats,
numeric formats, currency symbols, and availability of translated interfaces and certain documentation.

MicroStrategy is certified in homogeneous configurations (where all the components lie in the same locale) in the following languages—English (US), French, German, Italian, Japanese, Korean, Portuguese (Brazilian), Spanish, Chinese (Simplified), Chinese (Traditional), Danish, and Swedish. A translated user interface is available in each of the above languages. For information on specific languages supported by individual MicroStrategy system components, see the MicroStrategy readme.

MicroStrategy also provides limited support for heterogeneous configurations (where some of the components may lie in different locales). Please contact MicroStrategy Technical Support for more details.

**Technical Support**

If you have questions about a specific MicroStrategy product, you should:

1. Consult the product guides, Help, and readme files. Locations to access each are described above.

2. Consult the MicroStrategy Knowledge Base online at [https://resource.microstrategy.com/support](https://resource.microstrategy.com/support).

   A technical administrator in your organization may be able to help you resolve your issues immediately.

3. If the resources listed in the steps above do not provide a solution, contact MicroStrategy Technical Support directly. To ensure the most productive relationship with MicroStrategy Technical Support, review the Policies and Procedures document in your language, posted at [http://www.microstrategy.com/Support/Policies](http://www.microstrategy.com/Support/Policies). Refer to the terms of your purchase agreement to determine the type of support available to you.

MicroStrategy Technical Support can be contacted by your company’s Support Liaison. A Support Liaison is a person whom your company has designated as a point-of-contact with MicroStrategy’s support personnel. All customer inquiries and case communications must come through these named individuals. Your company may designate two employees to serve as their Support Liaisons, and can request to change their Support Liaisons two times per year with prior written notice to MicroStrategy Technical Support.
It is recommended that you designate Support Liaisons who have MicroStrategy Administrator privileges. This can eliminate security conflicts and improve case resolution time. When troubleshooting and researching issues, MicroStrategy Technical Support personnel may make recommendations that require administrative privileges within MicroStrategy, or that assume that the designated Support Liaison has a security level that permits them to fully manipulate the MicroStrategy projects and has access to potentially sensitive project data such as security filter definitions.

**Ensure issues are resolved quickly**

Before logging a case with MicroStrategy Technical Support, the Support Liaison may follow the steps below to ensure that issues are resolved quickly:

1. Verify that the issue is with MicroStrategy software and not a third party software.
3. Attempt to reproduce the issue and determine whether it occurs consistently.
4. Minimize the complexity of the system or project object definition to isolate the cause.
5. Determine whether the issue occurs on a local machine or on multiple machines in the customer environment.
6. Discuss the issue with other users by posting a question about the issue on the MicroStrategy Customer Forum at [https://resource.microstrategy.com/forum/](https://resource.microstrategy.com/forum/).

The following table shows where, when, and how to contact MicroStrategy Technical Support. If your Support Liaison is unable to reach MicroStrategy Technical Support by phone during the hours of operation, they can leave a voicemail message, send email or fax, or log a case using the Online Support
Interface. The individual Technical Support Centers are closed on certain public holidays.

<table>
<thead>
<tr>
<th>Region</th>
<th>Email</th>
<th>Web</th>
<th>Fax</th>
<th>Phone</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td><a href="mailto:support@microstrategy.com">support@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>(703) 842–8709</td>
<td>(703) 848–8700</td>
<td>9:00 A.M.–7:00 P.M. Eastern Time, Monday–Friday except holidays</td>
</tr>
<tr>
<td>EMEA: Europe</td>
<td><a href="mailto:eurosupp@microstrategy.com">eurosupp@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>+44 (0) 208 711 2525</td>
<td></td>
<td>The European Technical Support Centre is closed on national public holidays in each country.</td>
</tr>
<tr>
<td>The Middle East</td>
<td></td>
<td></td>
<td>+44 (0) 208 080 2182</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Africa</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asia Pacific</td>
<td><a href="mailto:apsupport@microstrategy.com">apsupport@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>+61 2 9333 6499</td>
<td>+82 2 560 6565 Fax: +82 2 560 6555</td>
<td>+86 571 8526 8067 Fax: +86 571 8848 0977</td>
</tr>
<tr>
<td>Latin America</td>
<td><a href="mailto:latamsupport@microstrategy.com">latamsupport@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>+54 11 5222 9360 Fax: +54 11 5222 9355</td>
<td>+54 11 5222 9355</td>
<td>+54 11 3044 4088</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+5 11 3054 1010 Fax: +55 11 3044 1010</td>
<td></td>
<td>Latin America (except Brazil): 9:00 A.M.–7:00 P.M. (Buenos Aires), Monday–Friday except holidays</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Brazil: 9 A.M. - 6 P.M. (São Paulo), Monday–Friday except holidays</td>
</tr>
</tbody>
</table>
Support Liaisons should contact the Technical Support Center from which they obtained their MicroStrategy software licenses or the Technical Support Center to which they have been designated.

**Required information when calling**

When contacting MicroStrategy Technical Support, please provide the following information:

- **Personal information:**
  - Name (first and last)
  - Company and customer site (if different from company)
  - Contact information (phone and fax numbers, e-mail addresses)

- **Case details:**
  - Configuration information, including MicroStrategy software product(s) and versions
  - Full description of the case including symptoms, error messages(s), and steps taken to troubleshoot the case thus far

- **Business/system impact**

If this is the Support Liaison’s first call, they should also be prepared to provide the following:

- Street address
- Phone number
- Fax number
- Email address

To help the Technical Support representative resolve the problem promptly and effectively, be prepared to provide the following additional information:

- **Case number:** Please keep a record of the number assigned to each case logged with MicroStrategy Technical Support, and be ready to provide it when inquiring about an existing case
- **Software version and product registration numbers of the MicroStrategy software products you are using**
• **Case description:**
  - What causes the condition to occur?
  - Does the condition occur sporadically or each time a certain action is performed?
  - Does the condition occur on all machines or just on one?
  - When did the condition first occur?
  - What events took place immediately prior to the first occurrence of the condition (for example, a major database load, a database move, or a software upgrade)?
  - If there was an error message, what was its exact wording?
  - What steps have you taken to isolate and resolve the issue? What were the results?

• **System configuration (the information needed depends on the nature of the problem; not all items listed below may be necessary):**
  - Computer hardware specifications (processor speed, RAM, disk space, and so on)
  - Network protocol used
  - ODBC driver manufacturer and version
  - Database gateway software version
  - (For MicroStrategy Web-related problems) browser manufacturer and version
  - (For MicroStrategy Web-related problems) Web server manufacturer and version

If the issue requires additional investigation or testing, the Support Liaison and the MicroStrategy Technical Support representative should agree on certain action items to be performed. The Support Liaison should perform any agreed-upon actions before contacting MicroStrategy Technical Support again regarding the issue. If the Technical Support representative is responsible for an action item, the Support Liaison may call MicroStrategy Technical Support at any time to inquire about the status of the issue.
Feedback

Please send any comments or suggestions about user documentation for MicroStrategy products to:

documentationfeedback@microstrategy.com

Send suggestions for product enhancements to:

support@microstrategy.com

When you provide feedback to us, please include the name and version of the products you are currently using. Your feedback is important to us as we prepare for future releases.
DESIGNING REPORTS AND DOCUMENTS FOR IOS AND ANDROID DEVICES

Introduction

This chapter contains steps to design reports and Report Services documents in MicroStrategy Web, for display and use on mobile devices such as iPhones, iPads, and Android-based phones and tablets. It also contains best practices for designing reports and documents that perform well and are easy to use. The following topics are covered:

• Best practices for designing reports and documents for viewing on mobile devices, page 2. Designing a MicroStrategy Report Services report or document that is viewed on iOS- and Android-based devices requires the use of device-specific document features. This section discusses best practices for using these features.

• Creating documents for display on mobile devices, page 8

• Allowing users to filter data: prompts, page 25. A prompt is a question that the system presents to a user when a report is executed. The user’s answer determines the data that is returned by the report. Specific prompts can be added to a report for use on a mobile device that has the MicroStrategy Mobile application.
• **Displaying data as interactive visualizations: widgets, page 36.** Widgets are sophisticated visualization techniques that allow users to visualize data in different ways than traditional reports displayed as grids or graphs do. A widget can be displayed in a document on a mobile device, and a report can be displayed as a widget on a mobile device.

• **Opening a device’s installed applications from documents, page 90.** You can use links that interact with applications installed with mobile devices, such as email or text messaging.

• **Linking to documents and reports from a mobile document, page 95.** A link lets the user execute another document or report (the target) from a document (the source), and to pass parameters to answer any prompts that are in the target.

**Prerequisites**

• This chapter assumes that you know the nature and structure of your company’s data, which users will analyze in business intelligence reports and documents.

• This chapter assumes that you are familiar with designing MicroStrategy reports and documents and have the necessary privileges to do so.


---

**Best practices for designing reports and documents for viewing on mobile devices**

Designing a report or Report Services document that is viewed on iOS- and Android-based devices requires the use of device-specific document features. This section discusses best practices for using these features.
Best practices for using prompts to filter data

- Create prompts specifically designed for use on mobile devices. Some examples of the prompt types are listed below:
  - Slider, which allows users to answer the prompt by selecting a numeric value on a slider.
  - Stepper, which allows users to answer the prompt by using increment and decrement buttons.
  - Wheel, which allows users to answer the prompt by moving wheels to specify a value.
  - Geo Location, which allows users to filter results based on their current geographical location.
  - Barcode Reader, which allows users to answer the prompt by scanning or typing a barcode.

For steps to create these prompts, see _Allowing users to filter data: prompts, page 25_.

- Prompts that are not specifically designed for mobile devices can still be used. In general, use:
  - The List style for single selections.
  - The Shopping Cart style for multiple selections on iOS devices.
  - The Geo Location style for geographical location data.
  - The Barcode Reader style for barcode data.

Best practices for enhancing performance on a mobile device

- Consider using Intelligent Cubes to provide historical or trend data in your documents. For background information on Intelligent Cubes, and instructions to create reports based on Intelligent Cubes, see the OLAP Services Guide.

- To let users display subsets of data, group data in a document using features such as page-by. Accessing a cached report or document that has multiple pages is faster than re-prompting the report or document, which resubmits the job to the Intelligence Server.
Best practices while planning reports and documents

- For documents that will be displayed on phones, outline how users will navigate them before creating them. Because screen space is limited on mobile phones, content that could be displayed in a single dashboard in MicroStrategy Web may need to be divided among multiple documents when displayed on the device. There are many ways to divide existing reports and documents, as well as many ways a user can navigate between the resulting documents. Prior to developing a document, it is useful to diagram the documents and links that will need to be created. This allows you to identify:

  - The order in which documents must be built. Links must be created after the document they target has already been created.
  - Where duplicate functionality exists. If two documents display different data with the same formatting, you may be able to create one document, duplicate it, and change the datasets to save development time.
  - The datasets that are needed. One dataset can frequently supply data to multiple documents, which can speed up development and reduce cache sizes on the Intelligence Server.

- Create your documents using fonts that are available on the device you are designing for.

- Ensure that the document displays correctly on the mobile device by defining the display properties, available in the Properties dialog box. These properties include optimizing the layout for display on a device, and whether or not the page-by bar and re-prompt icon are displayed. For descriptions of these properties, see Creating documents for display on mobile devices, page 8.

- To allow users to write data to the data warehouse using a mobile device, create documents that use Transaction Services. You must have the Transaction Services product to use this feature.

  For an introduction to Transaction Services, and instructions to create Transaction Services reports, see the MicroStrategy Advanced Reporting Guide. For instructions to create Transaction Services-enabled documents, see the Document Creation Guide.

- Consider the size of the device’s screen when building your reports. Although users can scroll through data, reports with fewer metrics improve performance, and are usually easier to read. In addition, take advantage of the larger screen size available on tablet devices.
• Images are easier to manage if they are hosted on a web server, and referenced using HTTP or HTTPS URLs. That way, if you need to migrate images across environments, you do not need to change the URLs for the images.

An example of an HTTP URL to an image is http://example.com/folder/image.png.

• To take advantage of the high-resolution screens on newer iOS devices, consider using large images in your dashboards.

   If the dashboards are for both older devices and newer devices, add the suffix @2x to the image’s file name. This ensures that the image is appropriately resized for the older device. For example, http://example.com/image@2x.png.

• For reports with grouped data, you can determine whether to display the report on an iPad as a series of pages, with a separate page for each element in the page-by axis. This option, called Enable book-style page-by navigation, is selected by default. For steps to group data in a report, see the Basic Reporting Guide.

• Design documents for tablets in a way that users can view all the data in a single screen without panning. If more data must be displayed than will fit on one screen, consider using panel stacks to arrange the data in a way that the user can navigate by swiping or using selectors.

• In documents for tablets, use Information Windows to show users additional information about an attribute element they select. For information on creating Information Windows, see Providing additional information to users: Information Windows, page 20.

• Use the docked panel selector to display visualizations grouped on panel stacks. For information on creating docked panel selectors, see Allowing users to easily switch between panels: docked panel selectors, page 18.

• In documents for tablets, use the Interactive Grid widget adjacent to a panel stack, and use the Interactive Grid as a selector that targets the panel stack. This allows users to view additional information without linking to a new document.

• If the data in your iPhone or iPad document is frequently updated, you can have the document periodically refresh itself as it is being displayed on a mobile device. For steps, see the MicroStrategy Web Help.
Best practices while designing reports and documents

• Consider using one of the pre-designed templates, which are designed to take the size of the device’s screen into account, when creating documents for mobile devices.

• Enable drilling to allow users the ability to view information at different levels from within a single report. This allows users to get more information from one report without having to browse to, and run, other reports.

• When designing graph reports to be used on a mobile device, consider the following:
  ▪ For tooltips to show on mobile devices, they must be enabled for the graph series when creating the report. For information on enabling tooltips for graph reports, see the MicroStrategy Basic Reporting Guide.
  ▪ To maximize the graph size, move the legend below the graph.
  ▪ The following graph types are supported on Android devices:
    – Bubble
    – Funnel
    – Gauges
    – Horizontal Area
    – Horizontal Bar
    – Horizontal Line
    – Pareto
    – Pie
    – Scatter
    – Vertical Area
    – Vertical Bar
    – Vertical Line

• When designing grid reports, add padding around the cells to make the data more legible on mobile devices.
• Because Android devices come in varying screen sizes, a dashboard designed for iOS can appear different when viewed on an Android device. To provide an attractive display of a dashboard on an Android device, while leaving the display on an iOS device unaffected, use the following properties to modify the dashboard:

  ▪ Use the **Fit Page** and **Fit Width** options to ensure that the document fits to the size of the screen.

  ▪ By default, when the document is displayed on an Android device, any area not used to display the document is rendered in the same color as the background color defined for the document. You can use the Document Fill Color or Layout Watermark to provide a background for any part of the screen that is not used by the rest of the dashboard.

  ▪ Manually size the column widths of any grids on a dashboard, rather than using the automatic resizing options.

• Consider using Mobile Views to support different screen sizes, and different orientations of the device. For instructions on using Mobile Views, see *Formatting documents for various screen sizes and different orientations: Mobile Views, page 10.*

• Consider creating documents that include widgets, rather than converting reports to widgets. Certain features, such as Information Windows and network lines for the Map widget, can only be used in documents.

  For steps to create widgets in documents, see *Displaying data as interactive visualizations: widgets, page 36.*

• If you are creating an Interactive Grid widget, it is recommended that you assign an action to only one attribute form in the widget. For example, if you want one attribute to act as a selector, ensure that drilling is disabled for the Grid/Graph, and that attributes on the Grid/Graph do not link to other reports or documents.

  For steps to create an Interactive Grid widget, see *Displaying data in rows and columns: Interactive Grid widget, page 49.*

• Consider using links to add interactivity to your document. For example, you can create links that allow users to send an email, make a phone call, or execute related reports and documents. For information and the steps to create links, see *Opening a device’s installed applications from documents, page 90* and *Linking to documents and reports from a mobile document, page 95.*

• If you have prompts in a linked-to report, make sure that there are default answers saved for the prompts.
Creating documents for display on mobile devices

This section describes the ways in which you can design Report Services documents for iOS- and Android-based devices, and to use features specifically designed for some devices.

This section assumes that you have created a document with the datasets that you want to analyze. For steps to create a document, refer to the MicroStrategy Document Creation Guide.

Creating documents for mobile devices using a template

A document template allows you to start with a predefined structure when you create a new document. You can use several predesigned templates for your mobile documents to help you create documents that are correctly sized for the device’s screen, as described below.

The following templates are optimized for display on the iPhone and Android smartphones:

- **iPhone Portrait**: This template is designed to be viewed on a smartphone held in a vertical position. Only the Detail Header section of the document is displayed.
  - Width: 6.6 inches
  - Height: 9.6 inches, which includes room for the iPhone status bar
  - Supported iPhone orientation: Portrait only
  - Graph tooltips displayed: Yes

- **iPhone Portrait Micro-Application**: This template is the same as the iPhone Portrait template, except that the Optimize layout for micro application option is selected, preventing users from performing actions such as zooming in or out of the document. This allows you to better control the user’s experience and interaction with the document.
• **iPhone Landscape**: This template is designed to be viewed on a smartphone held in a horizontal position. Only the Detail Header section of the document is displayed.
  - Width: 10 inches. The iPhone status bar is not displayed in landscape view.
  - Height: 6.6 inches
  - Supported iPhone orientation: Landscape only
  - Graph tooltips displayed: Yes

• **iPhone Landscape Micro-Application**: This template is the same as the iPhone Landscape template, except that the Optimize layout for micro application option is selected, preventing users from performing actions such as zooming in or out of the document. This allows you to better control the user’s experience and interaction with the document.

• **iPhone Map Information Window**: You can define an Information Window for a Map widget to be displayed on the iPhone, to display additional information when a user taps a map marker in the widget. Use this template to create a document layout for use as an Information Window. For detailed steps, see *Using a layout as an Information Window in a Map widget, page 61*.
  - Width: 3 inches
  - Height: 2 inches

The following templates are optimized for display on the iPad and Android tablets:

• **iPad Portrait**: This template is designed to be viewed on an iPad held in a vertical position. Only one section of the document is displayed.
  - Width: 8 inches
  - Height: 10 inches, which includes room for the iPad status bar
  - Supported iPad orientation: Portrait only

• **iPad Landscape**: This template is designed to be viewed on an iPad held in a horizontal position. Only one section of the document is displayed.
  - Width: 10.67 inches
  - Height: 7.33 inches
  - Supported iPad orientation: Landscape only
Formatting documents for mobile devices

You can ensure that the document displays correctly on mobile devices by defining the display properties, such as whether the document layout is optimized for mobile phones, and whether the page-by bar and re-prompt icon are displayed.

You can format the display properties at the following levels:

- For each Mobile View. You can create Mobile Views to define how your document appears on different devices, and for different orientations of the device. For example, you can size a graph so that it takes up less vertical space when displayed in the landscape orientation on a device. For instructions to define Mobile Views, see Formatting documents for various screen sizes and different orientations: Mobile Views, page 10.

- In multi-layout documents, for each document layout. For descriptions of the layout display properties, see Formatting document layouts, page 15 and Changing the layout bar style, page 17.

You must use MicroStrategy Web to define these properties. For instructions, see the steps below.

Formatting documents for various screen sizes and different orientations: Mobile Views

You can specify how to display documents on iPhone and iPad by using Mobile Views. Mobile Views allow you to quickly and easily determine how the elements of a document are displayed in the following scenarios:

- When users rotate their devices. For example, you can resize a graph to take advantage of the extra horizontal space when the device is held in landscape orientation, or rearrange the controls on the document to accommodate the extra vertical space when the mobile device is held in portrait orientation.

- When users access the same document from different devices, which may have different screen sizes. For example, you can size text to take up less room on a mobile phone in one Mobile View, or enlarge an image to fit a tablet in another Mobile View. The document is automatically displayed using the Mobile View that most closely matches the height and width (resolution) of the device’s screen.
When you use a Mobile View, controls in the document keep the same basic settings when displayed in different Mobile Views. For example, a selector containing a list of regions targets a graph displaying revenue data. If the user selects the Southeast region from the selector, revenue information for Southeast is displayed in the graph. When the user rotates the mobile device and the document is displayed using a different Mobile View, Southeast remains selected and the data displayed in the graph is unchanged.

**Parameters you can change in Mobile Views**

Once you have added a Mobile View to a document, you can do the following:

- Display a preview of the Mobile View in Design Mode or Editable Mode in Web.
- Edit controls in the Mobile View. You can edit the following options for a control independently in each Mobile View:
  - The position of the control in the document
  - The height and width of the control
  - The height of the control's title bar (for Grid/Graphs, panel stacks, and selectors)
  - Whether the control is hidden. You can determine whether a control will be visible when the Mobile View is displayed on a mobile device. All controls in the document must be included in each Mobile View you define. However, you can hide a control in an individual Mobile View to prevent it from being displayed when the document is viewed on a mobile device. For steps to determine whether a control is visible, see the *MicroStrategy Document Creation Guide*.

    For example, you want to create two Mobile Views, but only want to display a specific grid in the Mobile View for a single mobile device. You must hide the grid in the Mobile View in which you do not want the grid to be displayed.
  - Whether the height and width of the control are automatically determined or are fixed at a specific size
  - The height of a document section
Whether a document section can grow or shrink to fit its contents

Whether to hide a document section if it has no content

Show or hide all controls in the document in Design Mode, regardless of whether they are shown when the document is displayed on a mobile device.

By default, the mobile device tries to display a document using the Mobile View that matches the exact height and width of the device’s screen. If there is more than one Mobile View with the same height and width as the mobile device’s screen, the first of these Mobile Views, as listed in the Manage Views Editor, is used. Otherwise, the mobile device displays the Mobile View whose width most closely matches the width of the mobile device’s screen.

**Using Mobile Views with multi-layout documents**

Documents can contain multiple layouts. Once you create a Mobile View, it is automatically available to every layout in the document.

For example, a multi-layout document contains three layouts. If you create a Mobile View to determine how the document is shown on an iPhone, you must edit the controls in each layout to define how the layouts will be displayed. You can use the Orientation option for Mobile Views in conjunction with the Supported Orientation option for document layouts to determine how a mobile device chooses the best Mobile View to use to display a document layout, as follows:

- If the Supported Orientation of the document layout is set to Both Portrait and Landscape, the document layout is displayed using the Mobile View that most closely matches the height and width of the mobile device, as well as the orientation in which the mobile device is held.

  For example, if the mobile device is held vertically, the mobile device attempts to display the document layout using the Mobile View that has Orientation set to Portrait or Portrait and Landscape, and most closely matches the height and width of the device. If only Mobile Views designed to be displayed in landscape orientation have been defined for the layout, the mobile device chooses the best Mobile View from among those defined and rotates the Mobile View to be displayed vertically, to match the orientation of the mobile device.

- If the Supported Orientation of the document layout is set to either Portrait Only or Landscape Only, the document layout is displayed using the Mobile View that most closely matches the height and width of the mobile device, as well as the Supported Orientation of the layout.
For example, if the Supported Orientation is Portrait Only, the mobile device attempts to display the document layout using the Mobile View that has Orientation set to Portrait or Portrait and Landscape, and most closely matches the height and width of the mobile device. If only Mobile Views designed to be displayed in landscape orientation have been defined for the layout, the mobile device chooses the best Mobile View from among those defined and displays the Mobile View vertically, to match the Supported Orientation of the document layout. The Mobile View is locked to the same orientation as the Supported Orientation option, meaning that if the Supported Orientation is set to Portrait Only and a Mobile View is displayed vertically on the mobile device, the orientation of the layout as displayed on the mobile device remains the same and does not rotate regardless of whether the user rotates the mobile device.

When a document is viewed on the iPhone, the Supported Orientation option determines which layout is displayed on the mobile device. The mobile device then determines the best Mobile View to use to display the layout. For more information on the Supported Orientation setting, see the MicroStrategy Web Help.

---

**To define a Mobile View in a document**

1. In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2. From the **Tools** menu, select **Manage Views**. The Manage Views Editor opens.
   
   A default Mobile View is automatically displayed in the list of Mobile Views, and cannot be deleted.

3. Click the **Duplicate** icon next to an existing Mobile View. A new Mobile View is automatically created.

4. In the **Name** field, type a name for the new Mobile View.

5. Under the **Resolution** column, specify the height and width of the mobile device screen on which to display the Mobile View, as follows:
   
   a. In the first field, type the width, in pixels, of the device screen.
   
   b. In the second field, type the height, in pixels, of the device screen.
You can specify whether the Mobile View is designed to be displayed on a mobile device when the device is held vertically or horizontally. From the **Orientation** drop-down list, select one of the following:

- To display the Mobile View when the device is held vertically, select **Portrait Only**.
- To display the Mobile View when the device is held horizontally, select **Landscape Only**.
- To display the Mobile View when the device is held vertically or horizontally, select **Portrait and Landscape**.

Repeat the appropriate steps above to define each Mobile View.

You can determine which Mobile View to display in Design Mode when the document layout is displayed in Web. Under the **Current** column, select the Mobile View to display.

To delete an existing Mobile View, click the **Delete** icon next to the Mobile View to delete.

You can choose to show all controls in Design Mode in Web, regardless of whether or not they are marked as hidden. For example, you design a Mobile View to be displayed on the iPhone. The Mobile View contains several controls that will be displayed on the iPhone, as well as a grid that is marked as hidden and will not be displayed. You can choose to display all the controls in Design Mode, including the grid. Do one of the following:

- To display all controls in the layout in Design Mode, regardless of whether or not they are hidden, select the **Show hidden objects in Design Mode** check box.
- To display only the controls that are specified as not hidden, clear the **Show hidden objects in Design Mode** check box.

Click **OK** to save your changes.

Add controls to the document, such as text fields, images, graphs, and so on. For steps to add controls to a document, see the *MicroStrategy Document Creation Guide*. When you add a new control to the document, a message is displayed asking if you would like to make the control visible in all Mobile Views. Do one of the following:

- To make the control visible in all views, select **Yes**.
- To make the control visible in only the current Mobile View, select **No**.
To remove a control from a Mobile View, select the control, and press Delete. A message is displayed asking you if you want to delete the control from the document. To hide the control from the current Mobile View, while keeping it visible in all other Mobile Views, select No.

To determine which Mobile View to display in Web

13 From the Tools menu, select Manage Views. The Manage Views editor opens.

14 Under the Current column, select the Mobile View you want to display.

15 Click OK to save your changes.

To delete a Mobile View from a document

16 From the Tools menu, select Manage Views. The Manage Views editor opens.

17 Click the Delete icon next to the Mobile View you want to delete.

18 Click OK to save your changes.

Formatting document layouts

Each layout in a document can be defined to display on an iPhone, iPad, or Android device independently of other layouts within the same document. The following procedure describes the steps to format a document layout for mobile devices.

For an introduction to multi-layout documents, see the MicroStrategy Document Creation Guide.

To define how a document layout will display

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Tools menu, select Document Properties. The Properties dialog box opens.

3 From the left, click Mobile under the Layout Properties section. You can define the following display properties:
• From the Supported Orientations drop-down list, select which orientations you want the layout to support:
  - **Portrait Only** (height is greater than width)
  - **Landscape Only** (width is greater than height)
  - **Portrait and Landscape**

Documents are always displayed on Android tablets in landscape orientation.

4 You can also define the following display properties for documents:

• To display the page-by bar, select the **Display page-by interface** check box.

  Users can tap a button on the page-by bar at the top of a document to select a page-by element to display.

• To display the Filter button when the layout is displayed, select the **Display Filter interface** check box.

  The Filter button allows users to change their prompt answers.

• To use a layout as an Information Window in a Map widget, select the **Use as Information Window for the Map widget** check box.

  An Information Window provides additional details about a location. It is displayed when a user selects a map marker in a Map widget. For more information, see *Using a layout as an Information Window in a Map widget, page 61*.

  If the document is to be displayed on multiple devices, it is recommended that you use a panel stack as the Information Window. For information, see *Providing additional information to users: Information Windows, page 20*.

• To optimize the layout for a micro-application, choose **Optimize layout for micro application**. Optimizing the layout for a micro-application prevents users from performing actions such as zooming in or out of the document, which allows you to better control the user’s experience and interaction with the document.

5 For documents on the iPad, you can choose to always open a document in full screen mode, which also prevents users from exiting the full screen mode. From the left, click **Document**, and select the **Always open this document in full screen mode** check box.
6 Click **Apply**. The Properties dialog box closes.

### Changing the layout bar style

On iPhones, iPads, and Android devices, you can switch between layouts using the layout bar, which may be displayed at the top or bottom of a document. For steps to configure the layout bar, see the following procedure.

To define how the layout bar in a multi-layout document will display

1 In MicroStrategy Web, open the document in Design Mode.

2 From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.

3 From the left, under the Document Properties section, click **Mobile**. You can define the following display properties:

   • From the **Layout bar style** drop-down list, select the style of the layout bar that is displayed on the device. The Layout bar is displayed on the document, and contains icons for each layout in a document.

   □ To display the layout bar as selectable tabs, select **Tabs**.

   □ To allow users to swipe between pages or select an option in the layout bar to display a report or document, select **Swipe**. This displays the layout bar in the location set in the Layout bar position drop-down list.

   • From the **Layout bar position** drop-down list, select the location in which the layout bar is displayed on the device. This option is only available if the Layout bar style is set to Swipe.

   □ To display the layout bar at the top of the screen, select **Top**.

   □ To display the layout bar at the bottom of the screen, select **Bottom**.

   • To enable graph tooltips on the device, select the **Enable graph tooltips** check box.

4 Click **Apply**. The Properties dialog box closes.
Allowing users to access information easily: mobile-friendly panel stacks

In addition to the standard features supported by panels in documents, you can use the following mobile-friendly features:

- Allow users to easily switch between panels using a docked panel selector, which appears as a selector bar at the bottom of a panel stack. See *Allowing users to easily switch between panels: docked panel selectors*, page 18.

- Allow users to switch between panels by swiping. See *Allowing users to switch panels by swiping*, page 19.

- Save screen space by using an Information Window, which is a pop-up window that can display additional details when users tap a selector in a document or a marker in a map widget. See *Providing additional information to users: Information Windows*, page 20.

- In documents for iPad, determine whether a panel stack resets to the first panel when an attribute selector that targets the panel stack is changed. See *Resetting panel stacks when selectors are changed*, page 24.

Allowing users to easily switch between panels: docked panel selectors

A docked panel selector allows users to switch between panels by tapping on circles displayed on a selector bar that appears at the bottom of a panel stack. An example of a panel with a docked selector on the iPad is shown below:
A row of circles, each representing a panel, is displayed in the center of the selector. The current panel is marked with a dark circle. The steps to create a docked panel selector are described below.

**To create a docked panel selector**

1. In MicroStrategy Web, create a new document, or open an existing document in Design Mode.

2. From the **Insert** menu, choose **Panel Stack**. When you move the mouse cursor to the Layout area, the pointer changes to crosshairs.

3. Click and drag in the Layout area to create the panel stack.

**To create and configure a selector for the panel stack**

4. Right-click the panel stack, and choose **Create Panel Selector**. A drop-down selector appears above the panel stack.

5. Right-click the panel selector and choose **Properties and Formatting**. The Properties and Formatting dialog box appears.

6. From the left, choose the **Selector** category.

7. Under **Mobile**, ensure that the **Display selector docked to its panel stack** check box is enabled.

8. Click **OK** to save the changes.

**To add panels and content to the panel stack**

9. Hover the mouse cursor over the panel stack. A toolbar appears above the panel stack.

10. Click **Add Panel** to add panels to the stack.

11. For each panel, click **Add Content**, and add grids or graphs to the panel.

**Allowing users to switch panels by swiping**

You can allow users to change panels in a panel stack by swiping the device’s screen to move to the next or previous panel.
Prerequisites

This procedure assumes that you have created a document with the following:

- A panel stack. For steps to add panel stacks to documents, see the MicroStrategy Web Help.
- A selector that targets the panel stack. For steps to add selectors to documents, see the MicroStrategy Web Help.

To allow users to switch panels by swiping

1. Open the document in Design or Editable Mode.
2. Right-click the selector that targets the panel stack, and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, select General.
4. Select the Allow current panel to be changed without selector check box.
5. Click OK to return to the document.

Providing additional information to users: Information Windows

Information Windows let users view additional information about an attribute element by tapping the element in a grid or graph, or by tapping a location in a Map widget. The Information Window is a panel stack that is
configured to appear as a pop-up window over the element, displaying an additional visualization based on the element. An example of an Information Window in an iPad document is shown below:

In the above example, the Subcategory column in the grid is used as a selector. When a user taps an element in the column, the Information Window is displayed.

To use an Information Window in a document, you must define a panel stack to be used as the Information Window, and a Grid/Graph selector that targets the panel stack, following the procedure below.

**To define an Information Window in a mobile document**

1. In MicroStrategy Web, navigate to the document to add an Information Window to. The document must contain at least one Grid/Graph.
For example, the document shown below contains a basic grid:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Region&gt;</td>
<td>&lt;Employee&gt;</td>
<td>&lt;Revenue&gt;</td>
<td>&lt;Cost&gt;</td>
<td>&lt;Profit&gt;</td>
<td></td>
</tr>
</tbody>
</table>

1. Open the document in Design Mode.

To define the panel stack for the Information Window

2. From the Insert menu, choose Panel Stack. When you move the cursor into the Layout area, the pointer becomes a crosshairs.

3. Click and drag anywhere in the Layout area to create the panel stack. The panel stack is added to the document.

4. Right-click the panel stack, and select Properties and Formatting. The Properties and Formatting dialog box opens.

5. From the left, click General, then type an appropriate name for the panel stack in the Name field. This name appears as the title of the Information Window on the iPad.

6. Select the Use as Information Window for template selectors check box.

7. Click OK to save the changes.

8. Add a grid or graph to the panel stack.
For example, in the document above, a pie chart representation of Revenue for each Year is added to the panel stack, as shown below:

To define a Grid/Graph selector for the Information Window

10 In the report grid, right-click the attribute you want to use as the selector, and choose **Use as Selector**. MicroStrategy Web automatically attempts to find targets for the selector.

In the above example, the Region attribute is used as a selector for the Information Window.

11 To verify that the selector targets the Information Window, right-click the attribute again, and choose **Edit Selector**. The Configure Selector dialog box appears, as shown below.

12 In the Selected Targets list, ensure that the Information Window panel appears in the list.

13 Click **OK**.
Save the document.

For the example above, when the document is executed on an iPad, the Information Window appears when the user taps an element in the Region column, as shown below:

### Resetting panel stacks when selectors are changed

In documents for iPad, you can determine whether a panel stack resets to the first panel when an attribute selector that targets the panel stack is changed. By default, the current panel (the panel that is displayed) does not change when an attribute selector is changed. The steps to enable this option follow.

1. In Web, open the document in Design mode.
2. Right-click the panel stack, and select Properties and Formatting.
3. In the General category, select the Reset to first panel when targeted (Mobile only) check box.
4. Click OK to save your changes.
Creating documents that use Transaction Services to update your data warehouse

You can create documents for iOS and Android devices that allow users to change values in grids, and then write those changes to your data warehouse. This feature is available when you install the Transaction Services product. For an introduction to Transaction Services, see the MicroStrategy Advanced Reporting Guide.

Prerequisites

- You must have the Transaction Services product.
- You must have the Web Configure Transaction privilege.

Overview

The following is a high-level overview of the tasks you need to perform to create a document that uses Transaction Services. Each high-level step describes where to find specific instructions for designing transaction-enabled documents:

- In Desktop, create a Transaction Services report using the Freeform SQL Editor. For instructions, see the MicroStrategy Advanced Reporting Guide.
- In MicroStrategy Web, create a dataset report that includes the attributes and metrics you added to the Transaction Services report above. For instructions, see the Document Creation Guide.
- In MicroStrategy Web, create a document for mobile devices that uses the above dataset report, and link it to the Transaction Services report you created above. For instructions, see the Document Creation Guide.

The values in documents you create using the above procedure can only be edited by users who have the Execute Transaction privilege.

Allowing users to filter data: prompts

A prompt is a question that the system presents to a user when a report is executed. The user's answer determines the data that is returned by the report. Specific prompts can be added to a report for use on a mobile device.
that has the MicroStrategy Mobile application. These prompts are then displayed when the prompted report, or a document that uses the prompted report as a dataset, is executed on the device.

For an introduction to prompts, the basic prompt types, and prompt creation, see the MicroStrategy Web Help.

For steps to answer prompts in MicroStrategy Mobile, see the MicroStrategy Mobile Analysis Guide.

You can display prompts on mobile devices in the following styles:

- **Textbox**: This prompt lets users type a value via a keypad to answer a prompt.
- **Slider**: This prompt lets users select a numeric value on a horizontal slider.
- **Stepper**: This prompt displays a numeric value. Users can tap the increment and decrement buttons to increase or decrease the value for their prompt answer.
- **Switch**: This prompt lets users choose between two choices, On and Off.
- **Wheel**: This prompt displays a wheel or row of wheels that the user can scroll through to specify a date or date and time. On Android devices, this prompt is displayed as a stepper.
- **Calendar**: This prompt lets users select a date from a calendar.
- **Geo Location**: This prompt lets users filter results based on their current geographical location. The prompt includes a request for permission to enable a GPS-style locator. For more information, see Prompting users for their location: Geo Location prompts, page 34.
- **Barcode Reader**: This prompt lets users answer a prompt by scanning or typing a barcode. For more information, see Creating Barcode Reader prompts, page 35.

Prompts for mobile devices are divided into two types: value prompts and attribute element prompts. Value prompts require the user to select a single value, such as a date or number. Attribute element prompts require the user to select from a limited list of available attribute elements.
Allowing users to filter data based on a single value: Value prompts

A value prompt lets users select a single value, such as a date or specific text string, and filter report data based on their selection. The different types of value prompts are:

- **Date and time prompt**: This prompt type asks users to type or select a date, and returns data with the Date data type that matches the user’s selection. For example, the Date prompt can be useful when added to a filter that screens data based on Year=2006. The prompt lets users select a specific date within the year of the filter’s condition. Date prompts are used in filters that qualify on a date.

  Date and time prompts are displayed as wheels on an iPhone or iPad, and are displayed as a date/time stepper on an Android device.

- **Numeric prompt**: This prompt type asks users to type a numeric value. Numeric value prompts accept integers or decimals up to 15 digits of precision. Numeric prompts can be used in any filter that needs a number input from the user. For example, a numeric prompt may be used to filter results where the minimum value for Revenue is entered by the user.

  Numeric prompts can be displayed as text boxes, numeric wheels, sliders, steppers, switches to choose between two numeric values, and location prompts.

- **Text prompt**: This prompt type asks users to type a string of text in a text box.

  Text prompts can be displayed as text boxes, or as barcode reader prompts.

- **Big decimal prompt**: This prompt type asks users for a “big decimal” value. Big decimal value prompts accept integers and decimals up to 38 digits of precision.

  Big decimal prompts can be displayed as text boxes.

For more information about value prompts, see the *MicroStrategy Web Help*. 
To create a value prompt

1 On the MicroStrategy Web home page, click Create Prompt. The Create Prompt page opens, with a list of the types of prompts you can create. Click Value Prompt.

2 Specify the type of value prompt, making your selection based on the table above:
   - **Date and Time prompt**: This prompt lets users filter for data related to either a specific date or a range of dates.
   - **Numeric prompt**: This prompt lets users filter numeric data, usually based on a metric.
   - **Text prompt**: This prompt lets users filter text data, usually based on attribute forms.
   - **Big Decimal prompt**: This prompt lets users filter data based on a big decimal value for a metric.

3 Click the General tab.

4 Specify a title and description for the prompt in the Title and Instructions fields.

To restrict the prompt answers

5 To require users to answer the prompt before running the report, select the Prompt answer is required check box.

6 To set the maximum and minimum values that can be entered by the user, select the Minimum value and Maximum value check boxes and type a value in the respective fields. You can specify a minimum value even if you do not specify a maximum value.

7 To determine whether users can save and reuse their prompt answers, from the Personal answers allowed drop-down list, select one of the following:
   - **None**: Users cannot save and reuse prompt answers.
   - **Single**: Users can save and reuse only one prompt answer.
   - **Multiple**: Users can save and reuse multiple prompt answers.
To specify the layout and display style of the prompt

8 Click the **Style** tab.

9 From the **Display style** drop-down list, specify a presentation style, such as Textbox, for the prompt. This is how the prompt is displayed to the user.

10 Depending on your requirements, choose the appropriate display style and options by referring to the following table:

<table>
<thead>
<tr>
<th>End Goal</th>
<th>Prompt Type and Display Style</th>
<th>Setup Recommendations and Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a date from a calendar</td>
<td>Prompt type: Date &amp; Time</td>
<td><strong>Minimum value</strong>: Specify the earliest date that can be used to answer the prompt.</td>
</tr>
<tr>
<td></td>
<td>Display style: Textbox</td>
<td><strong>Maximum value</strong>: Specify the latest date that can be used to answer the prompt.</td>
</tr>
<tr>
<td>Select a date and/or time from a wheel</td>
<td>Prompt type: Date &amp; Time</td>
<td><strong>Minimum value</strong>: Specify the earliest date and time that can be used to answer the prompt.</td>
</tr>
<tr>
<td></td>
<td>Display style: Textbox</td>
<td><strong>Maximum value</strong>: Specify the latest date and time that can be used to answer the prompt.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Allow user to select time</strong>: Specify whether or not the user can select a time as well as a date to answer the prompt.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Interval</strong> (minutes): Specify the interval displayed between each value on the wheel. For example, an interval of 30 allows users to select times in 30-minute intervals, such as 9:30 A.M., 10:00 A.M., 10:30 A.M., and so on.</td>
</tr>
<tr>
<td>Type a numeric value to answer a prompt</td>
<td>Prompt type: Numeric</td>
<td><strong>Minimum value</strong>: Specify the lowest value that can be used to answer the prompt.</td>
</tr>
<tr>
<td></td>
<td>Display style: Textbox</td>
<td><strong>Maximum value</strong>: Specify the highest value that can be used to answer the prompt.</td>
</tr>
<tr>
<td>Use a switch to choose between two numeric values</td>
<td>Prompt type: Numeric</td>
<td><strong>On value</strong>: Specify the numeric value used when the switch is set to its On position. The default is 1.</td>
</tr>
<tr>
<td></td>
<td>Display style: Switch</td>
<td><strong>Off value</strong>: Specify the numeric value used when the switch is set to its Off position. The default is 0.</td>
</tr>
<tr>
<td>Select a numeric value on a horizontal slider</td>
<td>Prompt type: Numeric</td>
<td><strong>Minimum value</strong> (required): Specify the lowest selectable value in the slider.</td>
</tr>
<tr>
<td></td>
<td>Display style: Slider</td>
<td><strong>Maximum value</strong> (required): Specify the highest selectable value in the slider.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Interval</strong>: Specify the interval displayed between each value on the slider. For example, an interval of 10 allows users to specify values in increments of 10, such as 10, 20, 30, and so on.</td>
</tr>
<tr>
<td>End Goal</td>
<td>Prompt Type and Display Style</td>
<td>Setup Recommendations and Requirements</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use a stepper to increment or decrement a numeric value</td>
<td><strong>Prompt type:</strong> Numeric</td>
<td><strong>Minimum value:</strong> Specify the lowest value that is displayed in the prompt.</td>
</tr>
<tr>
<td></td>
<td><strong>Display style:</strong> Stepper</td>
<td><strong>Maximum value:</strong> Specify the highest value that is displayed in the prompt.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Interval:</strong> Specify the interval used to increment or decrement values in the stepper. For example, if the stepper's minimum value is set to 100, and the interval is 10, users can increment the stepper value to 100, 110, 120, and so on.</td>
</tr>
<tr>
<td>Select a numeric value from a wheel</td>
<td><strong>Prompt type:</strong> Numeric</td>
<td><strong>Minimum value:</strong> Specify the lowest value that is displayed in the prompt.</td>
</tr>
<tr>
<td></td>
<td><strong>Display style:</strong> Wheel</td>
<td><strong>Maximum value:</strong> Specify the highest value displayed in the prompt.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Interval:</strong> Specify the interval displayed between each value on the wheel. For example, an interval of 30 allows users to specify values in increments of 30.</td>
</tr>
<tr>
<td>Filter data based on a user's current location</td>
<td><strong>Prompt type:</strong> Numeric</td>
<td><strong>Mobile preferences:</strong> Select the Latitude or Longitude option to filter data based on the current latitude or longitude. Note: For Geo Location prompts, you must create one prompt for the longitude, and one for the latitude. For a detailed description of the Geo Location prompt, see Prompting users for their location: Geo Location prompts, page 34.</td>
</tr>
<tr>
<td></td>
<td><strong>Display style:</strong> Geo Location</td>
<td></td>
</tr>
<tr>
<td>Type text to answer a prompt</td>
<td><strong>Prompt type:</strong> Text</td>
<td><strong>Minimum number of characters:</strong> Specify the minimum required length of the prompt answer.</td>
</tr>
<tr>
<td></td>
<td><strong>Display style:</strong> Textbox</td>
<td><strong>Maximum number of characters:</strong> Specify the maximum allowable length of the prompt answer.</td>
</tr>
<tr>
<td>Scan or type an item's barcode</td>
<td><strong>Prompt type:</strong> Text</td>
<td><strong>Minimum number of characters:</strong> Specify the minimum required length of the barcode.</td>
</tr>
<tr>
<td></td>
<td><strong>Display style:</strong> Barcode Reader</td>
<td><strong>Maximum number of characters:</strong> Specify the maximum allowable length of the barcode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a detailed description of the Barcode Reader prompt, see Creating Barcode Reader prompts, page 35.</td>
</tr>
<tr>
<td>Type a large number to answer a prompt</td>
<td><strong>Prompt type:</strong> Big Decimal</td>
<td><strong>Minimum value:</strong> Specify the lowest value that can be used to answer the prompt.</td>
</tr>
<tr>
<td></td>
<td><strong>Display style:</strong> Textbox</td>
<td><strong>Maximum value:</strong> Specify the highest value that can be used to answer the prompt.</td>
</tr>
</tbody>
</table>

For examples of each prompt display style, see Allowing users to filter data: prompts, page 25.
To save the prompt

11 To save the prompt, click Save As. The Save As dialog box opens.

12 Specify a name, description, and the location in which to save the prompt and click OK. The Save As dialog box closes, and the prompt is saved.

Allowing users to choose from a list of attribute elements: attribute element prompts

An attribute element prompt lets users select prompt answers from a limited list of specific attribute elements.

The following table provides a list of attribute element prompt types that you can create in MicroStrategy Web for use on a mobile device. To create a prompt that accomplishes a specific goal, find the task you want to perform in the first column in the table, then see the remaining columns for the display style, recommendations, and requirements to create the prompt. For images of each prompt display style, see Allowing users to filter data: prompts, page 25.

For more information about attribute element prompts, see the MicroStrategy Web Help.

To create an attribute element prompt

1 On the MicroStrategy Web home page, click Create prompt.

2 The Create Prompt page opens with a list of the types of prompts that you can create. Click Attribute Element List.

3 To determine the attribute whose elements the user can choose from, click Select Attribute. Select the attribute whose elements are displayed in the prompt and click OK.

To define the elements that the user can choose from

4 Choose one of the following options:

- To display all the attribute elements to users while they are answering the prompt, choose List all elements (no restriction). This option is
recommended only if there are a small number of elements for the attribute.

- To create a list of attribute elements from which users can choose, select **Use a predefined list of elements**. This option is recommended if users need to choose from a specific set of elements.

  To select the elements, click **Add**, then click **OK**. To remove an object, highlight it and click **Remove**. To remove all items, click **Clear**.

- To narrow the list of available attribute elements by using a filter, choose **Use a filter to reduce the number of elements**. This option is recommended for attributes with a large number of elements.

  For example, you can restrict the Customer attribute by only showing the top 100 customers. Browse to and select the filter.

5. Click the **General** tab.

6. Specify a title and description for the prompt in the **Title** and **Instructions** fields.

7. To require users to answer the prompt before running the report, specify whether the prompt requires an answer. Select the **Prompt answer is required** check box.

8. Set the maximum and minimum number of prompt answers allowed, if desired. Enter these numbers in the **Minimum number of answers** and **Maximum number of answers** fields.

9. To determine whether users can save and reuse their prompt answers, from the **Personal answers allowed** drop-down list, select one of the following:

   - **None**: Users cannot save and reuse prompt answers.
   - **Single**: Users can save and reuse only one prompt answer.
   - **Multiple**: Users can save and reuse multiple prompt answers.

10. Click the **Style** tab.

11. You can determine the presentation style used to display the prompt to the user. The default is **Shopping Cart**. From the **Display style** drop-down list, select the presentation style you want to use.
Depending on your requirements, select the appropriate display style and options by referring to the following table:

<table>
<thead>
<tr>
<th>End Goal</th>
<th>Display Style</th>
<th>Setup Recommendations and Requirements</th>
</tr>
</thead>
</table>
| Select a date-based attribute element from a calendar | Calendar | **Minimum date:** Specify the earliest date that users can select.  
**Maximum date:** Specify the latest date that users can select. |
| Select an attribute element from a list | List | **Show search box:** Specify whether or not users are presented with a search box to filter the list of attribute elements.  
**Make search required:** Specify whether or not to require that users search for elements. |
| Use the current geographical location to filter attribute elements | Geo Location | **Select location mapping level:** Select the level at which to filter attribute elements. For example, if this option is set to City, the attribute elements will be filtered to include only those in the current city.  
**Select location mapping attribute:** Select the attribute to use to filter the element list. The location mapping attribute must contain attribute forms for latitude and longitude, and these attribute forms must be visible on the template.  
For a detailed description of the Geo Location prompt, see *Prompting users for their location: Geo Location prompts, page 34*. |
| Scan or type the barcode of an item to search for an attribute element | Barcode Reader | **Show search box:** Specify whether or not users are presented with a search box to filter the list of attribute elements.  
**Make search required:** Specify whether or not to require that users search for elements.  
**Barcode mapping attribute form:** Select the attribute form used to look up barcode information.  
For a detailed description of the Barcode Reader prompt, see *Creating Barcode Reader prompts, page 35*. |

**To save the prompt**

13 To save the prompt, select **Save As**. The Save As dialog box opens.

14 Specify a name, description, and the location in which to save the prompt and click **OK**.
Prompting users for their location: Geo Location prompts

The Geo Location prompt lets users answer a prompt by using their device’s current geographical location. Geo Location prompts are typically used to filter data in a Map widget. For example, a Map widget displays several locations as markers on the map display. You can choose to display only those map markers that are in the user’s current city.

The location name that is returned by a Geo Location prompt is based on Google’s geocoding. The prompt determines the user’s longitude and latitude using the mobile device’s GPS receiver, and passes this information to Google Maps to return information about the user’s location.

You can also use an attribute element prompt to filter attribute elements based on the location of the mobile device. To support attribute element prompts, your MicroStrategy schema must include a location mapping attribute that includes attribute forms for latitude and longitude information.

For example, to filter a list of stores by the state in which the mobile device is located, provide a location mapping attribute that contains attribute forms for the state name, latitude, and longitude.

The attribute that provides the list of attribute elements that are filtered and displayed by the Geo Location prompt, also called the display attribute, does not have to be the same as the location mapping attribute. For example, the Customer State is both the display attribute and the location mapping attribute. When the prompt is displayed on a mobile device, the list of prompt answers is filtered to display the current state, as shown in the image below. Instead, if the display attribute is the Store attribute, and the location mapping attribute is Customer State, the list of prompt answers is filtered to display the stores in the current state, as shown in the image below on the right. Users can select stores from the list for which to display data.
You can:

- Create a prompt that automatically uses the device’s current latitude and longitude. While creating the prompt, you must define two value prompts, one for latitude and one for longitude. The prompts are then automatically answered, and do not display in the mobile device’s interface.

  For steps to create value prompts, see *To create a value prompt, page 28.*

- Create a prompt that filters an attribute element list using the current geographical location, by defining an attribute element prompt with the display style set to Geo Location.

  For steps to create an attribute element prompt, see *To create an attribute element prompt, page 31.*

**Creating Barcode Reader prompts**

The Barcode Reader prompt lets users scan or type an item’s barcode using the device to answer a prompted report or document.

You can add a Barcode Reader prompt to a report or document by defining a prompt and setting its display style to Barcode Reader. The prompt is then displayed as a Barcode Reader when the report or document is executed, as shown below:
The Barcode Reader prompt supports the following types of barcodes:

- UPC-A
- UPC-E
- EAN-8
- EAN-13

You can do the following:

- To allow iPhone and Android users to filter report results based on a product barcode, you can define a value prompt with the display style set to Barcode Reader.

  For steps to create a value prompt, see *To create a value prompt, page 28.*

- To allow iPhone, iPad, and Android users to search for an item in an attribute element list, you can define an attribute element prompt with the display style set to Barcode Reader. If an item’s barcode matches the scanned or typed barcode, its name is returned in the search and can be selected to answer the prompt.

  For steps to create an attribute element prompt, see *To create an attribute element prompt, page 31.*

To support the scanning of barcodes using MicroStrategy Mobile, you must store the barcode data used in the associated prompt with a database data type that supports text data. MicroStrategy recommends using the Varchar data type for your database to store the barcode data. For details about storing data in your warehouse, see the *MicroStrategy Project Design Guide.*

### Displaying data as interactive visualizations: widgets

A widget is a rich, graphical display of the results of data, which allows users to visualize data in different ways than they can when using traditional reports. Widgets are sophisticated visualization techniques that can combine with rich interactivity to enable users to understand their data more effectively.
You can use the following methods to define widgets for mobile devices:

- **Display reports as widgets.** This is recommended if you want to display only one widget on the screen. Note that certain features, such as Information Windows for the Map widgets, require you to create widgets in documents.

  To display reports as widgets, you need to use the Custom Visualizations Editor in MicroStrategy Web. For steps, see the *MicroStrategy Web Help*.

- **Add widgets to documents.** This is recommended if you want to display additional information on the same layout as the widget. Instructions are included in this chapter to create and add widgets to documents.

The following table contains a list of mobile widgets, the mobile devices on which they can be displayed, and links to background information for each widget.

Widgets other than the mobile widgets in this table are displayed as grid or graph reports on mobile devices.

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
<th>Supported devices</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Cloud widget</td>
<td>Displays the names of attribute elements in various font sizes to depict the differences in metric values.</td>
<td>iPhone, iPad</td>
<td>Displaying a Data Cloud widget, page 39</td>
</tr>
<tr>
<td>Date Selection widget</td>
<td>Allows users to view data about events on an interactive calendar.</td>
<td>iPad</td>
<td>Displaying an interactive event calendar: Date Selection widget, page 40</td>
</tr>
<tr>
<td>Graph Matrix Visualization</td>
<td>Displays data using a variety of graph styles, such as the line graph, bubble graph, or grid.</td>
<td>iPad</td>
<td>Displaying data in an interactive graph: Graph Matrix widget, page 43</td>
</tr>
<tr>
<td>Heat Map widget</td>
<td>Allows users to visualize data as rectangles color-coded and sized to depict the differences in metric values.</td>
<td>iPad</td>
<td>Displaying data in a Heat Map widget, page 45</td>
</tr>
<tr>
<td>Image Layout widget</td>
<td>Allows users to visualize data as colored areas or bubble markers overlaid on an image.</td>
<td>iPad</td>
<td>Displaying data as an overlay on an image: Image Layout widget, page 45</td>
</tr>
<tr>
<td>Image Viewer widget</td>
<td>Allows users to browse through a collection of images.</td>
<td>iPhone, iPad, Android</td>
<td>Displaying images: Image Viewer widget, page 46</td>
</tr>
<tr>
<td>Interactive Grid widget</td>
<td>Displays data in a compact tabular layout.</td>
<td>iPhone, iPad, Android</td>
<td>Displaying data in rows and columns: Interactive Grid widget, page 49</td>
</tr>
</tbody>
</table>
Designing Reports and Documents for iOS and Android Devices

Mobile Design and Administration Guide

Displaying data as interactive visualizations: widgets

© 2012 MicroStrategy, Inc.

If you are designing widgets for an iPhone or Android device, you can determine whether the widget takes up the entire screen. For steps, see Displaying widgets using the entire screen on mobile devices, page 89.

Some widgets are also available as interactive visualizations in Visual Insight, which allows you to quickly create a customized, interactive Visual Insight analysis that can be used to explore business data. For steps to create a Visual Insight analysis, see the MicroStrategy Web Help.

The following visualizations can be viewed in a Visual Insight analysis on an iPad:

- Density Map visualization
- Grid visualization
- Graph visualization

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
<th>Supported devices</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map widget</td>
<td>Allows users to search and view information for locations on a map.</td>
<td>iPhone, iPad, Android</td>
<td>Displaying geographical data: Map widget, page 53</td>
</tr>
<tr>
<td>Microcharts widget</td>
<td>Allows users to analyze trends at a glance using compact charts and line graphs.</td>
<td>iPad, Android</td>
<td>Visualizing trends: Microcharts widget, page 70</td>
</tr>
<tr>
<td>Network Visualization widget</td>
<td>Allows users to analyze relationships between items and clusters as a network of connected nodes.</td>
<td>iPad</td>
<td>Visualizing relationships: Network Visualization widget, page 73</td>
</tr>
<tr>
<td>Multimedia widget</td>
<td>Allows users to download and view multimedia files, such as videos, PDFs, and ePub books.</td>
<td>iPhone, iPad</td>
<td>Downloading and viewing multimedia files: Multimedia widget, page 74</td>
</tr>
<tr>
<td>Photo Uploader widget</td>
<td>Allows users to upload images by taking a new image or using an existing image on their mobile device.</td>
<td>iPhone, iPad</td>
<td>Uploading images: Photo Uploader widget, page 75</td>
</tr>
<tr>
<td>RSS Reader widget</td>
<td>Allows users to view and update an RSS news feed.</td>
<td>iPhone, iPad</td>
<td>Displaying RSS feeds: RSS Reader widget, page 79</td>
</tr>
<tr>
<td>Timeline widget</td>
<td>Allows users to view events or important milestones in the status of a product.</td>
<td>iPad</td>
<td>Displaying a Timeline widget, page 85</td>
</tr>
<tr>
<td>Time Series widget</td>
<td>Displays data for a specific period of time in a line graph.</td>
<td>iPhone, iPad, Android</td>
<td>Displaying data trends: Time Series widget, page 82</td>
</tr>
</tbody>
</table>
- Graph Matrix visualization
- Heat Map visualization
- Image Layout visualization
- Map visualization
- Network visualization

**Displaying a Data Cloud widget**

A Data Cloud widget for the iPhone and iPad displays the names of attribute elements in various font sizes to depict the differences in metric values between the elements. This type of widget allows an analyst to quickly identify the most significant, positive, or negative contributions.

A Data Cloud widget is a list of attribute elements. The first metric on the widget's template determines the font size for the attribute elements. A bigger font for an element indicates a larger metric value.

For steps to add a Data Cloud widget to a document and specify formatting options, see the *Dashboards and Widgets Creation Guide*. 

© 2012 MicroStrategy, Inc.

Displaying data as interactive visualizations: widgets 39
Displaying an interactive event calendar: Date Selection widget

The Date Selection widget displays events in an interactive calendar in either a Month, Week, or Day view on an iPad. An example of a Date Selection widget is shown below:

The following are instructions to display a grid as a Date Selection widget on a mobile device. You can also define Information Windows that display when an event is tapped. For instructions on creating an Information Window, see Providing additional information to users: Information Windows, page 20.

Prerequisites

For a report to be used as a Date Selection widget, it must include at least two attributes on the rows. These attributes must meet the following criteria:

- The first attribute represents each day displayed in the calendar, and must contain elements of the Date data type.
- The second attribute provides the events displayed in the calendar, and uses the following attribute forms:
  - The first attribute form contains a description of the event.
  - The second attribute form (optional) contains the image displayed for the event when the widget is shown in Day View. This attribute form must be of the image data type.
The third attribute form (optional) contains the image displayed for the event when the widget is shown in Week View. This attribute form must be of the image data type.

- The third attribute (optional) provides the category name of each event in the calendar, and is used to color-code the events. It uses the following attribute forms:
  - The first attribute form contains the description of the category.
  - The last attribute form (optional) contains the color in which to display the category, stored as a hex value. The value must be of the form 0xFFFFFF or FFFFFFF.

Additional attributes, if any, are displayed in the Day view of the calendar.

---

**To create a Date Selection widget for mobile devices**

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the **Insert** menu, point to **Widgets**, then **Mobile**, and select **Date Selection**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.
4. If desired, resize the widget by clicking and then dragging its handles.
5. From the Dataset Objects panel on the left, select attributes and drag them on to the widget. Place at least two attributes on the Grid/Graph’s rows, as described in the prerequisites above.

---

**Formatting a Date Selection widget**

You can format a Date Selection widget by:

- Selecting whether events in the Month view are grouped by day or week. For steps, see *To select the grouping of events in the Month view, page 42*.

- Automatically assigning colors to event categories. The colors are based on the elements of the categorization attribute of the widget’s dataset. For steps, see *To automatically assign colors to event categories, page 42*. 
• Specifying the color of each event category. For steps, see *To assign a specific color to each category, page 43.*

• Selecting the font color of the Month header in the calendar. For steps, see *To specify the font color in which to display the Month header, page 43.*

**Prerequisites**

The following procedures assume that you have already created the Date Selection widget you want to modify.

---

**To select the grouping of events in the Month view**

1. Open the document in Flash Mode.

2. Right-click the widget, then select **iPad Properties**. The iPad Date Selection dialog box is displayed.

3. From the **Month view is displayed by** drop-down list, select one of the following:
   
   • **Day**: When the widget is shown in the Month view on an iPad, events are grouped by day.
   
   • **Week**: When the widget is shown in the Month view on an iPad, events are grouped by the week.

4. Click **OK** to save your changes.

---

**To automatically assign colors to event categories**

1. Open the document in Flash Mode.

2. Right-click the widget, then select **iPad Properties**. The iPad Date Selection dialog box is displayed.

3. From the **Color events by** drop-down list, select **Attribute**.

4. From the **Series** color palettes, select the colors you want to use to display the event categories. Each color will automatically be assigned to a category and displayed when the widget is viewed on a mobile device.
5 Click **OK** to save your changes.

---

**To assign a specific color to each category**

1 Open the document in Flash Mode.

2 Right-click the widget, then select **iPad Properties**. The iPad Date Selection dialog box is displayed.

3 From the **Color events by** drop-down list, select **Attribute Form**. The events are color-coded based on the attribute form that contains the color for each category.

4 Click **OK** to save your changes.

---

**To specify the font color in which to display the Month header**

1 Open the document in Flash Mode.

2 Right-click the widget, then select **iPad Properties**. The iPad Date Selection dialog box is displayed.

3 From the **Font color for the Month heading** color palette, select a color.

4 Click **OK** to save your changes.

---

**Displaying data in an interactive graph: Graph Matrix widget**

The Graph Matrix widget allows you to quickly analyze various trends across several metric dimensions. The widget consists of several line graphs that allow users to analyze and compare trends in metric data.
An example of the Graph Matrix widget is shown in the image below.

For steps to add a Graph Matrix widget to a document and specify formatting options, see the *Dashboards and Widgets Creation Guide*.

You can also use the Graph Matrix visualization in Visual Insight analyses. For information on creating analyses, refer to the *MicroStrategy Web Help*. 
Displaying data in a Heat Map widget

The Heat Map widget for the iPad displays elements as rectangles and lets users quickly grasp the state and impact of a large number of variables at one time. An example of the Heat Map widget on the iPad is shown below:

You can use MicroStrategy Web to design a document that can display a grid as a Heat Map widget on a mobile device. For steps to add a Heat Map widget to a document and specify formatting options, see the Dashboards and Widgets Creation Guide.

You can also use the Heat Map visualization in Visual Insight analyses. For information on creating analyses, refer to the MicroStrategy Web Help.

Displaying data as an overlay on an image: Image Layout widget

You can add an Image Layout widget to a document to display an image overlaid with colored areas or bubble markers. For example, you can display a map of the United States, with a bubble marker displayed over each state. You can have states with a high number of stores displayed using large bubble markers, and states with a low number of stores displayed using small bubble markers. As another example, you can display the layout of a store in the widget, with each aisle displayed as a separate region, then have MicroStrategy automatically color each aisle based on the number of visits.
each aisle receives. The image below shows an Image Layout widget with a map of the United States, in which each state is displayed as a separate colored region.

![Image Layout widget](image)

You can display the Image Layout widget on an iPad with MicroStrategy Mobile. For steps to add an Image Layout widget to a document and specify formatting options, see the Dashboards and Widgets Creation Guide.

A shape file is an HTML file that contains the image that you want to display in the widget, as well as the location of each bubble marker or area you want to display on top of the image. MicroStrategy provides several default shape files for you to choose from, including a map of countries of the world and a map of states in the United States. You can define your own shape file for use in the widget, using the same steps as you would to customize an Image Layout visualization. For steps, see the MicroStrategy Web Help.

**Displaying images: Image Viewer widget**

Analysts can use the Image Viewer widget to display images, view image descriptions, and zoom in and out of images in a document on an iPhone, iPad, or Android device with MicroStrategy Mobile. For iPhone and iPad, you can choose to display the images in a slide show, filmstrip, or matrix layout, specify the captions to display for each image, format the background and border color of the widget, and so on.
Prerequisites

- You must create an attribute to place on the widget’s Grid/Graph, with the following attribute forms:
  - The first attribute form contains the location in which each image is saved.
  - The second attribute form contains a description of each image.
  - The third attribute form contains the unique numeric ID of each image.

To add an Image Viewer widget to a document

1. Open the document in Design or Editable Mode.
2. From the Insert menu, point to Widgets, then point to Mobile, and select Image Viewer.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.
4. If desired, resize the widget by clicking and then dragging its handles.
5. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on to the Grid/Graph, as described in the prerequisites above.
   - To choose the attribute forms displayed for an attribute in the widget, right-click the header of the attribute, point to Attribute Forms, then select the attribute forms to display.

Configure the widget’s display properties

6. Right-click the widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.
7. From the left, select Widget.
8. Click the Widget Properties icon. The Image Viewer Properties dialog box opens.
9 From the **Display Style** drop-down list, select the display style to use to show images in the widget, as follows:

- To display the images in an interactive slideshow, select **Slideshow** (default). Users can switch between images by performing a horizontal swipe motion on the mobile device.

- To display the images in a filmstrip layout, select **Filmstrip**. Users can scroll through images vertically or horizontally, as determined by the Scroll Direction option described below.

- To display the images in a table layout, with evenly spaced rows and columns, select **Matrix**. You can specify the number of rows and columns displayed in the table using the Number of Rows and Number of Columns options described below.

10 You can determine whether to display images in the widget in a vertical or horizontal layout. This option is only available if the Display Style option is set to Filmstrip. From the **Scroll Direction** drop-down list, select one of the following:

- To display images in a vertical layout, select **Vertical** (default). Users can perform a vertical swipe motion on the mobile device to scroll through the images.

- To display images in a horizontal layout, select **Horizontal**. Users can perform a horizontal swipe motion on the mobile device to scroll through the images.

11 You can determine how many rows of images are displayed in the widget. In the **Number of Rows** field, type the number of rows to display. This option is only available if the Display Style option is set to Matrix.

12 You can determine how many columns of images are displayed in the widget. In the **Number of Columns** field, type the number of columns to display. This option is only available if the Display Style option is set to Matrix.

13 From the **First Caption Line** drop-down list, select the attribute form that contains the first line of captions you want to display for images in the widget.

14 From the **Second Caption Line** drop-down list, select the attribute form that contains the second line of captions you want to display for images in the widget.
You can specify the default action (such as drilling on an attribute or opening a report or document) to perform when the user taps an image caption in the widget. From the **Default Action Form** drop-down list, select an attribute form. The action defined for this attribute form will automatically be performed when the user taps the caption.

From the **Background Color** palette, select the background color of the widget by doing one of the following:

- To display a transparent background color, click **No Fill**.
- To display a solid background color, select the background color from the palette. You can access additional colors by clicking **More Colors**.

From the **Border Color** palette, select the color of the border to display around the images in the widget by doing one of the following:

- To display the borders as transparent, click **No Fill**.
- To display a solid border color, select the border color from the palette. You can access additional colors by clicking **More Colors**.

From the **Border Width** drop-down list, select the thickness of the border to display around the images. The default value is 5 pixels.

Click **OK** to return to the Properties and Formatting dialog box.

Click **OK** to save the changes.

**Displaying data in rows and columns: Interactive Grid widget**

The Interactive Grid widget allows you to display data in a compact tabular layout on an iPhone, iPad, or Android device that has MicroStrategy Mobile downloaded. Attributes and metric values are displayed in columns in the widget, as shown below. You can specify multiple display options for the widget, such as whether to apply banding to the rows in the widget, whether
to display multiple attributes or metrics in a column as stacked together in a single row or allow users to toggle between the values displayed in the column, and so on.

You can allow users to directly edit the data displayed in the widget using a mobile device. For example, you create a widget to display a list of time off requests. A user can tap a button next to each request to display a check mark for approved requests and an X for rejected requests, then submit their changes to their data source. To accomplish this, you must link the widget's Grid/Graph to a Transaction Services report. For steps and background information about Transaction Services, see the Advanced Documents chapter in the Document Creation Guide.

You can allow users to perform an action when they tap an attribute or metric in the widget on a mobile device. To do this, you must assign the action to the attribute or metric on the widget's Grid/Graph in Web. For example, if several customer regions are displayed in an Interactive Grid widget, you can allow users to tap the name of a customer region to update the data displayed in another grid in the document. Only one action can be performed for each attribute or metric. If more than one action is enabled for an attribute or metric, the action with the highest priority is performed. You can enable the following actions for a value in the widget, in order of highest to lowest priority:

- Edit data for the attribute or metric, by displaying the attribute or metric as an input object control in a Transaction Services-enabled document. For steps and background information about Transaction Services, see the Advanced Documents chapter in the Document Creation Guide.
• Use an attribute or metric in the widget as a selector. To do this, you must define the attribute or metric as a selector on the widget's Grid/Graph. For steps, see the MicroStrategy Web Help.

• Open a link to a report or document. For steps to define a link in a widget using the Links Editor, see the Providing Flash Analysis and Interactivity: Widgets chapter in the Dashboards and Widgets Creation Guide.

• Drill on an attribute element. For steps to enable drilling in a Grid/Graph, see the Displaying Reports in Documents: Grid/Graphs chapter in the Document Creation Guide.

The steps to add an Interactive Grid widget to a document follow.

**Prerequisites**

You have already created a dataset report with the following features:

• At least one attribute on the rows. The elements of this attribute are displayed in the first column of the widget.

• At least one metric on the columns. The metric values are displayed in additional columns in the widget.

For instructions to create a report, see the MicroStrategy Basic Reporting Guide.

---

**To create and add an Interactive Grid widget to a document**

1. Open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select Interactive Grid.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.

4. If desired, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on to the Grid/Graph, as described in the prerequisites above.
Configure the widget’s display properties

6 Right-click the widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.

7 From the left, select Widget.

8 Click the Widget Properties icon. The Interactive Grid Properties dialog box opens.

9 By default, the rows of the widget are not banded. To apply banding to the widget, select the Banding check box.

10 By default, the width of the columns in the widget is automatically determined. To manually specify the width of each column, clear the Automatic column sizing check box. In the Width (%) fields, specify the width of each column as a percentage. The widths for all columns should add up to 100.

11 You can allow users to group the data displayed in the widget by selecting an attribute element. Do one of the following:

- To allow users to group the data displayed in the widget, select the Apply Grouping to check box. The first attribute on the widget’s Grid/Graph is automatically used to group the data when the widget is viewed.

- To display the widget without grouping its data, clear the Apply grouping to check box.

12 From the Color Theme drop-down list, select a color theme to use to display the background color, border color, and header color of the widget.

13 You can select a default action (such as drilling on an attribute, opening a report or document, or acting as a selector) to perform for attributes and metrics that have no action defined on the widget’s Grid/Graph. From the Default Action Form drop-down list, select an attribute. The action defined for this attribute will automatically be performed when a user taps a value in the widget for which no action is explicitly defined.

It is recommended that you assign an action to only one attribute form in the widget. For example, if you want one attribute to act as a selector, ensure that drilling is disabled for the Grid/Graph, and that the attribute does not link to another report or document.
14 If you place multiple attributes or metrics in a column, you can choose whether to display each attribute element or metric value stacked together in a single row in the widget, or to allow the user to tap the header of a column to change which attribute or metric value is displayed. Do one of the following:

- To allow users to tap a column header to change which object is displayed, select the **Toggle** check box.
- To display each object as stacked values in a single row, clear the **Toggle** check box. Column headers are not displayed when values are displayed as stacked.

15 You can create, rearrange, or delete columns in the widget:

- To rearrange report objects within the columns, click a report object and drag it to a new location.
- To add a new column to the widget, click **Add Column**. The new column is added and displayed.
- To delete a column, click **x** to the right of the column.

The first two columns in the widget are added to the widget by default and cannot be deleted.

16 Click **OK** to return to the Properties and Formatting dialog box.

17 Click **OK** to save the changes.

**Displaying geographical data: Map widget**

With a Map widget, users can search and view information for locations on a map on an iPhone, iPad, or Android device. You can specify the geographical location of each location on the map by either supplying the location as a spatial point, or by providing separate values for the longitude and latitude.
Locations on the map are displayed as map markers, bubble markers, or color-coded areas. Tapping a location displays an Information Window with additional details about the selected location, as shown below:

You can display data in the Map widget in the following ways:

- Display your data using static images as map markers. You can define a threshold on this metric to change the image used for the map markers. For information on defining thresholds on a metric, see the MicroStrategy Web Help.

- Display your data using bubble markers. The size of each bubble marker is automatically determined based on the value of the metric on the columns of the widget. You can define a threshold on this metric to change the color of the bubble markers. For information on defining thresholds on a metric, see the MicroStrategy Web Help.

- Display your data as areas color-coded based on the population density of locations on the map. For example, you can display areas with a high concentration of stores in red, and areas with a low concentration of stores in blue.

- Create and format a custom Information Window, which is a pop-up window that displays additional data, for the Map widget. For steps to define an Information Window, see Providing additional information to users: Information Windows, page 20.

- Filter the locations displayed on a Map widget to view only those locations that meet certain criteria. For example, if store locations are displayed on the widget, you can limit the displayed stores to only those...
within a specified zip code. For more information on filtering by geographical location, see *Using the Geo Location prompt in the Map widget, page 63.*

For iPhone and iPad documents, once you create a Map widget, you can display lines that show relationships between locations on the map. For steps to use lines for relationships, see *Using lines to display relationships between locations in a Map widget, page 67.*

In order to display your data in the Map widget, you must provide geographical information for each location in the map using attributes or attribute forms. You can provide this data in the following ways:

- During the import data process, you can define an attribute and assign it a geo role to identify what type of geographical information it contains. For example, you can create an attribute called City, which contains the names of multiple cities, then assign it the City geo role. Web automatically creates the City attribute with the attribute forms Latitude and Longitude, which contain the latitude and longitude of each city. You can then use the City attribute to provide latitude and longitude information for locations in the widget. Web automatically adds latitude and longitude information as attribute forms to data columns with the Country, State, Zip Code, City, or Location geo roles. You can also use attributes that have been assigned the Latitude or Longitude geo roles to provide geographical information as attributes, as described in the prerequisites below. For background information on importing data into
MicroStrategy Web, including steps to assign a geo role to an attribute, see the MicroStrategy Web Help. For steps to assign a geo role to an attribute in Desktop, see the Desktop Help.

- Your administrator can create attributes containing location data to support the Map widget. Steps to create location data are included in the Warehouse Structure for Your Logical Data Model chapter in the Project Design Guide.

Creating a Map widget

Prerequisites

The dataset for the map widget must meet the following requirements:

- Place the attribute or attributes containing the geographical information on the rows. The attributes must provide this information in one of two ways:
  
  - To provide the geographical information using attributes, you must provide one of the following:
    
    - One attribute that contains the latitude of each location and one attribute that contains the longitude of each location. For example, you can provide an attribute that has been assigned the Latitude geo role and an attribute that has been assigned the Longitude geo role.
    
    - One attribute that provides geographical information for each location as a point.
  
  - To provide the geographical information using attribute forms, you must provide one of the following:
    
    - One attribute, which provides the latitude and longitude of each location using separate attribute forms. For example, you can provide an attribute that has been assigned the Country, State, Zip Code, City, or Location geo roles.
    
    - One attribute that provides geographical information for each location as a point, using a single attribute form.

  If you are using attribute forms, be sure that the attribute forms containing the geographical information are visible in the grid. Right-click the header of the attribute, point to Attribute Forms, then select the attribute forms you want to display.
• Place at least one metric on the columns. You can define a threshold on this metric to change the display of markers on the map. For more information on thresholds, see the MicroStrategy Web Help.

To create and add a Map widget to a document for mobile devices

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Insert menu, point to Widgets, then Mobile, and select Map.

3 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.

4 If desired, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and metrics, and drag them on to the Grid/Graph, as described in the prerequisites above.

Configure the widget’s display properties

6 Right-click the widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.

7 From the left, select Widget.

8 On the right, ensure that the check boxes for the mobile devices you are designing for are enabled, as applicable.

9 Click the Widget Properties icon. The Map Properties dialog box opens.

10 You can use static images as map markers for locations displayed in the Map widget, display bubble markers instead of map markers, or display your data as areas color-coded based on the population density of locations on the map. Do one of the following:

  • To use map markers to mark locations on the map, select the Use Image Markers option. From the drop-down list, select the marker image to use to display locations on the map. A preview of the selected marker style is displayed to the right of the drop-down list.

  • To use bubble markers to mark locations on the map, select the Use Bubble Markers option. The size of each bubble marker is
automatically determined based on the value of the metric on the columns of the widget.

• To use shades of color to indicate the concentration of locations on the map, select the **Density Maps** option. From the drop-down list, select the color theme to use to automatically color areas on the map.

11 You can specify whether the Map widget displays in Map, Satellite, Hybrid, or Terrain view by default. From the **Default View** drop-down list, select one of the following:

• To display the widget as a map, select **Map**.

• To display the widget as a satellite image, select **Satellite**.

• To display the widget as a satellite image, with boundaries and place names displayed over the image, select **Hybrid**.

• To display the widget as a map with topographical details, select **Terrain**.

12 You can specify the type of magnification to apply to the map when the user selects a location in the widget. From the **Redraw Behavior on Selector Action** drop-down list, select one of the following:

• To maintain the widget's current level of magnification, select **Keep the Current Zoom**.

• To refit the contents of the widget to the selected area, select **Refit the Content**.

13 You can determine how to size bubble markers representing negative metric values. From the **Negative Values are Represented As** drop-down list, select one of the following:

• To use the absolute value of the metric to size the bubble marker, select **Absolute Numbers**. For example, a bubble representing a metric value of -2,500 will be displayed as the same size as a bubble representing 2,500.

• To display bubble markers representing negative metric values as bubbles with a size of 7 pixels, select **Bubbles Sized at 7 Pixels**.

14 You can determine whether or not to apply threshold formatting to image markers or bubble markers in the widget. Do one of the following:

• To enable threshold display, select the **Apply threshold for the map** check box.
- To disable threshold display, clear the **Apply threshold for the map** check box.

15 You can choose to provide geographical information for the widget using attributes or attribute forms. From the **Use Attribute or Form** drop-down list, select one of the following:

- To provide geographical information using attributes, select **Use Attribute**.

- To provide geographical information using attribute forms, select **Use Attribute Form**.

16 You can determine whether to provide geographical information to the widget as a point, or as separate latitude and longitude values. Do one of the following:

- To define the location as a point:
  - From the **Select Data Type** drop-down list, select the **Point** option.
  - If the **Use Attribute or Form** drop-down list is set to **Use Attribute Form**, from the **Select Attribute** drop-down list, select the attribute that contains the attribute form you want to use to display the widget.
  - From the **Select Point** drop-down list, select the attribute or attribute form that contains the point information.

- To define the location as a latitude and longitude:
  - From the **Select Data Type** drop-down list, select the **Latitude/Longitude** option.
  - If the Use Attribute or Form drop-down list is set to Use Attribute Form, from the **Select Attribute** drop-down list, select the attribute that contains the attribute forms you want to use to display the widget.
  - From the **Select Latitude** drop-down list, select the attribute or attribute form that contains the latitude information.
  - From the **Select Longitude** drop-down list, select the attribute or attribute form that contains the longitude information.
17 From the **Selection Display Attribute/Form** drop-down list, select the attribute to use to display data in the Information Window when the user selects locations in the widget.

18 By default, if multiple locations in the widget have the same latitude and longitude—for example, two stores located in the same building—a separate map marker is displayed for each location. If you are designing this widget to be displayed on an iPhone or iPad, you can choose to display a separate map marker for each store, or display a single map marker for all of the stores at that location. Do one of the following:

- To display a single map marker, select the **For repeated rows, display only one marker for same location** check box. When the user taps the map marker on the document, information for each location at the selected latitude and longitude is displayed. If map markers in the widget are displayed as bubble markers and a group of locations are located at the same latitude and longitude, the bubble marker for this group is sized and colored based on the last location in the group, as displayed in the widget. If subtotals are displayed in the widget, the subtotal for the group is used to size and color the bubble marker.

- To display a separate map marker for each location, clear the **For repeated rows, display only one marker for same location** check box.

19 On a mobile device, tapping a map marker on the map displays additional information about the location in an Information Window.

You can define a layout in the document to use as a custom Information Window, and format its appearance. Select the **Display Information Window from document layout** check box. For instructions to configure the layout to use as the Information Window, see *To specify a layout as an Information Window in a Map widget, page 62.*

- From the **Select Layout to use** drop-down list, select the name of the layout to use as the Information Window.

20 Click **OK** to return to the Properties and Formatting dialog box.

21 Click **OK** again to save changes.
Using a layout as an Information Window in a Map widget

When a user taps a map marker in a Map widget on an iPhone, iPad, or Android device, a pop-up window is displayed. This Information Window provides additional details about the location, such as the location name and related metric values, as shown below:

Information Windows are automatically displayed for all markers, using a default layout and format. You can create and format a custom Information Window to display for a Map widget. To define a custom Information Window, you create a document layout, using either Desktop or Web. You then enable the layout to be displayed as an Information Window and specify the layout as the Information Window in the Map widget’s properties. Layouts enabled as an Information Window are not displayed with the other layouts in a document and are only displayed on mobile devices.

If you define an Information Window in a separate document, you can reuse the Information Window layout by importing it into other documents. For instructions on importing layouts, see the MicroStrategy Report Services Document Creation Guide.

Prerequisite

This procedure assumes you have already added a Map widget to the document. For instructions, see To create and add a Map widget to a document for mobile devices, page 57.
To specify a layout as an Information Window in a Map widget

1. In MicroStrategy Web, open the document that contains the Map widget in Design mode.

   **Create the layout to use as the Information Window**

2. From the Insert menu, select Layout. The Insert Layout dialog box opens.

3. Do one of the following to define a style for the new layout:
   - To define a layout style, click the Layout tab, then select a layout style.
   - To import a layout from a saved document, click the Document tab, then select a previously saved document.

4. Click OK. The new layout is displayed.

   **Add content to the layout**

5. The content that you add to this layout is displayed in the Information Window. You can add any controls to the layout, including text fields, Grid/Graphs, images, shapes, and so on. For instructions about designing documents, see the Document Creation Guide.

   The container that displays the Information Window on the iPhone is 1.5 inches wide. Its height is defined to fit to the content, with a maximum height of 1 inch.

   **Enable the layout to be displayed as an Information Window**


7. From the Layout Properties section on the left, select Advanced.

8. Select the Use as Information Window check box.

9. Click OK. The layout is enabled as an Information Window.

   **Specify the Information Window layout to be displayed in the Map widget’s properties**

10. Select the tab of the layout that contains the Map widget, then right-click the widget.
11 Select **Properties and Formatting**. The Properties and Formatting dialog box opens.

12 From the left, select **Widget**.

13 Click the **Widget Properties** icon. The Map Properties dialog box opens.

14 Select the **Display Information Window from document layout** check box.

15 From the **Select Layout to use** drop-down list, select the name of the layout to use as the Information Window.

16 Click **OK** to apply the changes.

17 Click **OK** to return to the document.

**Using the Geo Location prompt in the Map widget**

The Geo Location prompt lets users answer a prompt by using the device’s current geographical location. In a Map widget, a Geo Location prompt is typically used to filter data in the widget. For example, you can choose to display only those map markers that are in your current state.

You cannot add a prompt directly to a document; you must define the prompt on the dataset reports used for the document. For more information on using prompts in documents, see the *Report Services Document Creation Guide*.

You can create the Geo Location prompt to do the following:

- To automatically use the device’s current longitude and latitude to filter the widget’s results, define value prompts with the display style set to Geo Location. You must define two value prompts, one for latitude and one for longitude. The prompts are then automatically answered and do not display in the interface.

- To filter an attribute element list using the current geographical location, you can define an attribute element prompt with the display style set to Geo Location.

Geo Location prompts are defined in MicroStrategy Web. For instructions, see *Prompting users for their location: Geo Location prompts, page 34.*
Filtering data based on geographical distance from a mobile device

You can filter data in a report to display information based on the distance between a location on the report, and the current location of an iPhone, iPad, or Android device. For example, in the image below, a report displays a list of stores.

<table>
<thead>
<tr>
<th>Store Name</th>
<th>Store Latitude</th>
<th>Store Longitude</th>
<th>Store_Point_Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ino Best North</td>
<td>39.18846</td>
<td>-77.26161</td>
<td>18.9389</td>
</tr>
<tr>
<td>Associates First No 1</td>
<td>38.8966159</td>
<td>-77.039657</td>
<td>10.0547</td>
</tr>
<tr>
<td>General Best Urban</td>
<td>38.89497</td>
<td>-77.015834</td>
<td>11.4916</td>
</tr>
<tr>
<td>Spring East Modern</td>
<td>38.9228113</td>
<td>-77.0394214</td>
<td>10.0226</td>
</tr>
</tbody>
</table>

When the report is viewed on a mobile device, the user can choose to display only stores within a ten mile radius, as shown in the image below.

<table>
<thead>
<tr>
<th>Store Name</th>
<th>Store Latitude</th>
<th>Store Longitude</th>
<th>Store_Point_Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>The General East</td>
<td>38.927266</td>
<td>-77.070937</td>
<td>8.3546</td>
</tr>
<tr>
<td>Dollar Best Urban</td>
<td>38.9592429</td>
<td>-77.084408</td>
<td>8.1667</td>
</tr>
<tr>
<td>Lead East East</td>
<td>38.85969662</td>
<td>-77.2207445</td>
<td>3.8991</td>
</tr>
<tr>
<td>General Associates Enterprise</td>
<td>38.926732</td>
<td>-77.162774</td>
<td>6.6486</td>
</tr>
</tbody>
</table>

If the report is displayed as a Map widget, only map markers for stores within a ten mile radius are displayed, as shown below.

To filter data based on the distance from a point of interest to a mobile device, you must first create a metric to calculate this distance. The steps to create this metric are described below.
Once you have created the distance calculation metric, you can use it to filter data by creating a prompt or filter using the metric. For example, you can:

- Create a prompt to allow users to display only data for locations within a specified radius of the mobile device.
- Create a filter to automatically display data only for locations greater than a certain distance from the mobile device.
- In a Map widget, display map markers only for locations within a specified radius.

**Prerequisite**

- You must create an attribute with attribute forms containing the latitude and longitude of each location to use for the distance calculation. For example, the Store attribute in the example above has two attribute forms, Latitude and Longitude, which contain the latitude and longitude information for each store.
- You must create two Geo Location prompts, one each for the latitude and longitude. The prompts must be created as value prompts, as described in *Allowing users to filter data based on a single value: Value prompts*, page 27.

---

**To create a metric to calculate the distance between locations and a mobile device**

1. In Desktop, from the **File** menu, point to **New**, and then **Metric**. The New Metric dialog box opens.

2. Click **OK** to create a new metric. The Metric Editor opens.

3. In the Definition pane, type the formula of the metric you want to create. Use the syntax in the table following this procedure for the metric's definition.

4. Click **Save and Close**. The Save As dialog box opens.

5. In the **Object name** field, type the name of the new metric. Use the name provided in the table below.

6. Navigate to the location in which you want to save the new metric, then click **Save**. The new metric is created.
7 Repeat the appropriate steps above to create each of the metrics required to calculate the distance to each store.

8 Once you have created the distance calculation metric, Point_Distance, you can create any of the following prompts to use the metric:

- A Metric Qualification prompt. You can add the prompt to a report to let users specify a distance radius for which to display data. For information on creating Metric Qualification prompts, see the MicroStrategy Web Help.

- A Metric Set Qualification filter. You can add the filter to a report or to a dataset report in a document, to automatically filter the data using the current location of the mobile device.

- A prompt or filter that will use the metric, added to a report displayed as a Map widget, or to the dataset report of a Map widget in a document. When the Map widget is displayed on a mobile device, only the map markers for locations within the specified distance from the mobile device are displayed.

<table>
<thead>
<tr>
<th>Metric Name</th>
<th>Metric Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location_Lat</td>
<td>Max(AttributeName@LatitudeFormName) Replace AttributeName with the name of the location attribute, and replace LatitudeFormName with the attribute form that contains the latitude information for each location. For example, for an attribute named Store with the attribute forms Latitude and Longitude, create a metric with the name Location_Lat, with the definition Max(Store@Latitude).</td>
</tr>
<tr>
<td>Location_Long</td>
<td>Max(AttributeName@LongitudeFormName) Replace AttributeName with the name of the location attribute, and replace LongitudeFormName with the attribute form that contains the longitude information for each location. For example, for an attribute named Store with the attribute forms Latitude and Longitude, create a metric with the name Location_Long, with the definition Max(Store@Longitude).</td>
</tr>
<tr>
<td>DeltaLat/2</td>
<td>(Radians([Location_Lat] - ?LatitudePromptName) / 2) Replace LatitudePromptName with the name of the value prompt for latitude. For example, if the value prompt is named Latitude, the definition is (Radians([Location_Lat] - ?Latitude)) / 2).</td>
</tr>
</tbody>
</table>
Using lines to display relationships between locations in a Map widget

Once you create a Map widget for an iPhone or iPad, you can show relationships between locations on the map when the widget is displayed on the device. To do this, you display lines between the map markers. You can choose to display these lines using different thicknesses or colors depending on the relationship between locations.

Prerequisites

- The procedure assumes that you have created a Map widget. For more information on the requirements for this widget, see Creating a Map widget, page 56.
- If you provided the location of each map marker in the Map widget using attribute forms, the Latitude, Longitude, and ID attribute forms of the location attribute should be displayed in the Map widget.
- If you provided the location of each map marker in the Map widget using attributes, you must include the lookup attribute on the Map widget.

<table>
<thead>
<tr>
<th>Metric Name</th>
<th>Metric Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeltaLong/2</td>
<td>(Radians (([Location_Long] - ?LongitudePromptName))/2)</td>
</tr>
<tr>
<td></td>
<td>Replace LongitudePromptName with the name of the value prompt for longitude. For example, if the value prompt is named Longitude, the definition is (Radians((([Location_Long] - ?Longitude)) / 2).</td>
</tr>
<tr>
<td>A</td>
<td>((Sin([DeltaLat/2]) * Sin([DeltaLat/2])) + ((Cos(Radians(?Latitude)) * Cos(Radians([Location_Lat]))) * Sin([DeltaLong/2])) * Sin([DeltaLong/2])))</td>
</tr>
<tr>
<td>C</td>
<td>(2 * [Atan2](Sqrt((1-A)), Sqrt(A)))</td>
</tr>
<tr>
<td>Point_Distance</td>
<td>(3959 * C)</td>
</tr>
</tbody>
</table>

**Note:** This value is based on the radius of the Earth, 3,959 miles or 6,371 km. To calculate the distance between the stores and the mobile device using a different unit of distance, replace 3959 with the radius of the Earth in the units you want to use to measure distance. For example, to calculate distance in kilometers, the metric definition is (6371 * C).
You must create a Grid/Graph that is used to display lines in the widget. This Grid/Graph includes the metrics used to determine the color and thickness of lines between map markers, and attributes containing the IDs of the starting and ending locations of each line. The IDs provided must correspond to the IDs used to identify map marker locations in the Map widget. The steps to create this Grid/Graph are below.

To display lines between map markers in a Map widget

1. Open the document in Design or Editable Mode.

To create the Grid/Graph for the relationships

2. From the Insert menu, select Grid/Graph.

3. Click the location on your document in which you want to place the Grid/Graph. This Grid/Graph will not be visible when the widget is displayed on the device, and should be in the same document section as the Map widget.

4. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on top of the Grid/Graph, as described below:

- You must place two attributes on the rows of the Grid/Graph, which must provide the IDs of the starting and ending locations of each line in the widget. The IDs provided must correspond to the ID forms in the attribute used to identify map marker locations in the Map widget. Place the attributes as follows:
  - The first attribute is the lookup attribute for the widget. It must contain a single attribute form containing the ID of the starting location for each line.
  - The second attribute must be a single attribute form containing the ID of the ending location for each line.

- Place at least one metric on the Grid/Graph’s columns:
  - The first metric automatically determines the thickness of each line displayed in the widget, with thick lines representing large metric values. For example, if airports are displayed in the Map widget, and the lines represent flights between each airport, you can add the Passenger Count metric to the Grid/Graph. When the widget is displayed on a mobile device, the flights with the most
passengers are displayed with thick lines, while flights with less passengers are displayed with thin lines.

To display each line using the same thickness, you can provide a metric with a constant value.

The second metric is used to determine the color of each line in the widget. By default, each line in the widget is displayed using the default color. You can override the default color by defining a threshold to change the font color of the metric values that meet the threshold condition. For information on creating thresholds, refer to the MicroStrategy Web Help.

If only one metric is placed on the columns, all lines will display using the default color.

5 The ID attribute form of each attribute must be displayed in the Grid/Graph you just created. If they are not displayed, for each attribute, right-click the header of the attribute, point to Attribute Forms, then select the attribute forms you want to display.

6 If you provided the location of each map marker in the Map widget using attributes, you must include the lookup attribute on the Grid/Graph that you just created to display lines between the map markers. Place the lookup attribute on the rows of the Grid/Graph, directly before or directly after the attributes providing the latitude and longitude of each map marker.

To enable the line display

7 Right-click the Map widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.

8 From the left, click Advanced.

9 Clear the Enable incremental fetch on grid check box, and click Apply.

10 From the left, select Widget.

11 Click the Widget Properties icon. The Map Properties dialog box opens.

12 To enable the display of lines, select the Display Affinity Lines/Arcs check box.

13 If the Use Attribute or Form option is set to Use Attribute, from the Select Lookup Attribute drop-down list, select the lookup attribute.
14 From the **Select Affinity Data** drop-down list, select the Grid/Graph that you created above.

15 From the **Draw Arcs/Lines** drop-down list, select **Arcs** to display curved lines or **Lines** to display straight lines.

16 From the **Max Line Thickness** drop-down list, select the maximum thickness that can be used to display lines in the widget. The thickness of each line is automatically determined based on the value of the first metric on the new Grid/Graph’s rows. The default value is 5.

17 Click **OK** to return to the Properties and Formatting dialog box.

18 Click **OK** to save changes and return to the document.

**Visualizing trends: Microcharts widget**

The Microcharts widget for iPad and Android tablets lets users visualize trends in a metric at a quick glance. Depending on the number of metrics used in the underlying report, the Microcharts widget can display one, two or three microcharts. For example, bar and sparkline microcharts convey trends in a metric, and bullet microcharts compare a metric’s actual value to its targets. An example of a Microcharts widget is shown below:

![Microcharts widget example](image)

The Microcharts widget can be used in the following modes:

- **Grid mode**: This is the default setting. In this mode, all attributes except the last one from the left are grouped and displayed as rows in the widget.

- **KPI List mode**: In this mode, key performance indicators (KPIs), such as Profit, Revenue, and so on, are displayed in a list. Each KPI is represented by its own row of microcharts.
For iPad documents, in both Grid and KPI List mode, you can choose to display data in multiple columns, as shown above, or one column at a time, as shown below:

<table>
<thead>
<tr>
<th>Metrics</th>
<th>TY vs. LY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Cases EOM</td>
<td></td>
</tr>
<tr>
<td>New Cases</td>
<td></td>
</tr>
<tr>
<td>% Critical Cases</td>
<td></td>
</tr>
<tr>
<td>Closed Cases</td>
<td></td>
</tr>
<tr>
<td>% Closed under 1 week</td>
<td></td>
</tr>
<tr>
<td>Avg. Resolution Time (days)</td>
<td></td>
</tr>
</tbody>
</table>

Users can tap the column to cycle through the available columns in the Microcharts widget.

Ticker mode, Vertical Scroll mode, and the tree display are not available for the iPad.

Creating a Microcharts widget

Prerequisites

In a document, create a Grid/Graph that meets the following minimum requirements:

- For a Microchart widget in Grid mode, the report must have at least two attributes in the rows. The last attribute from the left is used as the X-axis for the bar graph and sparkline microchart.

- For a Microchart widget in KPI List mode, the report must have only one attribute in the rows.

- At least two metrics in the columns. The first metric from the left determines the height of the bars for the bar microchart, and the peaks of the sparkline microchart. The second metric displays a horizontal reference line for both microcharts.

For steps to create a Microcharts widget, and for more information on creating Grid/Graphs that meet the data requirements for the
Microcharts widget, as well as variations of the widget based on the number of metrics used, see the *Dashboards and Widgets Creation Guide*.

**Displaying the Microcharts widget in KPI List mode**

By default, if the Grid/Graph has only one attribute row, the Microcharts widget displays in KPI List mode. To configure other properties of the widget, you must run the document in Flash Mode in MicroStrategy Web, and then change the properties, as described in the steps below.

You must determine how many of the metrics to use for each KPI. For example, if you specify three metrics for each KPI, the first three metrics from the left are used for the first KPI, the next three for the second, and so on.

---

**To display the Microcharts widget in KPI List mode**

1. In MicroStrategy Web, navigate to the document where you have defined the Microcharts widget, and open it in Flash Mode. The document should open with the Microcharts widget displayed.

2. Right-click the Microcharts widget, and select *Properties*. The Microcharts properties dialog box opens.

3. From the drop-down list at the top left, choose *Mode*. If your widget has a single attribute row, the *KPI List Mode* check box is enabled by default.

   ! If the widget contains more than one attribute, the *KPI List Mode* check box is disabled.

4. In the *Metrics per KPI* field, type the number of metrics to use for each KPI.

5. Click *OK*.

6. Click *Save* to save the document.
Displaying the Microcharts widget with a single column

You can display the Microcharts widget with a single column in both Grid and KPI mode. To enable this option, you must run the document in Flash Mode in Web.

To display the Microcharts widget with a single column

1. In MicroStrategy Web, navigate to the document where you have defined the Microcharts widget and open it in Flash Mode. The document opens with the Microcharts widget displayed.
2. Right-click the Microcharts widget and select Properties. The Microcharts Properties dialog box opens.
3. From the drop-down list at the top left, select Mode.
4. Select the Display a single metric column at a time check box, and click OK.
5. Click Save to save the document.

Visualizing relationships: Network Visualization widget

You can create a Network Visualization widget to allow analysts to quickly and easily identify relationships between related items and clusters, such as when visualizing a social network or displaying a market basket analysis. Attribute elements are displayed as nodes in the visualization, with lines (called edges) drawn between the nodes to represent relationships between elements. Once the visualization is created, users can view characteristics of the nodes and the relationships between them, using display options such as node size, edge thickness, and edge color.

For steps to add a Network Visualization widget to a document and specify formatting options, see the Dashboards and Widgets Creation Guide.

You can also use the Network visualization in Visual Insight analyses. For information on creating analyses, refer to the MicroStrategy Web Help.
Displaying data as interactive visualizations: widgets

© 2012 MicroStrategy, Inc.

Downloading and viewing multimedia files: Multimedia widget

You can allow users to browse and view files in a web folder, such as documents, images, and videos, using a Multimedia widget. When viewed on an iPhone or iPad with MicroStrategy Mobile, the Multimedia widget displays a list of available files, along with information about each file, including the file name, description, and file type. Users can tap the Download icon next to a file displayed in the widget to download and view the file. When the mobile device is offline, users can view files that have been downloaded and automatically stored on their mobile device. Files that have not been stored on the mobile device are greyed out and cannot be viewed offline.

Users can view the following types of files using the Multimedia widget:

- Audio and video files
- ePub files
- Excel
- HTML
- Image
- PDF
- Plain text
- PowerPoint
- Word

Prerequisites

Before creating a Multimedia widget, you must perform the following tasks:

- Create the document in which to insert the Multimedia widget.
- Configure an XQuery database instance to retrieve web folder contents. For steps to configure this database instance, see the Custom SQL Queries: Freeform SQL and Query Builder chapter in the Advanced Reporting Guide.
- Create an XQuery report to use to access the web folder that contains the files to display in the widget. Add the XQuery report as a dataset report in the document. For steps to create the XQuery report, see the Custom SQL Queries: Freeform SQL and Query Builder chapter in the Advanced Reporting Guide.
To create and configure a Multimedia widget

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the Dataset Objects panel on the left, click and drag the dataset report to the area of the document in which to display the widget. The attributes on the Grid/Graph of the dataset report should be displayed in the following order:
   - MW_URL
   - MW_Name
   - MW_ModifiedOn
   - MW_ModifiedOnText
   - MW_DBIGUID
   - MW_Description
3. Right-click the dataset report, then select Properties and Formatting. The Properties and Formatting dialog box opens.
4. From the left, click Widget.
5. From the Widget drop-down list, point to Mobile, then select Multimedia.
6. Click OK to save your changes and return to the document.

Uploading images: Photo Uploader widget

Analysts can use the Photo Uploader widget to upload images from an iPhone, iPad, or Android device. A user can choose to take a new photo to use as an image, use an existing image on his mobile device, or delete images.

For example, you can add the Store attribute to the widget’s Grid/Graph, and then add a prompt to the document to allow users to select a store. Users can run the document, then select the store in which they are taking a picture with their mobile devices. When the image is uploaded, the name of the store is stored in the user’s data source, along with the description of the image and the location in which the image is stored. For steps to create prompts, see Allowing users to filter data: prompts, page 25.
Displaying data as interactive visualizations: widgets

© 2012 MicroStrategy, Inc.

Prerequisites

- You must have the Transaction Services product.
- You must have the Web Configure Transaction privilege.
- This procedure assumes you have already created attributes and metrics to place on the widget. The widget is used to store information about the images before they are uploaded and must contain a placeholder row of data for each image you want to upload. The data in these rows is updated when users upload images. The following attributes and metrics must be created:
  - One attribute that contains the following attribute forms:
    - The first attribute form is the location in which each image is saved. The values may be blank or placeholders, and are updated with new paths when users upload images.
    - The second attribute form contains a description of each image, as provided by the user.
    - The third attribute form (optional) contains a unique numeric ID of each image that the user uploads.
  
  Note the following:
  - The number of placeholder rows in the widget determines the maximum number of images users can upload. For example, if you create a widget with 20 rows, users can upload a maximum of 20 images.
  - To choose the attribute forms displayed for an attribute in the widget, right-click the header of the attribute, point to Attribute Forms, then select the attribute forms you want to display.
  - Two metrics, as follows:
    - The first metric is used to indicate whether or not the image has been uploaded.
    - The second metric (optional) contains the sum of the values in the first metric, and is used to display the number of images the user has uploaded.
  
  You can provide additional information about an uploaded image by placing additional attributes and metrics on the widget. For example, you can add the Store attribute to the widget, and then add a prompt to the document to allow users to select a store. Users can run the
document, then select the store in which they are taking a picture with their mobile devices. When the image is uploaded, the name of the store is stored in the user’s data source, along with the description of the image and the location in which the image is stored. For steps to create prompts, see *Allowing users to filter data: prompts, page 25*.

- This procedure assumes you have already created a Transaction Services report to link to the widget. There must be an attribute form or metric displayed in the widget (described above) for each input object in the Transaction Services report. For steps to create a Transaction Services report, see the *MicroStrategy Advanced Reporting Guide*.

---

**To add a Photo Uploader widget to a document**

1. Open the document in Design or Editable Mode.

2. From the **Insert** menu, point to **Widgets**, then point to **Mobile**. Select **Photo Uploader**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.

4. If desired, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on to the Grid/Graph, as described in the prerequisites above.

6. To link the widget to the Transaction Services report, right-click the widget’s Grid/Graph, then select **Configure Transaction**. The Configure Transactions dialog box opens.

7. Click ... (the Browse button), then navigate to and select the Transaction Services report to link to.

8. A list of the attributes and metrics that can be modified in the Transaction Services report is displayed in the Transaction Input column. Perform the following steps for each input object:

   a. From the **Grid Object** drop-down list, select the attribute form or metric to link to the input object.
b You can choose whether users can edit the value of each input object. Do one of the following:

– To allow users to edit the value of the input object, select the **Editable** check box.

– To prevent users from editing the value of the input object, clear the **Editable** check box.

You must define the first metric on the columns of the widget to be editable. This metric indicates whether the image has been uploaded.

c From the **Transaction Input** drop-down list, choose a control to display the input as, such as a text box, slider, and so on.

9 Repeat the appropriate steps above to define and format the control to display for each input object.

10 Click **OK** to save your changes and return to the document.

11 To create a button for users to submit a photo, from the **Insert** menu, point to **Selector**, then select **Action Selector Button**.

12 Click the section of the Layout area in which you want to place the selector. Right-click the selector, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.

13 From the left, click **General**, then in the **Display Text** field, type the text you want to display on the button or link; for example, **Submit**.

14 By default, a descriptive title bar is displayed for the selector. You can determine whether to display the title bar. Do one of the following:

• To display the title bar, select the **Show Title Bar** check box and type the title you want to display in the field.

• To display the selector button or link without the title bar, clear the **Show Title Bar** check box.

15 From the left, click **Selector**. From the **Action Type** drop-down list, select **Submit**.

16 By default, the selector button or link targets each Grid/Graph and panel stack in the document section in which it is placed. You can choose the targets of the selector manually instead. To do so, click **Click here**, then use the right arrow to move the target Grid/Graph or panel stack from the
Available list to the Selected list. For additional information on working with selectors, see the MicroStrategy Web Help.

17 Select the appropriate options to define the selector. For the full steps to define an action selector button, see the Report Services Document Creation Guide.

18 Click OK to save your changes and return to the document.

Displaying RSS feeds: RSS Reader widget

You can provide an RSS feed on the iPhone and iPad. RSS (Rich Site Summary, or Really Simple Syndication) is a data format used to display updated content from a website. An RSS document is called a feed. It contains either a summary of the content from an associated website or the full text.

The RSS Reader widget allows users to compare data in the dashboard with information from external news feed sources. The widget retrieves news from an RSS news feed and displays it alongside the other components of the dashboard. The RSS feed is automatically reloaded to display the most up-to-date news about a variety of topics that you specify.

You can add an RSS Reader widget to a document, then display the widget when the document is viewed on a mobile device, as shown in the image above. Users can select an RSS feed to display a list of news items, then select an item to display from the list. For steps to create an RSS Reader widget and add it to a document, see the Dashboards and Widgets Creation Guide.
Formatting an RSS Reader widget for mobile devices

You can format how the widget is displayed when viewed on the mobile device. For example, you can change the color in which the titles of RSS feeds are displayed, or the background color used for news items that are selected in the widget.

The table below suggests formatting ideas and provides steps to format how an RSS Reader widget is displayed on the mobile device.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Specify the URL of the RSS feed to display in the widget | 1 In Flash Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
  2 On the General tab, type the URL of the RSS feed in the Default RSS Field. To specify multiple URLs, type ?? between each URL. For example:  
  3 Click OK to apply your changes. |
| Specify the title of the RSS feed displayed in the widget | 1 In Flash Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
  2 On the General tab, type the title of the RSS feed in the RSS Reader Title field. To specify titles for multiple RSS feeds, type ?? between each title. For example, you can type Business??World News to create two RSS feeds, one named Business and the other named World News.  
  3 Click OK to apply your changes. |
| Select the color in which the titles of RSS feeds are displayed | 1 In Flash Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
  2 On the General tab, select a color from the RSS Reader Title Color palette.  
  3 Click OK to apply your changes. |
| Select the background color of the widget | 1 In Flash Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
  2 On the General tab, select a color from the Background Color palette.  
  3 Click OK to apply your changes. |
| Select the color of the widget’s border | 1 In Flash Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
  2 On the General tab, select a color from the Border Color palette.  
  3 Click OK to apply your changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Select the background color to use to display news items in the widget                      | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsItem** tab, select **Colors** from the first drop-down list.  
3 Select **Background** from the second drop-down list.  
4 Select a color from the **Background** color palette.  
5 Click **OK** to apply your changes. |
| Select the background color displayed for news items when a cursor hovers over the item in the widget | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsItem** tab, select **Colors** from the first drop-down list.  
3 Select **Rollover Background** from the second drop-down list.  
4 Select a color from the **Rollover Background** color palette.  
5 Click **OK** to apply your changes. |
| Select the font color to use to display news items in the widget                             | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsItem** tab, select **Colors** from the first drop-down list.  
3 Select **Font** from the second drop-down list.  
4 Select a color from the **Font Color** palette.  
5 Click **OK** to apply your changes. |
| Select the font color to use to display news items when a cursor hovers over the item in the widget | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsItem** tab, select **Colors** from the first drop-down list.  
3 Select **Rollover Font** from the second drop-down list.  
4 Select a color from the **Rollover Font Color** palette.  
5 Click **OK** to apply your changes. |
| Select the font color to use for news items that have been read                             | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsItem** tab, select **Colors** from the first drop-down list.  
3 Select **Read Articles** from the second drop-down list.  
4 Select a color from the **Read Articles** color palette.  
5 Click **OK** to apply your changes. |
| Select the background color to use to display news items that are selected in the widget     | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsDetail** tab, select a color from the **Background Color** palette.  
3 Click **OK** to apply your changes. |
| Select the font color to use to display news items that are selected in the widget           | 1 In Flash Mode, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 On the **NewsDetail** tab, select a color from the **Font Color** palette.  
3 Click **OK** to apply your changes. |
Displaying data trends: Time Series widget

The Time Series widget displays data over a specific period of time on an iPhone, iPad, or Android device. This widget is displayed as a line graph on the device. You can configure the widget to display multiple data series on the same graph. An example of a Time Series widget on an iPhone is shown below.

You can configure the Time Series widget to provide data across multiple time intervals. For example, in the image above, data is displayed for a one-month time period. However, the widget can also display data for one year, several years, or for the entire time period. You can add intervals to a widget by configuring the widget’s properties.

The number of data points displayed in a Time Series widget is determined by the maximum number of rows displayed in the grid on which it is based. For steps to change the number of data points displayed in a Time Series widget in a document, see To determine the maximum number of data points displayed in a document, page 84.

Prerequisites

You have already created a report with the following requirements:

- At least one attribute on the rows. The attribute provides the values along the horizontal axis of the widget, and should be time-based.
- At least one metric on the columns. The metric values are graphed in the widget.
To view data for multiple series, place at least one attribute on the columns. The attribute elements are graphed on the widget's axis.

Ensure that the row and column headers of the report are not merged.

---

**To create and add a Time Series widget to a document**

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Mobile, and select Time Series.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.

4. If desired, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on top of the widget, as described in the prerequisites above.

   Android devices can only display up to two metrics in a Time Series widget.

**Configure the widget's display properties**

6. Right-click the widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.

7. From the left, select Widget.


9. Interval selectors let users select the time period for which they want to view data in the widget, allowing them to analyze data at different levels of detail. You can add, rearrange, or delete interval selectors in a Time Series widget, as described below.

   **To add a new interval selector to the widget**
   a. Click Add. The new selector is added and displayed.
   b. Type a name for the selector in the Name field.
c From the **Template** drop-down list, select the control in the document that contains the time-based attribute you want to use to create the interval selector. The granularity is automatically determined by the last (right-most) attribute on the Grid/Graph’s rows, as described above.

d From the **Interval unit** drop-down list, select the units in which you want to specify the length of the time interval. For example, to define a six-month interval, you can select **Month** as the interval unit.

e Type the number of units you want to include in the interval in the **Interval size** field. For example, if the Interval unit is defined as **Month**, you can type 6 to specify a six-month time interval.

f A summary of the interval selector’s properties is displayed in the bottom pane. Repeat the appropriate steps above to add additional interval selectors.

**To rearrange the order in which an interval selector is displayed**

a Click **Move up** or **Move down** to change the position of the selector.

**To delete an interval selector**

a Select the interval selector’s name in the **Interval Selector** list to the left, then click **Remove**. The interval selector is removed.

10 Click **OK** to return to the Properties and Formatting dialog box.

11 Click **OK** again to save changes.

---

**To determine the maximum number of data points displayed in a document**

Increasing the number of rows that can be displayed in a grid may affect performance when the document is displayed.

1 Open the document containing the widget in Design or Editable Mode.

2 Right-click the widget’s Grid/Graph and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **Advanced**.

4 Select the **Enable incremental fetch in Grid** check box.
5 Type the maximum number of data points you want to display in the widget in the Maximum number of rows per page field.

6 Click OK to save changes.

Displaying a Timeline widget

The Timeline widget allows analysts using an iPad to view events or important milestones in the status of a product. For example, the image below shows a Timeline widget for a company that leases commercial jets to different airlines.

Each line represents a different commercial jet. An icon is displayed to mark events in the jet’s lifetime, such as a new lease, a lease expiring, a new purchase, and so on. The metric values on the right are the key performance indicators (KPIs) for each jet, and the values at the bottom are the KPIs for each year.
Creating and adding a Timeline widget to a report or document

The following are instructions to define a Timeline widget for display on a mobile device. You can also define Information Windows for the widget, which can display additional information when users tap a section of the timeline.

Prerequisites

- You must have a total of three datasets for the Timeline widget, which contain data as follows:
  - A main dataset, which must have the following objects:
    - One attribute on the rows. Each attribute element is shown as a row on the Timeline widget. In the example above, the Asset attribute is placed on the rows.
    - The Year and Quarter attributes, in that order, on the columns.
    - One metric for Status, with codes for the asset’s status, such as leased, sold, and so on. This metric determines the color of the timeline for a particular status. You can define the colors using thresholds on the Status metric.
    - One metric for Event, with codes for events in the asset’s timeline. You can define the appearance of the event marker by defining a threshold on the Event metric.
    - Optionally, one metric for the count of events for each asset, which contains the number of events that have occurred in a given quarter. If this value is greater than 1 for a specific quarter, a number badge for the quarter is displayed in the widget in place of an event icon. This number badge contains the number of events that affected the asset during the quarter.
  - A dataset that relates the asset to the KPI metrics. The metrics are displayed on the right side of the widget. The dataset must contain the following objects:
    - On the rows, the attribute for which timelines are displayed. In the example above, this is the Asset attribute.
    - On the columns, the metrics for the KPIs.
  - A dataset that relates the Year to the KPI metrics. The metrics are displayed at the bottom of the widget. The dataset must contain the following objects:
On the rows, the Year attribute.
On the columns, the metrics for the KPIs.

To create and configure the Timeline widget for mobile devices

1. In Web, open the document in Design or Editable Mode.
2. From the Insert menu, point to Widgets, then Mobile, and select Timeline.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed.
4. If desired, resize the widget by clicking and then dragging its handles.

To define the grid for the main dataset

5. From the Dataset Objects panel on the left, place the objects from the main dataset on to the widget. The requirements for these objects are described in the prerequisites above.
6. To color-code the line for each asset in the widget based on the asset’s status, you must define a threshold on the status metric to change the color in which metric values are displayed, as described below:
   a. Right-click the widget, then point to Thresholds, and select Visual. The Visual Threshold Editor opens.
   b. Select the appropriate options to define your threshold. For detailed steps to define a threshold, see the Formatting a Report chapter in the Basic Reporting Guide.
7. To display an image icon when an event occurs to an asset in the widget, you must define a threshold on the event metric to replace metric values with the image you want to display, as described below.
   a. Right-click the widget, then point to Thresholds, and select Visual. The Visual Threshold Editor opens.
   b. Select the appropriate options to define your threshold. For detailed steps to define a threshold, see the Formatting a Report chapter in the Basic Reporting Guide.
To define the grid for displaying metrics by asset

8 From the Insert menu, select Grid, then click the area in the document layout area in which you want to place the grid.

This grid will not be visible when the widget is displayed.

9 From the Dataset Objects panel, drag the objects from the second dataset, which relates the assets to metrics, on to the grid.

To define the grid for displaying metrics by year

10 From the Insert menu, select Grid, then click the area in the document layout area in which you want to place the grid.

This grid will not be visible when the widget is displayed.

11 From the Dataset Objects panel, drag the objects from the third dataset, which relates the year to metrics, on to the grid.

To configure the widget

12 Right-click the Timeline widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.

13 On the left, click Widget.

14 In the Available list under Secondary Data Providers, select the grid with the asset attribute, then click > to move it to the Selected list. Select the grid with the Year attribute and click > to move it to the Selected list.

15 Click the Widget Properties icon. The Timeline Properties dialog box opens.

16 You can choose the starting point from which to display data in the timeline when the widget is displayed. From the Initial column display properties drop-down list, select one of the following:

- To display data in the timeline starting with the most recent dates available, select Right Justified.
- To display data in the timeline starting with the earliest dates available, select Left Justified.

17 You can determine whether to show labels for each quarter displayed in the timeline. Do one of the following:

- To show the labels for each quarter, select the Show labels check box.
• To display the timeline without labeling each quarter, clear the **Show labels** check box.

18 Click **OK** to save your changes and return to the Properties and Formatting dialog box.

19 Click **OK** to save your changes.

**Displaying additional information: Information Windows**

You can define Information Windows, which are pop-up windows that display additional information when the user taps an area in the widget when the widget is displayed on the mobile device. To do so, you must first define a panel stack containing the information you want to display, then define specific attributes as selectors targeting the panel stack, as follows:

• To display an Information Window when the user taps a section of the timeline for a specific asset and quarter, you must define the Asset, Year, and Quarter attributes on the Timeline widget as selectors targeting the panel stack.

• To display an Information Window when the user taps the name of an asset in the widget, you must define the Asset attribute in the grid containing the metrics to be displayed by Asset (the second Grid/Graph you added to the document) as a selector targeting the panel stack.

For detailed steps to create Information Windows, see *Providing additional information to users: Information Windows, page 20.*

**Displaying widgets using the entire screen on mobile devices**

By default, when you add a widget to a layout in a document, the widget is sized to take up the entire screen when displayed on an iPhone or Android device. Any additional grids, graphs, or widgets you add to the layout are not displayed. You can choose to display the widget without taking up the entire screen, and allow the display of other grids, graphs, or widgets together in the layout.
To determine whether to display a widget using the entire screen on a mobile device

1. Open the document in Design or Editable Mode.

2. Right-click the Grid/Graph containing the widget and select **Properties and Formatting**. The Properties and Formatting dialog box is displayed.

3. From the left, select **Widget**. Do one of the following:
   - To size the widget to fit the entire screen, select the **Full Screen** check box.
   - To display the widget without taking up the entire screen, and allow the display of other grids, graphs, or widgets in the layout, clear the **Full Screen** check box.

Opening a device’s installed applications from documents

A document displayed on an iPhone, iPad or Android device can interact with the applications that are installed with the device. For example, a document can send addresses to Google Maps for directions or open a video. These applications include:

- Web browser
- Email
- Phone (applicable to mobile phones only)
- SMS (applicable to mobile phones only)
- Maps
- Videos

To allow users to open an external application in a document, you must create a hyperlink. The hyperlink connects a text field or an image to a web page or application (the target). When the document is viewed on a device, the user can click the control to navigate to the target.
For example, you create a document for the regional managers for a chain of stores. This document contains information about each of the stores in the manager’s region, as shown in the image below.

The information includes the store’s address, phone number, the store manager’s email address, its inventory figures, and so on. When regional managers view this document on their iPhones, they can:

- View a map of the store’s location and get directions from their current location
- Email the store manager
- Call the store

To create a link with a larger area that is easier to select, you can define a link that includes both the text and the area around it, or create an image button that users can select. To do this, you can:

- Create an image to use as the button and add a link to it.
- Insert a transparent image into the document, then enlarge and/or position it to cover the desired link area. Link the transparent image to the target. The user can then tap any area covered by the image to open the link. A sample transparent image is located by default in C:\Program Files\MicroStrategy\Intelligence Server\images\lptrans.gif.
When you create a hyperlink to open an external application, you must use the syntax outlined in the table below. Two examples are included for each type of hyperlink. The first example replaces the italicized variables in the syntax with specific, static text, while the second replaces it with an attribute, so that the hyperlink can change according to the data in your document.

<table>
<thead>
<tr>
<th>To...</th>
<th>Use This Syntax....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td><code>&lt;a href=&quot;mailto:EmailAddress&quot;&gt;Name&lt;/a&gt;</code></td>
</tr>
<tr>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;mailto:jdoe@example.com&quot;&gt;John Doe&lt;/a&gt;</code></td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;mailto:{StoreMgrEmail}&gt;{StoreMgr}&lt;/a&gt;</code> where StoreMgrEmail and StoreMgr are attributes</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;mailto:{Store@StoreMgrEmail}&gt;{Store@StoreMgr}&lt;/a&gt;</code> where StoreMgrEmail and StoreMgr are attribute forms of the Store attribute</td>
<td></td>
</tr>
<tr>
<td>Email with a subject</td>
<td><code>&lt;a href=&quot;mailto:EmailAddress?cc=EmailAddress&amp;subject=SubjectLine&amp;body=Message&quot;&gt;Text&lt;/a&gt;</code></td>
</tr>
<tr>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;mailto:jdoe@example.com?cc=msmith@example.com&amp;subject=Greetings%20from%20MicroStrategy!&amp;body=I%20have%20reviewed%20your%20store’s%20sales%20results%20and%20have%20the%20following%20feedback%20for%20you:&gt;Contact John Doe&lt;/a&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Call (applicable to mobile phones only)</td>
<td><code>&lt;a href=&quot;tel:PhoneNumber&quot;&gt;PhoneNumber&lt;/a&gt;</code></td>
</tr>
<tr>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;tel:1-555-555-5555&quot;&gt;1-555-555-5555&lt;/a&gt;</code></td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;tel:{StorePhone}&gt;{StorePhone}&lt;/a&gt;</code> where StorePhone is an attribute</td>
<td></td>
</tr>
<tr>
<td>Use SMS links (applicable to mobile phones only)</td>
<td><code>&lt;a href=&quot;sms:SMSNumber&quot;&gt;Text&lt;/a&gt;</code></td>
</tr>
<tr>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;sms:1-555-555-5555&quot;&gt;I’ll be there soon&lt;/a&gt;</code></td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;sms:{MgrPhone}&gt;New Message&lt;/a&gt;</code> where MgrPhone is an attribute</td>
<td></td>
</tr>
<tr>
<td>Pass location to Google Maps</td>
<td><code>&lt;a href=&quot;http://maps.google.com/maps?q=City&quot;&gt;City&lt;/a&gt;</code></td>
</tr>
<tr>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;http://maps.google.com/maps?q=Chicago&quot;&gt;Chicago&lt;/a&gt;</code></td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;http://maps.google.com/maps?q={CustomerCity}&quot;&gt; {CustomerCity}&lt;/a&gt;</code> where CustomerCity is an attribute</td>
<td></td>
</tr>
<tr>
<td>• <code>&lt;a href=&quot;geo:38.915645,-77.220796&quot;&gt;MicroStrategy HQ&lt;/a&gt;</code>, where the numbers in the link are the latitude and longitude respectively.</td>
<td></td>
</tr>
</tbody>
</table>

Note: For links to maps.google.com on Android devices, you may be asked to choose whether to open the link using your default browser, or using Maps.
You use the hyperlink properties to define links to the device's applications, as described below.

### To create a hyperlink to an application on the device

1. In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2. To use a text field for the hyperlink, complete the following steps (see the next step for instructions to add an image instead):
   
   a. From the **Insert** menu, select **Text**.
   
   b. Click in the section of the document where you want to place the text field. If you click and drag in the section, you can size the text field.

   **WARNING:** To ensure that the area of a link is large enough to recognize a user selecting it, make sure it has a height and width of at least 40 pixels.

---

<table>
<thead>
<tr>
<th>To...</th>
<th>Use This Syntax....</th>
</tr>
</thead>
</table>
**Examples:**  
- `<a href="http://maps.google.com/maps?daddr={CustomerAddress} &saddr={StoreAddress}">Directions from {StoreName} to {CustomerName} location</a>` where `CustomerAddress`, `StoreAddress`, `StoreName`, `CustomerName` are attributes |
| Open a video | Example:  
| Display a web page in the internal web browser (iPad) By default, web pages open in Safari | Replace `WebPageURL?inApp=1` with the URL of the web page you want to display in the internal web browser. If the URL contains a ? (question mark) followed by a list of parameters, such as `http://news.google.com/news?ned=us&topic=h&output=rss, type & (ampersand) followed by inApp=1. For example, `http://news.google.com/news?ned=us&topic=h&output=rss&inApp=1`.  
Otherwise, the URL of the web page you want to display must end with a / (forward slash), followed by ?inApp=1. For example, to link to the Google web page, the URL is `http://www.google.com/?inApp=1`. |

---

© 2012 MicroStrategy, Inc.
c Type the text to be displayed to users into the text field. You can add static text, dynamic text (in the form of data fields and auto text codes), or a combination to the text field:

- To add static text, type the static text into the text field.
- To add a data field, drag and drop a dataset object from the Dataset Objects panel into the text field.
- To add an auto text code, from the Insert menu, select Auto-text, then select the code to insert.

For background information about adding text to documents, see the Report Services Document Creation Guide.

3 To use an image for the hyperlink, complete the following steps:

a From the Insert menu, select Image.

b Click in the section of the document where you want to place the image. If you click and drag in the section, you can size the image. The Properties and Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a user selecting it, make sure it has a height and width of at least 40 pixels.

c Type the address of the image file to insert in the Source field. Navigate to and select the image file to insert in the document.

d Click OK. The image appears in the document.

For background information about adding images to documents, especially to ensure that the image is available as needed, see the MicroStrategy Report Services Document Creation Guide.

4 Right-click the text field or image that you just added, and select Properties and Formatting. The Properties and Formatting dialog box opens.

5 From the left, click General, then select the Is hyperlink check box.

6 In the Hyperlink field, delete the “http://” text that is automatically filled in. Following the syntax in the table on page 92, type the hyperlink into the Hyperlink field. You can type static text, dynamic text (in the form of data fields and text codes), or a combination, as described below:

- To add static text, type the static text into the text field.
• To add a data field (that is, an object from a dataset report), type the object’s name within braces, such as \{Revenue\} or \{Region\}. The name must match either the name of an object in a dataset or its alias. If either name contains spaces or special characters, you must type it in square brackets \[ \] within the braces; for example, \{[Manager Name]\}.

  A special character is any character other than a - z, A - Z, 0 - 9, #, _, and . (period).

• To add an auto text code (that is, document and dataset report information), type the code within braces. As with data fields, if an object’s name contains spaces or special characters, enclose it in square brackets within the braces. For background information about available auto text codes, see the MicroStrategy Report Services Document Creation Guide.

7 Click **OK** to return to the document. Notice that the text field is now underlined, indicating that it is a hyperlink.

### Linking to documents and reports from a mobile document

A link is a connection in a document to another document or a report. A link lets a user execute another document or report (the target) from a document (the source), and to pass parameters to answer any prompts that are in the target. You can link from a text field or an image.

For example, if a user is viewing a document containing regional sales, he can select a particular region to execute another document that displays sales for the stores in that region. This is a form of drilling, where the user has drilled from region to store. The source document could also link to the underlying dataset report, to display profit and cost values as well.

To create links in a document that is viewed on a mobile device, you must use the hyperlink properties and create the link URLs manually, by using the object ID and link syntax.

Once you have created a link to execute a report or document, you can add parameters to the URL to perform additional tasks, such as providing answers for prompts in the linked document, or specifying which layout to display.
Links you can create for iOS devices

You can use links to do the following on an iPhone or iPad:

• Execute a report, specifying the page-by, prompt answers, and report view (grid, graph, or both grid and graph)

• Execute a document, specifying the layout, grouping, and prompt answers.
  □ A multi-layout document contains multiple documents, each in its own layout, creating a “book” of documents. Each layout functions as a separate document, with its own grouping, page setup, and so on, but the layouts are generated into a single PDF document.
  □ Grouping a document helps users understand the data better. Grouping the data sets up a type of hierarchy within the document, and an inherent or implied sort order for the data.

□ You can change the grouping or layout for the currently displayed document, or for a target document. If you change the grouping or layout for the currently displayed document, you still must use the entire link URL, including the document ID, event parameter, and so on.

• Reprompt a report or document

Links you can create for Android devices

You can use links to do the following on an Android device:

• Execute a report, specifying whether it is displayed as a grid, a graph, or both a grid and graph

• Execute a document

• Run a report or document from a different project or server
Creating a link for a mobile document

Prerequisites

- Before creating links, create any target documents and reports, and use the following procedure to obtain their IDs:
  a. Navigate to the folder location of the report or document.
  b. Right-click the report or document, and select Properties. The Properties dialog box is displayed, with the object's ID displayed in the ID field. You can highlight and copy this ID to use in a link URL.

- Know the prompts of the targets and how they will be answered (for example, with prompt XML or an attribute element).

To create a link for a mobile document

1. In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2. To use a text field for the hyperlink, complete the following steps (if you are adding an image, skip this step):
   a. From the Insert menu, select Text.
   b. Click in the section of the document where you want to place the text field. If you click and drag in the section, you can size the text field.

      To ensure that the area of a link is large enough to recognize a user selecting it, make sure it has a height and width of at least 40 pixels.

   c. Type the text to be displayed to users into the text field. You can add static text, dynamic text (in the form of data fields and auto text codes), or a combination to the text field:

      To add static text, type the static text into the text field.
      To add a data field, drag and drop a dataset object from the Dataset Objects panel into the text field.
To add an auto text code, from the **Insert** menu, select **Auto-text**, then select the code to insert.

For background information about adding data fields and auto-text codes to documents, see the *Report Services Document Creation Guide*.

3 To use an image for the hyperlink, complete the following steps:
   a. From the **Insert** menu, select **Image**.
   b. Click in the section of the document where you want to place the image. If you click and drag in the section, you can size the image. The Properties and Formatting dialog box opens.
      - To ensure that the area of a link is large enough to recognize a user selecting it, make sure it has a height and width of at least 40 pixels.
   c. Type the address of the image file to insert in the **Source** field.
   d. Click **OK**. The image appears in the document.

For background information about adding images to documents, see the *MicroStrategy Reports Services Document Creation Guide*.

4 Right-click the image or text field, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

5 From the left, click **General**, then select the **Is Hyperlink** check box.

6 Type the link URL in the **Hyperlink** field:
   - To have the link execute a document, use the syntax:
     ```
     http://MSTRMobileURL?&src=source&evt=2048001&currentViewMedia=2&documentID=objectID
     ```
   - To have the link execute a report, use the syntax:
     ```
     http://MSTRMobileURL?&src=source&evt=4001&reportViewMode=view&reportID=objectID
     ```
   - To add additional parameters to the URL, such as providing answers for the target document’s prompts, see *Using links to answer prompts, display document layouts, and group data in a report or document, page 99*. 

© 2012 MicroStrategy, Inc.
Replace the italicized variables, as summarized below:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Replace With</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSTRMobileURL</td>
<td>To use an absolute path to your Mobile Server, use one of the following:</td>
</tr>
<tr>
<td></td>
<td>• For .NET</td>
</tr>
<tr>
<td></td>
<td>MobileServer/MicroStrategy/asp/Main.aspx</td>
</tr>
<tr>
<td></td>
<td>• For J2EE</td>
</tr>
<tr>
<td></td>
<td>MobileServer/MicroStrategy/servlet/mstrWeb</td>
</tr>
<tr>
<td></td>
<td>Replace MobileServer with the name of your MicroStrategy Mobile Server.</td>
</tr>
<tr>
<td></td>
<td>To use a relative path to your Mobile Server, use mstrWeb.</td>
</tr>
<tr>
<td>source</td>
<td>The page component that should handle the action and the event:</td>
</tr>
<tr>
<td></td>
<td>• For a document using J2EE format, mstrWeb.2048001</td>
</tr>
<tr>
<td></td>
<td>• For a document using .NET format, Main.aspx.2048001</td>
</tr>
<tr>
<td></td>
<td>• For a report using J2EE format, mstrWeb.4001</td>
</tr>
<tr>
<td></td>
<td>• For a report using .NET format, Main.aspx.4001</td>
</tr>
<tr>
<td>view</td>
<td>Report view mode:</td>
</tr>
<tr>
<td></td>
<td>• For grid view: 1</td>
</tr>
<tr>
<td></td>
<td>• For graph view: 2</td>
</tr>
<tr>
<td></td>
<td>• For grid and graph view: 3</td>
</tr>
<tr>
<td>objectID</td>
<td>The object ID of the target document or report</td>
</tr>
</tbody>
</table>

7 Click **OK** to return to the document.

**Using links to answer prompts, display document layouts, and group data in a report or document**

Once you have created a link to run a report or a document on an iPhone or iPad, you can add parameters to the URL to perform additional tasks, such as providing answers for prompts in the linked document, or specifying the layout to display when a document is run.

The table below lists the tasks you can perform, and the syntax for the link parameters to perform them. You can add these parameters to a link URL by separating each parameter with an ampersand (**&**). For example, the
following URL contains parameters to display the first layout in a document and provide the answer to a Value prompt:

```
Main.aspx?evt=2048001&currentViewMedia=2&documentID=E8663E7A4D8CDF05C060129D0061692&layoutIndex=0&valuePromptAnswers=1000
```

<table>
<thead>
<tr>
<th>Task</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run a report or document from a different project or server</td>
<td><code>server=servername&amp;project=projectname&amp;uid=username&amp;pwd=password</code> Replace <code>servername, projectname, username, and password</code> with the name of the server, project, and the login name and password to use to log in respectively. By default, if the URL does not specify a server and project, the current server and project are used. You can specify these parameters, called session parameters, to execute a report or document in a different server or project, and provide the appropriate login name and password. For more information on session parameters, see the Customizing MicroStrategy Web section, in Part I: Fundamentals of Customization in the Web Software Development Kit, available in the MicroStrategy Developer Library (MSDL), which is sold as part of the MicroStrategy SDK.</td>
</tr>
<tr>
<td>Display a specific layout in a document</td>
<td><code>layoutIndex=layout</code> Replace <code>layout</code> with the number of the layout you want to display. The first layout in the document is 0, the second is 1, and so on.</td>
</tr>
</tbody>
</table>
| Specify the group-by element in a document      | `groupByElements=groupByUnitID;groupByUnitType;groupByElementID` Replace the italicized variables with the following:  
  • `groupByUnitID`: The ID of the group-by attribute or consolidation. You can use `{&AttributeName@GUID}`, to provide the ID automatically. Replace `AttributeName` with the name of the attribute or consolidation.  
  • `groupByUnitType`: Use 12 for an attribute, or 47 for a consolidation.  
  • `groupByElementID`: The ID of the group-by element. You can use `{&AttributeName@LongElementID}`, to provide the ID automatically. Replace `AttributeName` with the name of the attribute or consolidation.  
  You can specify multiple group-by elements by separating each set of group-by parameters with a caret (^), as follows:  
  `groupByElements=groupByUnitID1;groupByUnitType1;groupByElementID1 ^groupByUnitID2;groupByUnitType2;groupByElementID2` |
<table>
<thead>
<tr>
<th>Task</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the page-by element in a report</td>
<td>pageByElements=pageByUnitID;pageByUnitTypeID;pageByElementID</td>
</tr>
<tr>
<td></td>
<td>Replace the italicized variables with the following:</td>
</tr>
<tr>
<td></td>
<td>• pageByUnitID: The ID of the page-by attribute or consolidation. You can use</td>
</tr>
<tr>
<td></td>
<td>{&amp;AttributeName@GUID}, to provide the ID automatically. Replace AttributeName with the name of the attribute or consolidation.</td>
</tr>
<tr>
<td></td>
<td>• pageByUnitTypeID: Use 12 for an attribute, or 47 for a consolidation.</td>
</tr>
<tr>
<td></td>
<td>• pageByElementID: The ID of the page-by attribute or consolidation. You can use {&amp;AttributeName@LongElementID}, to provide the ID automatically. Replace AttributeName with the name of the attribute or consolidation.</td>
</tr>
<tr>
<td></td>
<td>You can specify multiple page-by elements by separating each set of page-by parameters with a caret (^), as follows:</td>
</tr>
<tr>
<td></td>
<td>pageByElements=pageByUnitID1;pageByUnitTypeID1;pageByElementID1^pageByUnitID2;pageByUnitTypeID2;pageByElementID2</td>
</tr>
<tr>
<td></td>
<td>For information on finding the ID of an individual attribute element, see To obtain the ID of a specific attribute element in a document below.</td>
</tr>
<tr>
<td>Answer an Attribute Element List prompt</td>
<td>elementsPromptAnswers=AttributeID;AttributeElementID^AttributeElementDesc</td>
</tr>
<tr>
<td></td>
<td>Replace the italicized variables as follows:</td>
</tr>
<tr>
<td></td>
<td>• AttributeID: The ID of the attribute.</td>
</tr>
<tr>
<td></td>
<td>• AttributeElementID: The ID of the attribute element to use to answer the prompt. You can use {&amp;AttributeName@ElementID} to provide the ID automatically. Replace AttributeName with the name of the attribute.</td>
</tr>
<tr>
<td></td>
<td>• AttributeElementDesc: The description of the attribute. You can use {&amp;AttributeName@DESC} to provide the display name automatically. Replace AttributeName with the name of the attribute.</td>
</tr>
<tr>
<td></td>
<td>You can answer a prompt using multiple elements from the same attribute. To do so, you must supply the ID and display name of each attribute element to use to answer the prompt, separated by a semicolon, as below:</td>
</tr>
<tr>
<td></td>
<td>elementsPromptAnswers=AttributeID;AttributeElementID1^AttributeElementDesc1;AttributeElementID2^AttributeElementDesc2</td>
</tr>
<tr>
<td></td>
<td>You can provide answers to multiple attribute element prompts by separating each set of answers with a comma. For example:</td>
</tr>
<tr>
<td></td>
<td>elementsPromptAnswers={&amp;Region@GUID};{&amp;Region@ElementID}^{Region@DESC},{&amp;Year@GUID};{&amp;Year@ElementID}^{Year@DESC}</td>
</tr>
<tr>
<td>Task</td>
<td>Syntax</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Answer a Value prompt</td>
<td><code>valuePromptAnswers=value</code></td>
</tr>
<tr>
<td></td>
<td>Replace <em>value</em> with the answer for the Value prompt. This value can</td>
</tr>
<tr>
<td></td>
<td>be a date, number, or text string.</td>
</tr>
<tr>
<td></td>
<td>You can answer multiple Value prompts by separating each answer with</td>
</tr>
<tr>
<td></td>
<td>a caret (^). For example:</td>
</tr>
<tr>
<td></td>
<td><code>valuePromptAnswers=1000^20^1/1/2010</code></td>
</tr>
<tr>
<td></td>
<td>To skip a Value prompt answer, use a caret, without anything else.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><code>valuePromptAnswers=^1/1/2010</code></td>
</tr>
</tbody>
</table>
|                                           | **Note:** Because of the convention for signifying unanswered prompts,
|                                           | you cannot answer a Value prompt with an empty string using a link   |
|                                           | URL.                                                                |
| Use all prompt answers from the source    | `promptsAnswerXML={&PROMPTXML}`                                     |
| document, and apply them to the target    | The prompts in the linked report or document must be the same        |
| report or document                        | physical prompt objects with the same IDs as the prompts in the      |
|                                           | document containing the link. If the prompts are contained in filters,|
|                                           | use links to filters instead of embedded filter prompts. For        |
|                                           | more information on links to filters, see the **MicroStrategy       |
|                                           | Advanced Reporting Guide**.                                         |
| Reprompt the target report or document    | `showprompts=1`                                                     |
| Set the target document’s selectors to    | `prevMsgID=0`                                                       |
| the same values as the source document’s  | **Note the following:**                                              |
| selectors                                 | • The selectors must be attribute selectors, with the selection type  |
|                                           | *Include*.                                                          |
|                                           | • The values of a selector in the source document are applied to    |
|                                           | all the selectors in the target that are based on the same          |
|                                           | attribute. For example, if the source document has a selector based  |
|                                           | on Category, and the current selection is Books, all the            |
|                                           | selectors in the target that are based on Category are set to       |
|                                           | Books.                                                              |

---

**To obtain the ID of a specific attribute element in a document**

1. To obtain the ID of a specific element in an attribute, you must first obtain the ID of the attribute. Navigate to the folder location of the attribute.

2. Right-click the attribute, then select **Properties**. The Properties dialog box is displayed, with the attribute’s ID displayed in the ID field.

3. Highlight the ID, then copy it to the clipboard.

4. Open the document that contains the attribute in Editable Mode.
5 Right-click the header of the attribute in the Grid/Graph, then point to
Attribute Forms, and select ID. The ID of each element in the attribute is
displayed.

6 The full attribute element ID is the ID of the element’s attribute, followed
by a colon (:) and the ID of the element displayed in the grid. For
example:

8D679D4B11D3E4981000E787EC6DE8A4:2

**Using links to access features within the MicroStrategy Mobile application**

You can use links in a document to access specific features within the
MicroStrategy Mobile application for iPhone or iPad. For example, you can
add a link to display the Home screen or the My Reports folder.

The procedure to create the following hyperlinks is identical to that for
creating hyperlinks to the device’s installed applications. For steps, see *To
create a hyperlink to an application on the device, page 93*.

The table below lists the types of links you can create, and the URL to use to
create them.

<table>
<thead>
<tr>
<th>Task</th>
<th>URL</th>
</tr>
</thead>
</table>
| View a folder                       | mstr://?evt=2001&folderID=folderID
Replace folderID with the ID of the folder you want to display. |
| Display the Shared Reports folder   | mstr://?evt=2001&systemFolder=7               |
| Display the My Reports folder       | mstr://?evt=2001&systemFolder=20             |
| Email a screenshot of the document  | mstr://?evt=3037
The screenshot is added to the email as an attachment. To add a subject to
the email, add &emailSubject=subject to the end of the URL, then replace subject with the subject. For example, to send an email
with the subject “Your requested report”, type mstr://?evt=3037&emailSubject=Your+requested+report. |
<p>| Annotate and Share the report or document | mstr://evt=3175                           |
| Display the Help                    | mstr://?evt=3994                           |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Home screen</td>
<td>mstr://?evt=3995</td>
</tr>
<tr>
<td>Display the Shared Library</td>
<td>mstr://?evt=3996</td>
</tr>
<tr>
<td>Display the Reports screen</td>
<td>mstr://?evt=3997</td>
</tr>
<tr>
<td>Display the Status screen</td>
<td>mstr://?evt=3998</td>
</tr>
<tr>
<td>Display the Settings screen</td>
<td>mstr://?evt=3999</td>
</tr>
<tr>
<td>Connect to the user’s MicroStrategy Cloud</td>
<td>mstr://?evt=3992</td>
</tr>
<tr>
<td>Personal folder</td>
<td><strong>Note</strong>: If the user has not configured a Cloud Personal account,</td>
</tr>
<tr>
<td></td>
<td>the Cloud Personal login page is displayed</td>
</tr>
<tr>
<td>Display the Cloud Personal menu</td>
<td>mstr://?evt=3990</td>
</tr>
<tr>
<td>Display a menu containing Cloud Personal dashboards that were recently shared with the user</td>
<td>mstr://?evt=3991</td>
</tr>
<tr>
<td>Return to the previously viewed document</td>
<td>mstr://?evt=3124</td>
</tr>
<tr>
<td>Select a specific panel in a panel stack</td>
<td>mstr://?evt=2048076&amp;psName= PANEL_STACK_NAME&amp;pName=PANEL_NAME</td>
</tr>
<tr>
<td></td>
<td>Replace the italicized variables as follows:</td>
</tr>
<tr>
<td></td>
<td>• PANEL_STACK_NAME: The name of the panel stack to target</td>
</tr>
<tr>
<td></td>
<td>• PANEL_NAME: The name of the panel to select</td>
</tr>
<tr>
<td></td>
<td>To select panels from multiple panel stacks, use the following format:</td>
</tr>
<tr>
<td></td>
<td>mstr://?evt=2048076&amp;psKey= PanelStack1</td>
</tr>
<tr>
<td></td>
<td>Replace the italicized variables as follows:</td>
</tr>
<tr>
<td></td>
<td>• PanelStack1, PanelStack2, etc.: The names of the panel stacks to</td>
</tr>
<tr>
<td></td>
<td>target.</td>
</tr>
<tr>
<td></td>
<td>• PanelK1, PanelK2, etc.: The names of the panels to select, in the</td>
</tr>
<tr>
<td></td>
<td>order of the panel stack. For example, PanelK1 is a panel in Panel</td>
</tr>
<tr>
<td></td>
<td>Stack1.</td>
</tr>
<tr>
<td>Display a specific Information Window</td>
<td>mstr://?evt=2048500&amp;panelName=Name</td>
</tr>
<tr>
<td></td>
<td>Replace Name with the name of the panel stack you have created to use</td>
</tr>
<tr>
<td></td>
<td>as the Information Window.</td>
</tr>
</tbody>
</table>
Storing links on NFC tags to open reports, documents, or folders on Android devices

You can store a link on Near Field Communications (NFC) tags to open a report, document, or folder on an Android device through MicroStrategy Mobile. An NFC tag is a small piece of hardware that broadcasts short-range wireless NFC signals to compatible devices. When a Mobile user places her NFC capable Android device within the required range of the NFC tag, a link is broadcast to her device. This link opens MicroStrategy Mobile on the Android device and displays the specified report, document, or folder.

A Mobile user can only view the projects that her device has been configured to access. When creating a link for NFC tags, ensure that your target audience is using a mobile configuration that provides access to the specified report, document, or folder.

To store a link on your NFC tags, use a third-party NFC programming app on an NFC capable Android device. The table below lists the types of links you can create on NFC tags, and the URL to use to create them.

<table>
<thead>
<tr>
<th>Task</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a selection screen that allows you to specify the element to use to group data</td>
<td>mstr://gb/?e= {&amp;AttributeName@ElementID}&amp;a= {&amp;AttributeName@GUID}&amp;s=style</td>
</tr>
<tr>
<td>Replace AttributeName with the name of the attribute you want to use to group data. Replace style with one of the following:</td>
<td></td>
</tr>
<tr>
<td>• To display the attribute elements in a directory-like list: 0</td>
<td></td>
</tr>
<tr>
<td>• To display the attribute elements on a wheel: 1</td>
<td></td>
</tr>
<tr>
<td>Re-prompt the document</td>
<td>mstr://pr</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a grid report</td>
<td><a href="http://www.mstr.com?projectID&amp;reportID&amp;774">www.mstr.com?projectID&amp;reportID&amp;774</a></td>
</tr>
<tr>
<td>Replace projectID with the ID of the project that contains the report. Replace reportID with the ID of the report that you want to display.</td>
<td></td>
</tr>
<tr>
<td>Display a graph report</td>
<td><a href="http://www.mstr.com?projectID&amp;reportID&amp;769">www.mstr.com?projectID&amp;reportID&amp;769</a></td>
</tr>
<tr>
<td>Replace projectID with the ID of the project that contains the report. Replace reportID with the ID of the report that you want to display.</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>URL</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Display a document</td>
<td><a href="http://www.mstr.com?projectID&amp;documentID&amp;14081">www.mstr.com?projectID&amp;documentID&amp;14081</a></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Display the contents of a</td>
<td><a href="http://www.mstr.com?projectID&amp;folderID&amp;2048">www.mstr.com?projectID&amp;folderID&amp;2048</a></td>
</tr>
<tr>
<td>folder</td>
<td></td>
</tr>
</tbody>
</table>
DESIGNING REPORTS AND DOCUMENTS FOR A BLACKBERRY

Introduction

Reports and documents displayed on a BlackBerry are created in either MicroStrategy Desktop or MicroStrategy Web by a report or document designer. Complete details to design a report are in the MicroStrategy Basic Reporting Guide and MicroStrategy Advanced Reporting Guide. Details to design a document are in the MicroStrategy Report Services Document Creation Guide. This chapter covers design information that is specific for reports and documents that will be used on a BlackBerry.

It is important to design the reports and documents properly to ensure that they can be analyzed easily and efficiently on a mobile device.

Prerequisites:

• This chapter assumes that you know the nature and structure of your company’s data that you will analyze in your business intelligence reports and documents. It also assumes that you know how to create and manipulate a MicroStrategy report or document in MicroStrategy Desktop or MicroStrategy Web and have the necessary privileges to do so. For information about your security privileges, contact your administrator.
Best practices for designing Mobile-friendly reports

When designing a report in MicroStrategy Desktop or MicroStrategy Web for use on a BlackBerry, consider the following best practices for report and document display on a mobile device:

- Limit the total number of attributes and metrics displayed on the report’s rows and columns to six. This allows MicroStrategy Mobile users to view as much data as possible at one time.

- Keep the report as focused as possible by providing only the report objects essential for effective report analysis.

- If you want to place attributes on the columns of a grid report, you must design the report in original layout data view, which disables certain MicroStrategy Mobile features. Otherwise, any attributes on the columns are automatically moved to the rows in MicroStrategy Mobile. For details about the different data views, see Selecting a data view for a report or document, page 111.

- If you want to place metrics on the rows of a grid report, you must design the report in original layout data view, which disables certain MicroStrategy Mobile features. Otherwise, any metrics on the rows are automatically moved to the columns in MicroStrategy Mobile. For details about the different data views, see Selecting a data view for a report or document, page 111.

- Any report designed in tabular interactive data view with objects in its page-by field will display the currently selected page-by data in MicroStrategy Mobile, by default. The page-by field can be changed in MicroStrategy Mobile. For more information about the different data views, see Selecting a data view for a report or document, page 111.

- If the report is designed in original layout data view, changing objects in the page-by field is disabled. For more information about the different data views, see Selecting a data view for a report or document, page 111.

- Moving objects to and from the page-by field in MicroStrategy Mobile may impact performance in the application, depending on the amount of data in the report. As you design the report in MicroStrategy Desktop or MicroStrategy Web, place several objects in the page-by field so users do not have to move objects to and from the page-by field in MicroStrategy Mobile.
• A report’s font colors and styles (bold, italic, underline) are displayed in MicroStrategy Mobile. However, font types and sizes, and the alignment of text, are not applied to the report in MicroStrategy Mobile. Consider this when formatting the text on your report. Users can adjust the font size from MicroStrategy Mobile.

• Use thresholds formatted as quick symbols, colors, or text replacements. Thresholds involving the size and alignment of text are not supported. Also, custom image-based thresholds are not displayed in MicroStrategy Mobile.

• **Report size guidelines:**
  - If a report or document is 125,000 bytes (125KB) or larger, it will not be downloaded to a mobile device. If this issue occurs, redesign the report or document in MicroStrategy Desktop or Web to use it in MicroStrategy Mobile.
  - A report or document in MicroStrategy Mobile is typically about 1/5 to 1/2 of the size of the same report or document in MicroStrategy Desktop or MicroStrategy Web, depending on the size and complexity of the report or document.
  - Some smaller reports and documents may be compressed to about 1/10 of the size of the same report or document in Web or Desktop.

• **Designing graph reports:**
  - When designing a graph report in MicroStrategy Desktop, enable Automatic graph layout. This ensures that the objects on the graph are not repositioned in MicroStrategy Mobile. For the steps to do this, see the Graphing chapter of the MicroStrategy Advanced Reporting Guide.
  - Consider using graphs with only enough series that can best fit on the screen at a time. If you must display more information than can fit on one screen, use page-bys to break the graph in logical places across multiple screens.

For details to design a report in MicroStrategy Desktop or MicroStrategy Web, see the MicroStrategy Basic Reporting Guide.
Best practices for designing Mobile-friendly documents

If you are designing a document in MicroStrategy Desktop or MicroStrategy Web for use on a BlackBerry, consider the following best practices:

• Refer to Best practices for designing Mobile-friendly reports, page 108 for suggestions on designing each report within the document.

• Limit the number of Grid/Graphs included in the document. Each Grid/Graph in a MicroStrategy document is displayed as a separate tab when the document is displayed on the mobile device.

At least one Grid/Graph must be included in the document for the document to display any data in MicroStrategy Mobile.

• The names of the tabs above a document are determined by the names of the Grid/Graphs in the document. You can specify the name of a Grid/Graph in the Title field in the Properties dialog box in MicroStrategy Desktop or MicroStrategy Web. If you do not specify a title, the generic name of the Grid/Graph is displayed.

• Grid/Graphs are the only controls on documents that are displayed in MicroStrategy Mobile. Selectors, panel stacks, widgets, lines, rectangles, and text fields are not displayed in MicroStrategy Mobile. Avoid including these types of controls on a document that will be used on a mobile device.

• To include graphs in documents, you must design the report in original layout data view. Original layout data view disables some Mobile features. For details about the different data views, see Selecting a data view for a report or document, page 111.

• Do not subscribe to an HTML document for use with MicroStrategy Mobile. HTML documents are not displayed in MicroStrategy Mobile.

For details to design documents in MicroStrategy Desktop, see the MicroStrategy Report Services Document Creation Guide. For information on designing a document in MicroStrategy Web, see the MicroStrategy Web online help.
Selecting a data view for a report or document

Reports and documents that are designed to be viewed in a mobile device must have a data view assigned to them: tabular interactive or original layout. Each of these data views has its own benefits but also disables some features:

- **Tabular interactive data view** allows the widest number of report and document manipulations on the mobile device, but does not allow certain report formatting during the design process. See *Tabular interactive data view, page 111* for details.

- **Original layout data view** provides flexibility in the design of reports and documents, but disables some of the Mobile user's functionality. See *Original layout data view, page 112* for details.

The report designer designates the data view for each report when the report is designed in MicroStrategy Web or Desktop. The data view cannot be altered remotely using a mobile device.

When designing a report or document for a Mobile user, it is important to think about the way the user will interact with it. If the user will benefit from a simple grid layout and the ability to rearrange the data on the report, tabular interactive data view is the best choice. If the report is best understood with minimal manipulations, but requires a more complex layout, original layout data view is more appropriate.

For steps to set the data view when designing a report for Mobile, see the Report Options dialog box section under Grid Formatting in the MicroStrategy Web online help.

**Tabular interactive data view**

Tabular interactive data view allows the MicroStrategy Mobile user to use all functionality available to work with the reports and documents on the mobile device. The full functionality described in the *MicroStrategy Mobile Analysis Guide* is available to the user in tabular interactive data view.

However, this data view restricts the report or document designer from some design features, as described below:

- Placing attributes in columns: Any attributes placed in the columns of a grid will be moved to the rows of the grid when the report is delivered to the device.
• Placing metrics in rows: Any metrics placed in the rows of a grid will be moved to the columns of the grid when the report is delivered to the device.

Original layout data view

Original layout data view provides flexibility in the design of a report or document. It allows the report or document developer to use the design features that are disabled in tabular interactive data view.

However, original layout data view disables some of the Mobile user’s functionality. The disabled Mobile user functionality is described below:

• Sorting on a grid
• Moving objects to and from the page-by axis
• Rearranging rows on a grid
• Rearranging columns on a grid

Designing large reports for use in MicroStrategy Mobile in original layout design mode improves the loading time of a report when objects are in the page-by field. Reports in this data view load only the data for the currently selected page to the mobile device, rather than loading all of the data at once.

When designing a report in original layout data view, the designer is able to place attributes on the columns and metrics on the rows of a grid. This design ability, known as cross-tabbing, allows the user to see metrics for different attributes shown side-by-side. This is illustrated in the image below:
Introduction

This chapter explains how to install and configure MicroStrategy Mobile on an Intelligence Server, and how to install and configure the MicroStrategy Mobile application on mobile devices. It also explains how to subscribe to reports, and the ways in which administrators can manage multiple subscriptions simultaneously.

The topics covered in this chapter include:

- **Overview: MicroStrategy Mobile architecture, page 114**
- **Installing and configuring Mobile Server, page 115**
- **Deploying and configuring the MicroStrategy Mobile application, page 123**
- **The Mobile subscription workflow, page 177**
- **Managing Mobile report subscriptions, page 179**
- **Enabling real time updates for BlackBerry, page 191**
- **Troubleshooting MicroStrategy Mobile, page 194**
Prerequisites

- This chapter is primarily intended for system administrators. As such, readers are assumed to have various MicroStrategy system administrator privileges.

Overview: MicroStrategy Mobile architecture

The following diagram shows MicroStrategy Mobile as a part of the MicroStrategy architecture:

There are two main components in a MicroStrategy Mobile deployment:

- The MicroStrategy Mobile client applications, installed on an iPhone, iPad, Android device, or BlackBerry. The client applications send requests for reports and documents to Mobile Server, and display the reports when they are received.

- MicroStrategy Mobile Server, which performs the following functions:
  - Maintains the configurations for devices, and connects the devices to projects on Intelligence Server.
• Receives reports and documents from Intelligence Server, and delivers them to the iPhone, iPad, Android device, or BlackBerry Enterprise Server (BES).

The BES handles all interaction between MicroStrategy Mobile Server and the BlackBerry devices, and may encrypt the data transmitted to the devices.

Installing and configuring Mobile Server

To install MicroStrategy Mobile Server, select the MicroStrategy Mobile Server component of MicroStrategy Mobile during your MicroStrategy installation. For system requirements and specific instructions on how to install or upgrade MicroStrategy, see either the MicroStrategy Installation and Configuration Guide or the MicroStrategy Upgrade Guide.

MicroStrategy Mobile affects several specific areas that may require an administrator’s attention. These include:

• Authentication settings for the Mobile Server application, page 115
• Privileges and permissions, page 116
• SSL encryption, page 117
• Client authentication with a certificate server, page 117
• Destination folder for the Photo Uploader widget, page 122

Authentication settings for the Mobile Server application

The following instructions apply only to authenticating the Mobile Server application on the machine that it runs on. For instructions on setting up user authentication for your MicroStrategy environment, such as LDAP or single sign-on authentication, refer to the MicroStrategy System Administration Guide.

If you are using the ASP.NET version of Mobile Server, make sure that you configure the IIS authentication settings for the Mobile Server application. Otherwise certain reports and documents may display incorrectly or fail to execute.
You must make sure that IIS uses anonymous authentication to access all directories at the Mobile Server application level. In addition, you must enable integrated Windows authentication for all directories except the following image directories:

- MicroStrategyMobile/asp/images
- MicroStrategyMobile/images

Integrated Windows authentication must be disabled for these directories.

For instructions on how to configure the authentication settings in your version of IIS, see the IIS documentation.

**Privileges and permissions**

Reports viewed in Mobile are subject to the same security restrictions as reports viewed in any other MicroStrategy client. In particular, access control lists (ACLs) and security filters are applied to reports viewed in Mobile in the same way as in MicroStrategy Web or Desktop.

To view reports in Mobile, users must have the Use MicroStrategy Mobile privilege for all projects containing reports they want to view. In addition, to view Report Services documents in Mobile, users must have the Mobile View Documents privilege for all projects containing documents they want to view. Both these privileges can be found in the MicroStrategy Mobile privilege group.

It is the responsibility of the system administrator to ensure that MicroStrategy Mobile users have the privileges and permissions necessary to view reports and documents. In general, this means that users should have the Execute permission for any reports they are subscribed to, and for any objects contained in those reports.

For information on setting user privileges and object permissions, see the Setting Up User Security chapter in the System Administration Guide, or see the Help for MicroStrategy Desktop. For a complete list of user privileges, see the List of Privileges chapter in the Supplemental Reference for System Administration.
SSL encryption

MicroStrategy Mobile is equipped to take advantage of Secure Socket Layer (SSL) encryption, to ensure that your data remain secure at all stages of transmission. SSL transmissions can be identified by the `https://` prefix, instead of the standard `http://` prefix.

For detailed instructions on configuring Mobile Server to use SSL, see the Enabling Secure Communications chapter in the MicroStrategy System Administration Guide.

If you are using MicroStrategy Mobile for Android devices, you can specify a location for trusted certificates in the Connectivity Settings tab in the Mobile Configuration.

If you are using MicroStrategy Mobile for the BlackBerry, all communication between the BlackBerry and the BlackBerry Enterprise Server (BES) is encrypted. Communication between the BES and Mobile Server is only encrypted if you are using an SSL connection. The use of SSL is necessary for security if the BES and Mobile Server are not behind the same firewall, or if your configuration does not include a BES.

Client authentication with a certificate server

MicroStrategy Mobile Server can use a certificate server to authenticate the identity of all mobile clients. This certificate server can run on the same application server as the Mobile Server, or on a different one.

When client authentication is enabled and a certificate server is configured, a valid certificate must be issued to mobile clients that allows them to gain access to the Mobile Server. This process ensures that each mobile device is authorized to access the system, and allows you to deny authentication requests from devices which may have been compromised.

To set up the client certificate server


2. Install the certificate server using the ASP or JSP installation file from your MicroStrategy installation folder. The ASP files are located in
MicroStrategy\Mobile Server ASPx\CertificateServer. The JSP file is located in MicroStrategy\Mobile Server JSP\CertificateServer.war.

Note the following:

- To set up a certificate server with Microsoft Internet Information Services (IIS) 6.0, you must have the Read Scripts and Run Scripts permissions, and you must deploy the certificate server as a virtual directory.
- To set up a certificate server with Microsoft Internet Information Services (IIS) 7.0 or newer, you must deploy the certificate server as an application.

3 You must choose a public certificate to configure the certificate server. Either use the same certificate generated for SSL, or obtain a different one.

4 Once you have the certificate, install it on your application server, add it to a previously created trust list, and enable client authentication. Refer to your application server documentation for information on installing the certificate, creating a trust list, and configuring the application server to use client authentication.

Configuring the certificateServerConfig.xml file

5 Specify the desired Intelligence Server and project name in the certificateServerConfig.xml file, located by default in MicroStrategy\Mobile Server ASPx\CertificateServer\WEB-INF\xml\certificateServerConfig.xml for the ASP version, or MicroStrategy\Mobile Server JSP\CertificateServer\WEB-INF\xml\certificateServerConfig.xml for the JSP version. This information is used to authenticate clients before they have obtained a certificate.

6 In the certificateServerConfig.xml file, ensure that the correct provider is selected. This information is dependent on the MicroStrategy Mobile Server platform, as displayed in the following example for Tomcat application servers:

```xml
<provider class="com.microstrategy.web.certificate.TomcatCertificateProvider"/>
```

7 In the certificateServerConfig.xml file, ensure that the X.509 parameters are correctly configured for your environment.
8 In the certificateServerConfig.xml file, specify your signing certificate format as either Java Keystore (JKS) or Distinguished Encoding Rules (DER).

9 To enable the certificate server to revoke specified client certificates, set up the Certificate Revocation List (CRL) on the application server. Also configure the CRL Distribution Point (CDP) to designate a URL where the application server can check for CRLs. Configure the CDPLocation parameter in the certificateServerConfig.xml file by specifying the URL for the CRL. Refer to your application server documentation for information on configuring the CRL and CDP.

**Enabling the certificate server in the Mobile configuration**

10 When creating your MicroStrategy Mobile configuration, in the iPhone Settings, iPad Settings, Phone, or Tablet tab, select the Use Certificate Server check box, and in the text field, specify a URL for the certificate server. Because the certificate server must be configured with SSL, ensure that the URL employs the fully qualified name of the certificate server, and begins with https://, as in the following examples.

ASP:

```plaintext
https://fully_qualifed_domain_name:port/
CertificateServer/asp/certificate.aspx
```

JSP:

```plaintext
https://fully_qualifed_domain_name:port/
CertificateServer
```

or

```plaintext
https://fully_qualifed_domain_name:port/
CertificateServer/servlet/certificate
```

where:

- `fully_qualifed_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.

For more information on creating a mobile configuration, see *Configuring MicroStrategy Mobile for iPhone or iPad, page 127* or *Configuring MicroStrategy Mobile for Android, page 135*. 
**Downloading a certificate to a mobile client**

11 When a client requires a certificate, the Mobile user is prompted to begin the download. When a user clicks OK to begin the download, she is prompted to log in to the project specified in the `certificateServerConfig.xml` file.

Users can also manually download a client certificate from the Advanced Settings screen of the MicroStrategy Mobile application. For more information, see *Downloading a client certificate from the certificate server, page 158.*

**Managing certificates with the certificate server API**

12 To obtain a certificate for each mobile device through the API, use one of the following URLs.

**ASP:**

```plaintext
https://fully_qualified_domain_name:port/
GetCertificate&loginParams=
<auth><device_id>mobile_device</device_id><pkcs12_password>keystore_password</pkcs12_password><field n="pwd" v="MSTR_password"/>
</auth>
```

**JSP:**

```plaintext
https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate?action=
GetCertificate&loginParams=
<auth><device_id>mobile_device</device_id><pkcs12_password>keystore_password</pkcs12_password><field n="pwd" v="MSTR_password"/>
</auth>
```

where:

- `fully_qualified_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.
- `mobile_device` is the UUID of the desired mobile device.
- `keystore_password` is the pkcs12 password that is used for the generated keystore.
• **MSTR_password** is the desired user’s MicroStrategy password for the project specified in `certificateServerConfig.xml`.

• **MSTR_login** is the desired user’s MicroStrategy login for the project specified in `certificateServerConfig.xml`.

13 To view a list of certificates on the certificate server through the API, the application server administrator uses one of two URLs, as displayed in the examples below.

**ASP:**

```
https://fully_qualified_domain_name:port/
GetCertificateList
```

**JSP:**

```
https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificateAdmin?action=
GetCertificateList
```

where `fully_qualified_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.

14 To revoke a specific certificate through the API, the application server administrator uses one of two URLs, as displayed in the examples below.

**ASP:**

```
https://fully_qualified_domain_name:port/
RevokeCertificate&serialNumber=serial_number
```

**JSP:**

```
https://fully_qualified_domain_name:port/servlet/certificateAdmin?action=
RevokeCertificate&serialNumber=serial_number
```

where:

• `fully_qualified_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.

• `serial_number` is the serial number of the certificate to be revoked. This number can be retrieved from the list of certificates.
To revoke all certificates for a specific mobile device through the API, the application server administrator uses one of two URLs, as displayed in the examples below.

ASP:


JSP:


where:

- `fully_qualified_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.
- `device_uuid` is the universally unique identifier of the desired mobile device.

**Destination folder for the Photo Uploader widget**

The Photo Uploader widget allows Mobile users to upload images from their mobile devices to a central location that is specified in the `microstrategy.xml` file on the Mobile Server. By default, the `microstrategy.xml` file is located in your MicroStrategy installation location in `MicroStrategy\Mobile Server ASPx\WEB-INF` or in `MicroStrategy\Mobile Server JSP\WEB-INF`, depending on the application server that runs your Mobile Server.

Configure the desired location for saved images by specifying a relative or absolute path in the `value` field of the `resourcesFolderSavedImage` parameter in the `microstrategy.xml` file. If you have clustered Mobile Servers in your environment and you would like to store all saved images in a central location, specify an absolute path to the desired location in the `microstrategy.xml` file of each individual Mobile Server, and ensure that all Mobile Servers are able to access that location.
Deploying and configuring the MicroStrategy Mobile application

Once you have installed and configured MicroStrategy Mobile Server, you need to install and configure the MicroStrategy Mobile application on your company’s mobile devices. These steps vary depending on whether you are using MicroStrategy Mobile for iPhone or iPad, MicroStrategy for Android, or MicroStrategy Mobile for BlackBerry.

- **Deploying MicroStrategy Mobile for iPhone or iPad, page 123**
- **Configuring MicroStrategy Mobile for iPhone or iPad, page 127**
- **Deploying MicroStrategy Mobile for Android, page 134**
- **Configuring MicroStrategy Mobile for Android, page 135**
- **Configuring connectivity settings for iPhone, iPad, Android, and BlackBerry devices, page 140**
- **Configuring the home screen for iPhone, iPad, and Android devices, page 144**
- **Installing MicroStrategy Mobile for BlackBerry, page 160**
- **Configuring MicroStrategy Mobile for BlackBerry, page 162**

**Deploying MicroStrategy Mobile for iPhone or iPad**

For a list of supported iPhone and iPad devices and operating systems, see the MicroStrategy Readmes.

To maintain control of your MicroStrategy Mobile implementation cycle, it is recommended that you use the iOS Enterprise Deployment process to install the MicroStrategy Mobile applications on your users’ devices.

The requirements and workflow for this process are described below.

**Overview**

The following is a high-level overview of the tasks you must perform to begin deploying the MicroStrategy Mobile applications on your users’ devices:
• Download the MicroStrategy Mobile Xcode project.

• Use the iOS Developer Portal to create the files you need to build the applications in Xcode.

• Create a distributable archive of the application.

• Create a basic web page for your network, from which users can download the application.

**Prerequisites**

• You must use an Apple Mac, running Xcode 4.2 or better.

• Your organization must be enrolled in the iOS Developer Enterprise Program. For information about this program, visit http://developer.apple.com/programs/ios/enterprise/.

• You must create an Application ID for the deployed application, using the iOS Provisioning Portal. An Application ID is of the form [Code].com.yourcompany.yourappname, where Code is an alphanumeric code, called the Bundle Seed, and is generated when you create the Application ID.

  If you are deploying MicroStrategy Mobile for both iPhone and iPad, you must create an Application ID for each.

• You need a location on your network that users can access through their web browsers, using either the HTTP or HTTPS protocol. The distributable archive must be saved to this location.

**Deploying the MicroStrategy Mobile applications**

You must use Xcode to create modified versions of the MicroStrategy Mobile applications to deploy them on your users’ devices.

The third-party products discussed below are manufactured by vendors independent of MicroStrategy, and the information provided is subject to change. For detailed instructions to perform the following tasks, refer to the iOS Developer Library at http://developer.apple.com/library/ios/.
To build and deploy the MicroStrategy Mobile applications

To create a distribution certificate for MicroStrategy Mobile

1 In the Keychain Access utility on your Mac, use the Certification Assistant feature to create a Certificate Signing Request (CSR) file.

2 In the iOS Provisioning Portal, in the Certificates section, request a Distribution Certificate. When prompted, upload the CSR file you created in the previous step.

3 Once your certificate is ready, download it to your computer.

4 Use the Keychain Access utility to install the downloaded certificate to your computer.

   This certificate authorizes your Mac as a trusted computer on the network, and is used to sign the MicroStrategy Mobile applications for distribution.

To create a distribution Provisioning Profile for MicroStrategy Mobile

5 In the iOS Provisioning Portal, in the Provisioning section, create a Distribution Provisioning Profile for the application.

6 Download the Provisioning Profile to your computer.

To download and install the MicroStrategy Mobile Xcode projects

7 On your Mac, download the disk image with the MicroStrategy Mobile Xcode projects from http://download.microstrategy.com, under MicroStrategy Runtime Environment. The file name is MicroStrategy Mobile SDK.dmg.

   You must have a username and password to access the download site.

8 Double-click the downloaded file. A license agreement is displayed.

9 To accept the terms of the license agreement, click Agree. The disk image opens.

10 Copy the contents of the disk image to your computer, and eject the disk image.
To set up the Xcode projects

11 In the MicroStrategyMobile folder copied from the disk image, double-click MicroStrategyMobile.xcodeproj. The MicroStrategy Mobile project opens in Xcode.

12 Choose the MicroStrategyMobileIPhone or MicroStrategyMobileIPad scheme, as applicable.

13 Open the property list file for the scheme you are building the application for. The file names are Info_IPhone.plist or Info_IPad.plist for iPhone and iPad respectively.

14 Change the Bundle Identifier property to your organization’s Bundle Identifier.

The Bundle Identifier is of the form com.YourCompanyName.YourApplicationName, and is part of the application ID you created in the iOS Provisioning Portal.

15 For the scheme you selected, in the Build Settings section, under Code Signing, ensure that your distribution provisioning profile is selected.

To build the application for distribution

16 From the Build menu, select Build and Archive. An archived version of the application is built, with a .ipa extension.

17 Open Xcode’s Organizer window, select the archived application, and click Share Application. The Share Archived Application dialog opens.

18 Click Distribute for Enterprise. The archive is built, and you are prompted to enter the information for the application’s manifest file, which contains the information that users’ devices need to download the application.

19 Enter the information for the manifest file. In the URL field, enter the web address for the network location from which users can download the application. For example, http://YourNetworkLocation/MicroStrategyMobile.ipa.

Uploading and distributing the application

20 Upload the following files to your network location above:

- The application archive. For example, MicroStrategyMobile.ipa.
• The manifest file. For example, manifest.plist.

To distribute the application, provide users with a URL to the manifest file, using the following syntax:

```
itmss-services://?action=download-manifest&url=http://YourServerLocation/?manifest.plist
```

You can provide this URL in an email, or by using a basic HTML page that users can connect to.

### Configuring MicroStrategy Mobile for iPhone or iPad

Before a user can view reports and documents in MicroStrategy Mobile for iPhone/iPad, the application must be configured to communicate with Mobile Server and Intelligence Server. Manually configuring each device can be time-consuming and difficult. Instead, you can create a configuration, that is, an XML file containing mobile device configuration instructions, in Mobile Server. You can create a URL for a configuration and then email that URL to your mobile users. When a user opens the URL on her mobile device, the application is automatically configured using the settings in the configuration.

A single configuration can configure devices to connect to multiple Mobile Servers. Users can manually connect to any available Mobile Server, if the configuration allows them to configure the application from the mobile device. For instructions on how to configure the application from the mobile device, see Configuring the application from the device, page 157.

You can create and save multiple configurations. Each configuration can have its own login credentials, list of projects, and Home screen design. For example, you can create one configuration for regional sales managers, providing access to only those projects that report on sales data. You can then create another configuration for executives, which gives them access to all projects currently in production and also provides a Home screen with buttons for several high-level dashboards.

User logins and passwords included with a configuration should be used only for demonstration purposes, as the configuration is not transmitted or stored securely.
To create an iPhone or iPad configuration

1. Access the Mobile Server Administrator page:
   - In Windows: From the Start menu, point to Programs, then MicroStrategy, then Mobile, then Mobile Server, then select Mobile Administrator. The Mobile Server Administrator web page opens.
   - In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log on to the mstrMobileAdmin servlet using proper authentication, the Mobile Server Administrator web page opens. The default location of the Administrator servlet varies depending on the platform that you are using.

2. From the pane on the left, select Mobile Configuration.

3. Click Define New Configuration.

4. From the Device drop-down list, select either iPhone or iPad to create a configuration for the desired device.

5. In the Configuration Name field, type the name of the configuration. This is the name that is displayed in the configuration list.

Configure the iPhone or iPad settings

6. Select either the iPhone Settings or iPad Settings tab.

7. From the Memory Limit drop down list, select the amount of memory that is available to the application. Values include 25 MB, 50 MB, 100 MB, 250 MB, 500 MB, 1 GB, 2 GB, 3 GB, or 4 GB. The application uses the lower of this value and the available memory on the device. Reports and documents render faster when more memory is available to the application. The default value is 250 MB.

8. In the Network Timeout field, specify how long, in seconds, the application should wait for the network to respond before reporting a timeout. The default value is 60 seconds.

9. In the Acceptable Network Response Time field, specify an amount of time, in seconds, that is acceptable for a network response. The default value is 2 seconds.

   Along with the network timeout setting, this value determines the mobile server connection quality displayed in the Network tab of the Settings.
screen in the iPhone or iPad client. The Mobile Server quality is displayed as:

- A green image when network latency is less than the Network Timeout value.
- A red image when network latency is greater than the Network Timeout value.
- An orange image when the network latency is between the Network Timeout value and the Acceptable Network Response Time value.

10 In the **Maximum Columns in Grid** field, specify the maximum number of columns displayed at one time in a grid report. If the number of columns in the grid exceeds this value, a user can scroll to see additional columns. The default value is 10 columns.

11 From the **Logging Level** drop-down list, select the level of information to be stored in the application’s log file. You can choose from the following levels:

- **Warnings**: Errors and warnings generated by Mobile are included in the log file. This is the default option.
- **Errors**: Errors generated by Mobile are included in the log file.
- **Messages**: Messages generated by Mobile are included in the log file.
- **All**: Warnings, errors, and messages generated by Mobile are included in the log file.
- **Off**: Nothing is written in the log file.

To view the log file, in the MicroStrategy for iPhone application, from the **Settings** screen, tap **Advanced Settings**, then, in the **Logging** group, tap **View Log**.

12 In the **Maximum log size** field, specify the maximum number of entries to be stored in the log file. The default value is 50 entries.

13 In the **Check for new subscriptions every** field, type how often, in seconds, the application checks for new versions of subscribed reports and documents on Intelligence Server. The default value is 600 seconds.

14 In the **Validate device caches every** field, type how often, in seconds, the application validates the report and document caches on the device with Intelligence Server. This check only invalidates a cache on the device if the corresponding cache on Intelligence Server is invalid or expired; it
does not check whether any changes have been made to the original report or document. The default value is 600 seconds.

15 Some reports and documents have the pre-caching feature enabled, but do not use server side caching. To increase the execution performance for these objects, you can force the application to use the local caches for a specified amount of time. To do this, select the **Cache real-time data for** check box, and in the field, specify the number of seconds that a local cache remains valid.

Note the following:

- For instructions on configuring reports, documents, or the contents of a folder to be pre-cached, see *Configuring the home screen for iPhone, iPad, and Android devices, page 144*.

- If caching for a specific report or document has been disabled, you can still force it to use the pre-cache feature on a mobile device. To do this, open the report or document in Desktop, open the corresponding Report Caching Options or Document Properties dialog box, and click the **Allow mobile devices to cache data temporarily to optimize performance** check box.

16 By default, users can view and change the configuration settings in the Settings screen in the application. To prevent users from changing the configuration settings for the application, clear the **Allow users to access settings** check box.

17 By default, if a cache exists for a subscribed report or document, that cache is loaded when the user opens that report or document, and only for the page-by selection or layout that is opened. This speeds up initial access to the application. To allow access to reports and documents even when the connection to the network is intermittent, select the **Automatically pre-load subscriptions** check box. If this check box is selected, caches are loaded for all subscribed reports and documents when the application is launched.

18 By default, MicroStrategy Mobile caches the contents of folders, and does not refresh the folder unless the user shakes the device while in the folder screen. To disable folder caching and refresh folders every time that the user opens them, clear the **Cache Folders** check box.

19 By default, reports and documents are cached on the device until either the memory limit is reached or a newer version of the report or document is available. This allows access to reports and documents even when the connection to the network is intermittent. To clear the caches when the
application is closed, select the **Clear caches when the application closes** check box.

20 By default, users can modify caching settings for the Mobile application. For example, users can choose to clear or save caches when the application is closed. To prevent users from modifying caching settings, clear the **Allow users to modify caching settings** check box.

21 By default, users can modify logging settings for the Mobile application. For example, users can select the level of detail for logged statistics. To prevent users from modifying logging settings, clear the **Allow users to modify logging settings** check box.

22 By default, users can enable Diagnostic Mode in the Mobile application. Diagnostic Mode gives users access to the binary file that is generated by dashboards viewed on the mobile device. To prevent users from enabling Diagnostic Mode, clear the **Allow users to enable Diagnostic Mode** check box.

23 To enable push notification alerts, select the **Enable Push Notification** check box. For details on configuring push notification alerts, see *Configuring MicroStrategy Mobile for iPhone or iPad to receive push notifications, page 158*.

24 By default, mobile users can email, print, and save an image of the report or document that they are viewing. To disable this feature, clear the **Enable emailing, printing, and saving screenshot** check box.

25 By default, PDF documents open in MicroStrategy Mobile’s built-in PDF viewer. To disable this viewer, select the **Disable the built-in PDF viewer** check box. If this option is selected and the **Allow users to open PDF documents in external applications** check box is selected, users are prompted to choose a third party PDF viewer when they open a PDF document.

26 By default, Mobile users can use other applications to view PDF documents that are generated by MicroStrategy Mobile. To disable this privilege, clear the **Allow users to open PDF documents in external applications** check box.

27 To ignore user privilege errors when the mobile device is reconciling, select the **Ignore user privilege errors during reconcile** check box. Enable this setting if you are creating a single Mobile configuration with multiple projects that may not be accessible by all users who are using that configuration. This option eliminates the error messages that users would normally receive for each inaccessible project during
reconciliation, and removes any associated subscriptions and caches from the mobile device.

28 By default, user logins and passwords can be cached on the mobile device for a specified period of time. To stop credentials from caching on mobile devices, select the **Never Persist Credentials** check box. When this option is selected, a user is required to log in every time she opens or resumes the MicroStrategy Mobile application.

![This option is reserved for MicroStrategy use only.]

29 By default, the passwords used in the Mobile application to log in to projects and Mobile Servers do not expire. To configure passwords to expire after a certain period of time:

a In the **Password Expiration** settings, select **After**.

b From the drop-down list, select whether to specify the expiration time in **Days**, **Hours**, or **Minutes**.

c In the field, type the number of days, hours, or minutes before the passwords expire. The password expiration counts the time from when the user types a password, or, if the password is included as part of a configuration, from when the configuration is applied. Once a password expires, the user must type the password again to continue accessing that project or Mobile Server.

30 By default, the configuration used on the device is not updated automatically. To enable the mobile device to check the Mobile Server for updates to the configuration at a specified time interval:

a In the **Check and update configuration** settings, select **Every**.

b From the drop-down list, select whether to specify the time interval in **Days** or **Hours**.

c In the field, type the number of days or hours that must pass between each check for updates. The MicroStrategy Mobile application checks for an update to the Mobile configuration at this specified interval. If an update is found, the user is prompted to apply the new configuration to the mobile device. The user can then choose to apply the new configuration or wait to apply the configuration at a later time. If the user selects the latter option, the prompt reappears five minutes later.

31 To set up client authentication for Mobile Server, select the **Use Certificate Server** check box. With this option selected, you can set up a client certificate server responsible for creating certificates for mobile
clients. These certificates are required from mobile clients attempting to access the Mobile Server.

To specify the certificate server, type the certificate server’s URL in the Use Certificate Server text field. This field must begin with https:// and requires the use of the fully qualified name of the certificate server in the URL, as in the following examples.

**ASP:**

```
https://fully_qualified_domain_name:port/
CertificateServer/asp/certificate.aspx
```

**JSP:**

```
https://fully_qualified_domain_name:port/
CertificateServer

or

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate
```

where:

- `fully_qualified_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.

For detailed steps on configuring a certificate server, see *Client authentication with a certificate server, page 117.*

### 32

If a mobile device has an invalid certificate, it can still run reports and documents that are cached on the device. To clear the device cache when a certificate becomes invalid, select the **Clear caches when certificate becomes invalid** check box.

*This option is reserved for MicroStrategy use only.*

**Configure the confidential project setting**

### 33

To specify the amount of time required to elapse before a re-authentication request appears on the mobile device:

a. Type the desired number of days, hours, or minutes in the **Require re-authentication to confidential projects on resuming application after** field.

b. From the drop-down list, select whether to specify the elapsed time in **Days, Hours, or Minutes**.
c Specify at least one project as confidential in the Project Configuration area of the Connectivity Settings tab. For steps on designating a project as confidential, see *Configure a project, page 143*.

If your Mobile configuration contains at least one confidential project, the user is required to re-enter valid credentials when the MicroStrategy Mobile application is started, and after the specified period of inactivity. The inactivity period is set to 5 minutes by default.

The MicroStrategy Mobile application is considered inactive if it is running in the background, if other applications are running in the foreground, or if the mobile device is locked.

When the user brings the MicroStrategy Mobile application back to the foreground after the specified amount of time has elapsed, the user is prompted to enter valid credentials to regain access to the application.

**Configure the connectivity settings**

34 Click the **Connectivity Settings** tab to configure the connectivity settings for your iPhone or iPad. For instructions on configuring the connectivity settings, see *Configuring connectivity settings for iPhone, iPad, Android, and BlackBerry devices, page 140*.

**Configure the home screen settings**

35 Click the **Home Screen** tab to configure the appearance of the home screen in the Mobile application. For detailed instructions on configuring the home screen, see *Configuring the home screen for iPhone, iPad, and Android devices, page 144*.

**Save and distribute the Mobile configuration**

36 When you are finished creating the configuration, click **Save**.

37 Generate a URL for the configuration, and distribute it to your Mobile users. For detailed instructions on generating and distributing a URL, see *Generating a URL for a configuration, page 156*.

**Deploying MicroStrategy Mobile for Android**

For a list of supported Android devices and operating systems, see the MicroStrategy Readmes.
To deploy MicroStrategy Mobile to users’ Android devices, you can send the application as an email attachment to your users. The application is installed when the users download the attachment.

**Configuring MicroStrategy Mobile for Android**

Before a user can view reports and documents in MicroStrategy Mobile for Android, the application must be configured to communicate with Mobile Server and Intelligence Server. Manually configuring each device can be time-consuming and difficult. Instead, you can create a configuration, that is, an XML file containing mobile device configuration instructions, in Mobile Server. You can create a URL for a configuration and then post that URL to an HTML page, or email it to users. Mobile users can click the URL to configure their devices. When users open the URL on their mobile devices, the application is automatically configured using the settings in the configuration.

A single configuration can configure devices to connect to multiple Mobile Servers. Users can manually connect to any available Mobile Server, if the configuration allows them to configure the application from the mobile device. For instructions on how to configure the application from the mobile device, see *Configuring the application from the device, page 157*.

You can create and save multiple configurations. Each configuration can have its own login credentials, list of projects, and Home screen design. For example, you can create one configuration for regional sales managers, providing access to only those projects that report on sales data. You can then create another configuration for executives, which gives them access to all projects currently in production and also provides a Home screen with buttons for several high-level dashboards.

User logins and passwords included with a configuration should be used only for demonstration purposes, as the configuration is not transmitted or stored securely.

---

**To create an Android Phone or Android Tablet configuration**

1. Access the Mobile Server Administrator page:

   - In Windows: From the **Start** menu, point to **Programs**, then **MicroStrategy**, then **Mobile**, then **Mobile Server**, then select **Mobile Administrator**. The Mobile Server Administrator web page opens.
• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log on to the mstrMobileAdmin servlet using proper authentication, the Mobile Server Administrator web page opens. The default location of the Administrator servlet varies depending on the platform that you are using.

2 From the pane on the left, select Mobile Configuration.

3 Click Define New Configuration.

4 From the Device drop-down list, select either Android Phone or Android Tablet to create a configuration for the desired device.

5 In the Configuration Name field, type the name of the configuration. This is the name that is displayed in the configuration list.

Configure the Android Phone or Android Tablet settings

6 Select either the Phone Settings or Tablet Settings tab.

7 From the Memory Limit drop-down list, select the amount of memory that is available to the application. Values include 25 MB, 50 MB, 100 MB, 250 MB, 500 MB, 1 GB, 2 GB, 3 GB, or 4 GB. The application uses the lower of this value and the available memory on the device. Reports and documents render faster when more memory is available to the application. The default value is 250 MB.

8 In the Network Timeout field, specify how long, in seconds, the application should wait for the network to respond before reporting a timeout. The default value is 60 seconds.

9 In the Maximum Columns in Grid field, specify the maximum number of columns displayed at one time in a grid report. If the number of columns in the grid exceeds this value, the user can scroll to see additional columns. The default value is 10 columns.

10 By default, the maximum canvas to screen ratio is set to 25. This default setting is ideal for displaying reports and documents on most device screens. Some devices with high screen resolutions can experience rendering problems with this default setting. To solve rendering problems for your reports and documents on high resolution screens, lower the value in the Maximum canvas to screen ratio field.

11 In the Check for new subscriptions every field, type how often, in seconds, the application checks for new versions of subscribed reports and documents on Intelligence Server. The default value is 600 seconds.
12 In the **Validate device caches every** field, type how often, in seconds, the application should validate the report and document caches on the device with Intelligence Server. This check only invalidates a cache on the device if the corresponding cache on Intelligence Server is invalid or expired; it does not check whether any changes have been made to the original report or document. The default value is 600 seconds.

13 Some reports and documents have the pre-caching feature enabled, but do not use server side caching. To increase the execution performance for these objects, you can force the application to use the local caches for a specified amount of time. To do this, select the **Cache real-time data for** check box, and in the field, specify the number of seconds that a local cache remains valid. For instructions on configuring reports, documents, or the contents of a folder to be pre-cached, see *Configuring the home screen for iPhone and Android Phone* or *Configuring the home screen for iPad or Android Tablet*.

If caching for a specific report or document has been disabled, you can still force it to use the pre-cache feature on a mobile device. To do this, open the report or document in Desktop, open the corresponding Report Caching Options or Document Properties dialog box, and click the **Allow mobile devices to cache data temporarily to optimize performance** check box.

14 By default, users can view and change the configuration settings in the **Settings** screen in the application. To prevent users from changing the configuration settings for the application, clear the **Allow users to access settings** check box.

15 By default, if a cache exists for a subscribed report or document, that cache is loaded when the user opens that report or document, and only for the page-by-page selection or layout that is opened. This speeds up initial access to the application. To allow access to reports and documents even when the connection to the network is intermittent, select the **Automatically pre-load subscriptions** check box. If this check box is selected, caches are loaded for all subscribed reports and documents when the application is launched.

16 By default, MicroStrategy Mobile caches the contents of folders, and does not refresh the folder unless the user shakes the device while in the folder screen. To disable folder caching and refresh folders every time that the user opens them, clear the **Cache folders** check box.

17 By default, reports and documents are cached on the device until either the memory limit is reached or a newer version of the report or document is available. This allows access to reports and documents even when the
connection to the network is intermittent. To clear the caches when the
application is closed, select the **Clear caches when the application
closes** check box.

18 By default, users can modify caching settings for the Mobile application. For example, users can choose to clear or save caches when the application is closed. To prevent users from modifying caching settings, clear the **Allow users to modify caching settings** check box.

19 By default, users can enable Diagnostic Mode in the Mobile application. Diagnostic Mode gives users access to the binary file that is generated by dashboards viewed on the mobile device. To prevent users from enabling Diagnostic Mode, clear the **Allow users to enable Diagnostic Mode** check box.

20 By default, the configuration used on the device is not updated automatically. To enable the mobile device to check the Mobile Server for updates to the configuration at a specified time interval:

a  In the **Check and update configuration** settings, select **Every**.

b  From the drop-down list, select whether to specify the time interval in **Days**, **Hours**, or **Minutes**.

In the field, type the number of days, hours, or minutes, that must pass between each check for updates. The MicroStrategy Mobile application checks for an update to the Mobile configuration at this specified interval. If an update is found, the user is prompted to apply the new configuration to the mobile device. The user can then choose to apply the new configuration or wait for a later time. If the user selects the latter option, the prompt reappears five minutes later.

21 To set up client authentication for Mobile Server, select the **Use Certificate Server** check box. With this option selected, you can set up a client certificate server responsible for creating certificates for mobile clients. These certificates are required from mobile clients attempting to access the Mobile Server. To specify the certificate server, type the certificate server’s URL in the **Use Certificate Server** text field. This field must begin with `https://` and requires the use of the fully qualified name of the certificate server in the URL, as in the following examples.

**ASP:**

```
https://fully_qualified_domain_name:port/
CertificateServer/asp/certificate.aspx
```

**JSP:**
https://fully_qualified_domain_name:port/
CertificateServer

or

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate

where:

- `fully_qualified_domain_name:port` is the location and port of your certificate server. For example, `machine_name.domain.com:8443`.

For detailed instructions on configuring a certificate server, see *Client authentication with a certificate server, page 117*.

22 If you have Android devices that do not contain Google Maps external libraries, you must specify a Google Maps API key to enable Google Maps. To do this, select the **Enable maps** check box and type your organization's Google Maps API key in the **Key** field. To specify a Premiere key, select the **Premiere key** check box, and type the URL for your organization's Premiere key in the **URL** field.

**Configuring passcode and encryption options**

23 To require users to enter a password to access the application, and to enable the encryption of caches on their mobile devices, select the **Requires passcode (required for Data Encryption)** check box. When this option is selected, a Mobile user must create a password the first time that she opens the Mobile application. The user is then prompted for the password each time that she attempts to open the application.

-Mobile device caches are encrypted only if the Requires passcode check box is selected.

24 To specify requirements for the passwords that Mobile users enter to gain access to the Mobile application, use the following settings under **Encryption options**:

a To require at least one numeric character in the password, select the **Requires at least one numeric character** check box.

b To require at least one special character in the password, select the **Requires at least one special character ($, @, %...)** check box.

c To require at least one capital letter in the password, select the **Requires at least one capital letter** check box.
To specify a minimum number of characters for the password, type the desired number, in characters, in the **Minimum passcode length** text box. The default value is 4 characters.

e To specify a maximum number of failed login attempts before a user is locked out of the Mobile application, type the desired maximum number in the **Maximum number of failed logon attempts** text box. The default value is 10 characters.

f To specify the number of seconds that a user is locked out of the Mobile application after meeting the maximum number of failed logins, type the desired amount of time, in seconds, in the **Lockout duration** text box. The default value is 0 seconds.

25 To continue the mobile configuration, click the **Connectivity Settings** tab. For detailed instructions on configuring connectivity settings, see *Configuring connectivity settings for iPhone, iPad, Android, and BlackBerry devices, page 140.*

**Configuring connectivity settings for iPhone, iPad, Android, and BlackBerry devices**

To configure mobile devices to communicate with Mobile Server and provide access to projects, you must provide connection and authentication information. Configure the connection and authentication information for your Mobile Server(s) and project(s) in the Connectivity Settings tab of the Mobile Configuration.

Configure the connectivity settings

1 From the Mobile Configuration, select the **Connectivity Settings** tab.

2 Under **Default Mobile Server Authentication**, specify the default Mobile Server authentication settings.

   a From the **Authentication Mode** drop-down list, select the default authentication mode to use to log in to the Mobile Server machine. For iPhone, iPad, or BlackBerry, to use a trusted authentication
provider such as Tivoli or SiteMinder, you must choose **Basic** and enter your credentials for the trusted authentication provider.

If you are using HTML forms for trusted authentication with the iPhone or iPad, you can choose Anonymous, Basic, or Windows as the default Mobile Server authentication mode.

b For basic or Windows authentication, in the **Login** field, type the user name. To use basic authentication with a trusted authentication provider, type your trusted authentication provider login.

c For basic or Windows authentication, in the **Password** field, type the password for the login. To use basic authentication with a trusted authentication provider, type your trusted authentication provider password.

d For basic or Windows authentication, you can override login credentials that users may have specified on their mobile devices. To do this, select the **Overwrite user-specified credentials when applying configuration** check box.

3 Click **Configure New Mobile Server**.

4 In the **Mobile Server name** field, type the fully qualified host name of this machine. This is the Mobile Server that the application will connect to.

   For iPhone, iPad, or BlackBerry, if you are using trusted authentication, in this field, type the URL that is monitored by your trusted authentication provider. For example, if you are using Tivoli for trusted authentication, type `http://tivoli_machine:port/junctionName/`. For additional information on trusted authentication, see the **System Administration Guide**.

5 If mobile clients must use a different name to access the Mobile Server, select the **Mobile clients access this server using the following external name** check box, and type the name in the field. For example, type the externally accessible name of a load balancer in `machine-name.domain.com` format.

6 In the **Mobile Server port** field, type the port number that is used by Mobile Server on this machine.

7 In the **Mobile Server path** field, type the path to the MicroStrategy Mobile Server files on this machine.
8 From the **Mobile Server type** drop-down list, select **ASP.NET** for MicroStrategy Mobile, or **J2EE** for MicroStrategy Mobile Universal.

9 From the **Request type** drop-down list, specify whether the mobile devices use **HTTP** (no encryption) or **HTTPS** (HTTP encryption) to access the Mobile Server. For more information about HTTP and HTTPS and instructions on configuring Secure Sockets Layer (SSL), see **SSL encryption, page 117**.

   You must decide whether to configure your Mobile Server to use SSL prior to creating mobile configurations. If you attempt to implement SSL on your Mobile Server after creating mobile configurations, you will not be able to update any configuration that has a Request Type of HTTP.

10 The default Mobile Server authentication settings specified above are used to log in to the Mobile Server. To use different login credentials, clear the **Use default authentication** check box and specify the Mobile Server authentication settings:

   a From the **Authentication mode** drop-down list, select the default authentication mode to use to log in to the Mobile Server machine. For iPhone, iPad, or BlackBerry, to use a trusted authentication provider such as Tivoli or SiteMinder, you must choose **Basic** and enter your credentials for the trusted authentication provider.

   If you are using HTML forms for trusted authentication with the iPhone or iPad, you can choose Anonymous, Basic, or Windows as the Mobile Server authentication mode.

   b For basic or Windows authentication, in the **Login** field, type the user name. To use basic authentication with a trusted authentication provider, type your trusted authentication provider login.

   c For basic or Windows authentication, in the **Password** field, type the password for the login. To use basic authentication with a trusted authentication provider, type your trusted authentication provider password.

   d For basic or Windows authentication, you can override login credentials that a user may have specified on their mobile device. To do this, select the **Overwrite user-specified credentials when applying configuration** check box.
11 Under **Default Project Authentication**, specify the default project authentication settings.

a From the **Authentication mode** drop-down list, select the type of authentication used by the Intelligence Server.

   - If you select **Trusted Authentication** or **Windows Authentication**, the **Login** and **Password** fields are disabled. For iPhone, iPad, or BlackBerry, to use trusted authentication you must supply your trusted authentication provider credentials in the Mobile Server Authentication section above.

b In the **Login** field, type the MicroStrategy user name to be used by the application to log in to the Intelligence Server.

c In the **Password** field, type the password for that user name.

d For standard, LDAP, and database authentication, you can override login credentials that a user may have specified on their mobile device. To do this, select the **Overwrite user-specified credentials when applying configuration** check box.

**Configure a project**

12 Configure a project that contains reports and documents intended to be viewed on the mobile device:

a Click **Configure New Project**.

b Select the desired project from the **Project Name** drop-down list.

c The default project authentication settings specified above are used to log in to the project. To use different login credentials, clear the **Use Default Authentication** check box and specify the project authentication settings.

d To specify a root folder, other than the project’s default, select the **Use root folder** check box. Click the down arrow to select the desired root folder.

e To require iPhone and iPad users to provide credentials for a project after a period of inactivity, based on the elapsed time specified in the **Require Re-authentication to Confidential Projects on Resuming Application After** field, click **Treat project content as confidential**. For more information on setting the re-authorization timeout for confidential projects, see **Configure the confidential project setting**, page 133.

   - Note the following:
• Mobile configurations that contain multiple confidential projects must be configured to use the same login credentials for each of those projects. To do this, select the **Use Default Authentication** check box for every confidential project and configure the Default Project Authentication area of the Connectivity Settings.

• The confidential project setting can be configured only with the standard, LDAP, and database authentication types.

  Designate whether the login is case-sensitive by selecting or clearing the **User login is case sensitive** check box.

13 To configure another project, click **Configure New Project**. Enter the information for this project.

14 To configure another Mobile Server, click **Configure New Mobile Server**. Enter the information for this Mobile Server.

**Add a trusted certificate for SSL encryption for Android devices**

15 If you are using SSL encryption for communication between Android devices and Mobile Server, you must specify the location of your trusted certificate. A certificate is required for secure client authentication with the Mobile Server. To add a new certificate, click **Add New Certificate** and enter the URL for the certificate in the **Trusted Certificates** text box.

  The URL for the trusted certificates must be accessible from the Android devices.

**Configuring the home screen for iPhone, iPad, and Android devices**

You can specify whether the user is presented with the default MicroStrategy Mobile home screen, a folder or report that you specify, or a custom home screen when they open the MicroStrategy Mobile application. To do this, configure the settings in the Home Screen tab of the Mobile Configuration.
Configure the home screen

1. From the Mobile Configuration, select the Home Screen tab.

2. To display the default MicroStrategy Mobile home screen when the application is started, select Display the default home screen. The default home screen contains buttons for Projects, Folders, Settings, and Help.

3. To display the contents of a folder when the application is started:
   a. Select Display the contents of a folder.
   b. Click the down arrow next to the Object field. A dialog box opens.
   c. From the Project drop-down list, select the project that contains the folder you want to display. This must be a project that the configuration has been granted access to on the Connectivity Settings tab.
   d. In the User name and Password fields, type the user name and password to log in to the project.
   e. Browse to the folder and click Use current folder. The dialog box closes and the browse folder is specified in the field. This is the root folder where the Mobile user begins browsing for reports and documents.
   f. By default, Mobile Server checks for a cached subscription when a Mobile user selects a report or document from the browse folder. To execute the report or document without checking for a cached subscription, clear the Check subscription check box. Disabling this option ensures that reports and documents are updated, but this execution requires more time than displaying cached subscriptions.
   g. You can configure the application to cache and preload the contents of a folder in the background when the application reconciles. This feature creates a faster response time for the contents of the desired folder, and allows you to cache objects on the mobile device without requiring users to manually execute them. To enable cache preloading, select the Pre-cache contents at startup check box.

   To increase the execution performance of pre-cached objects that do not have server side caching enabled, specify an appropriate amount of time for local caches to remain valid. To do this, enter the amount of time in the Cache real-time data for field in the
iPhone, iPad, Phone, or Tablet Settings tab. For detailed instructions on configuring this option, see Configuring MicroStrategy Mobile for iPhone or iPad, page 127 or Configuring MicroStrategy Mobile for Android, page 135.

4 To create a customized home screen, select **Display a custom home screen**. Specify the options for each button. For detailed instructions on how to create a custom home screen, see Creating a custom home screen, page 146.

5 Click **Save**. The configuration is saved.

**Creating a custom home screen**

When you create a configuration for MicroStrategy Mobile, you can choose to display a report or document on the home screen, customize the application’s home screen, or use the default home screen.

- Displaying a single report or document as the home screen, page 146
- Configuring the home screen for iPhone and Android Phone, page 148
- Configuring the home screen for iPad or Android Tablet, page 153

**Displaying a single report or document as the home screen**

You can customize the home screen to displays a single report or document when the application is started. To improve the start up performance of this report or document, configure it to pre-cache.

**To display a single report or document when the application starts**

1 Select **Display a custom home screen**.

2 Select **Display a report or document**.

3 Click the down arrow. A project login dialog box opens.

4 From the **Project** drop-down list, select the project that contains the folder you want to display. This must be a project that the configuration has been granted access to on the **Connectivity Settings** tab.
5 In the **User name** and **Password** fields, type the user name and password to log in to the project.

6 Browse to the report or document and select it. The dialog box closes and the report or document is specified in the field.

7 On the iPad, if the home screen is a report or document, you can display a progress bar along the bottom of the screen to measure the progress for subscription synchronization and pre-caching. To do this, select **Display a progress bar for subscriptions synchronization and pre-caching**. By default, the progress bar is displayed in gray. To change the color of the progress bar, click the **Color** drop-down list and select the desired color.

8 You can configure the application to cache and preload a report or document and its supporting objects folder in the background when the application reconciles. This feature creates a faster response time for the report or document you choose to display at startup.

   To increase the execution performance of pre-cached objects that do not have server side caching enabled, specify an appropriate amount of time for local caches to remain valid. To do this, enter the amount of time in the **Cache real-time data for** field in the iPhone, iPad, Phone, or Tablet Settings tab. For detailed instructions on configuring this option, see *Configuring MicroStrategy Mobile for iPhone or iPad, page 127* or *Configuring MicroStrategy Mobile for Android, page 135*.

9 To enable cache preloading for a report or document, click +.

10 From the **Action** drop-down list, select **Run report or document**.

11 From the **Object** drop-down list, select the desired report or document.

12 From the **Include a folder of supporting objects** drop-down list, select a folder that includes supporting objects for your report or document. The contents of this folder are pre-cached at startup.

   **Pre-caching a folder of supporting objects**

13 To enable cache preloading for a folder, click +.

14 From the **Action** drop-down list, select **Browse folder**.
15 From the Root drop-down list, select the desired folder. The contents of this folder are pre-cached at startup.

16 To execute the report or document without checking for a cached subscription, clear the Check subscription check box.

Displaying a progress bar for subscriptions and pre-caching

17 On the iPad, if the home screen is a report or document, you can display a progress bar along the bottom of the screen to measure the progress for subscription synchronization and pre-caching. To do this, select Display a progress bar for subscriptions synchronization and pre-caching. By default, the progress bar is displayed in gray. To change the color of the progress bar, click the Color drop-down list and select the desired color.

Configuring the home screen for iPhone and Android Phone

The default home screen for MicroStrategy Mobile on iPhone and Android Phone includes the following buttons:

• Reports: Opens the list of reports that the user has subscribed to.

• Shared Library: Opens the Projects screen, which displays a list of all projects that the device has been configured to access.

• Settings: Opens the Settings screen. If the Allow users to access Settings check box (in the iPhone Settings tab) is cleared, the Settings screen displays version information and the status of the application. If this check box is selected, the Settings screen also displays configuration settings such as the memory limit.

• Help: Opens the Help for the application.

You can configure the home screen to display the contents of a folder, or a single report or document.

You can also customize the home screen to display a set of custom buttons. Each button can perform one of the following actions:

• Run a report or document

• List the projects available in the application

• List all reports or documents the user has subscribed to

• Open the Settings screen
• Open the Help for the application

Depending on how many buttons you define, the buttons are arranged as follows:

• If the home screen has one to four buttons, the buttons are arranged in one column of four rows.
• If the home screen has five or six buttons, the buttons are arranged in two columns of three rows.
• If the home screen has seven to nine buttons, the buttons are arranged in three columns of three rows.
• If the home screen has more than nine buttons, the buttons are arranged in multiple pages. Each page contains three columns of three rows of buttons.

To create a custom home screen for iPhone or Android Phone

1 In the Mobile Administrator home page, in the Mobile Configuration page, define a new configuration, or modify an existing configuration. For instructions on how to define a new configuration, see Configuring MicroStrategy Mobile for iPhone or iPad, page 127 or Configuring MicroStrategy Mobile for Android, page 135.

2 Select the Home Screen tab.

3 Select Display a custom home screen.

4 Select Display a custom list of folders, documents, or reports. A preview of the custom home screen is displayed on the left, and the customization options are displayed on the right.

Define the buttons

5 Select a button in the preview.

6 From the Buttons drop-down list, select Action.

7 From the Select drop-down list, specify the action that you want the button to take:

• Run report or document: Executes a specific report or document. To specify the report or document, click the arrow next to Object, select the project containing the report or document, log in, and browse to
the report or document. To create faster response times on iPhone by pre-caching the document or report in the background when the application starts, select the **Pre-cache at startup** check box. To pre-cache the supporting objects for the report or document on iPhone or Android Phone, select the desired folder from the **Include a folder of supporting objects** drop-down list.

- To increase the execution performance of pre-cached objects that do not have server side caching enabled, specify an appropriate amount of time for local caches to remain valid. To do this, enter the amount of time in the **Cache real-time data for** field in the iPhone or Phone Settings tab. For detailed instructions on configuring this option, see *Configuring MicroStrategy Mobile for iPhone or iPad, page 127* or *Configuring MicroStrategy Mobile for Android, page 135*.

- **Browse folder**: Opens a specific folder. To specify the folder, click the arrow next to **Root**, select the project containing the folder, log in and browse to the folder.

- You can allow MicroStrategy Mobile for iPhone users to browse folders made available over the web through the WebDAV protocol. To do this, you must create an External Mobile Folder and specify it as a Browse Folder. For detailed steps to create an External Mobile Folder, see the *MicroStrategy Advanced Reporting Guide*.

By default, Mobile Server checks for a cached subscription when a Mobile user selects a report or document from the browse folder. To execute the report or document without checking for a cached subscription, clear the **Check subscriptions** check box. Disabling this option ensures that reports and documents are updated, but this execution requires more time than displaying cached subscriptions.

To create faster response times on iPhone or Android Phone by pre-caching the folder in the background when the application starts, select the **Pre-cache at startup** check box.

- To increase the execution performance of pre-cached objects that do not have server side caching enabled, specify an appropriate amount of time for local caches to remain valid. To do this, enter the amount of time in the **Cache real-time data for** field in the iPhone or Phone Settings tab. For detailed instructions on configuring this option, see *Configuring MicroStrategy Mobile for iPhone or iPad, page 127* or *Configuring MicroStrategy Mobile for Android, page 135*. 
• **Go to Settings**: Opens the Settings screen. If the **Allow users to access Settings** check box (in the **iPhone or Phone Settings** tab of the **Mobile Configuration** page) is cleared, the Settings screen displays version information and the status of the application. If this check box is selected, the Settings screen also displays configuration settings such as the memory limit.

• **Go to Reports**: Opens the Reports screen, which displays the reports and documents the user has subscribed to.

  This option is available for the iPhone and iPad.

• **Go to Shared Library**: Opens the Shared Library screen, which displays a list of all projects that the device has been configured to access.

• **Go to Help**: Opens the Help for the application.

8 From the **Buttons** drop-down list, select **Caption**.

9 In the **Caption** field, type the text to be displayed on the button.

10 In the **Description** field, type any notes about the button. This field is only for reference within the configuration, and is not visible to the user.

11 To change the image used for the button's icon:

   a From the **Buttons** drop-down list, select **Icon**.

   b Select **Use my own**.

   c In the **Image URL** field, specify the location of the image to use as the icon for the button.

12 To add a new button, click **Add a button**. The button is displayed in the preview.

13 To delete a button, select the button and click **Remove a button**.

**Configure the button display**

14 From the **Format** drop-down list, select **Button Style**.

15 From the **Border Color** color picker, select the color used in the outline of the button.

16 From the **Fill Color** color picker, select the color used in the background of the button.
17 From the **Font Color** color picker, select the color of the font used in the button captions.

18 From the **Style** drop-down list, select the style to apply to the buttons:

- **Glass**: Same as **Flat**, but with a gloss applied on top of the background and icon.

- **Flat**: The **Border Color** and **Fill Color** properties (see below) define a background for the button. The active area of the button includes the icon and the background.

- **None**: No background is used. The only active area of the button is the icon itself. The **Border Color** and **Fill Color** properties (see below) are ignored when this style is selected.

**Specify the background**

19 From the **Format** drop-down list, select **Background**.

20 To set the background to a specific color, select **Fill Color** and, from the color picker, select that color.

21 To use a custom image as the background, select **Image**, and specify the location of the image in the **Image URL** field.

   The image must be no larger than 320 pixels wide and 416 pixels high.

**Configure the title bar**

22 From the **Format** drop-down list, select **Title Bar**.

23 To specify text to be displayed in the title bar, select **Caption** and, in the field, type the text to be displayed.

24 To display an image as the title bar, select **Image URL** and, in the text field, specify the location of the image.

   The image must be no larger than 232 pixels wide and 44 pixels high.

25 When you are ready to save the custom Home screen with the configuration, click **Save**. The configuration and the custom home screen are saved.
Configuring the home screen for iPad or Android Tablet

The default home screen for MicroStrategy Mobile on iPad and Android Tablet displays all projects that the device has been configured to access. In the menu bar it displays the following options:

- **Home or Shared Library**: Displays the list of projects.
- **Reports or Subscriptions**: Displays the reports and documents the user has subscribed to.

On the iPad, the application also has an in the upper right. Tapping on iPad or hitting the menu button on an Android tablet brings up a menu with the following options:

- **Settings**: Displays version information and the status of the application. If the **Allow users to access Settings** check box (in the iPad Settings or Tablet Settings tab of the Mobile Configuration page) is selected, the Settings screen also displays configuration settings such as the memory limit.
- **Help**: Displays the Help for the application.
- **Configure MicroStrategy Cloud Personal**: Lets iPad users log in to their accounts and configure their devices to access MicroStrategy Cloud Personal dashboards.

You can configure the home screen to display the contents of a folder, or a single report or document. You can also customize the home screen to display a set of custom buttons. These buttons are displayed in a list. Each button can perform one of the following actions:

- Run a report or document
- List the reports or documents in a folder
- List the projects available in the application

---

To create a custom home screen for iPad or Android Tablet

1. In the **Mobile Administrator** home page, in the **Mobile Configuration** page, define a new configuration, or modify an existing configuration. For instructions on how to define a new configuration, see Configuring MicroStrategy Mobile for iPhone or iPad, page 127 or Configuring MicroStrategy Mobile for Android, page 135.
2 Select the Home Screen tab.

3 Select Display a custom home screen.

4 Select Display a custom list of folders, documents, or reports. A preview of the custom home screen is displayed on the left, and the customization options are displayed on the right.

Define the buttons

5 Select a button in the preview.

6 From the Action drop-down list, specify the action that you want the button to take:

- **Run report or document**: Execute a specific report or document. To specify the report or document, click the arrow next to this option, select the project containing the report or document, and browse to the report or document. To create faster response times on iPad or Android Tablet by pre-caching the document or report in the background when the application starts, select the **Pre-cache at startup** check box. To pre-cache the supporting objects for the report or document, select the desired folder from the Include a folder of supporting objects drop-down list.

  To ensure that pre-cached objects are used by the application, select the **Cache real-time data for** check box in the iPad or Tablet Settings tab. For detailed instructions on configuring this option, see Configuring MicroStrategy Mobile for iPhone or iPad, page 127 or Configuring MicroStrategy Mobile for Android, page 135.

- **Browse folder**: Open a specific folder. To specify the folder, click the arrow next to this option, select the project containing the folder, and browse to the folder.

  You can allow MicroStrategy Mobile for iPad users to browse folders made available over the web through the WebDAV protocol. To do this, you must create an External Mobile Folder and specify it as a Browse Folder. For detailed steps to create an External Mobile Folder, see the MicroStrategy Advanced Reporting Guide.

By default, Mobile Server checks for a cached subscription when a Mobile user selects a report or document from the browse folder. To execute the report or document without checking for a cached subscription, clear the **Check subscriptions** check box. Disabling
this option ensures that reports and documents are updated, but this execution requires more time than displaying cached subscriptions.

To create faster response times by pre-caching the folder in the background when the application starts, select the Pre-cache at startup check box.

To ensure that pre-cached objects are used by the application, select the Cache real-time data for check box in the iPad or Tablet Settings tab. For detailed instructions on configuring this option, see Configuring MicroStrategy Mobile for iPhone or iPad, page 127 or Configuring MicroStrategy Mobile for Android, page 135.

• Go to Shared Library: Open the Shared Library screen, which displays a list of all projects that the device has been configured to access.

• Browse MicroStrategy Cloud Personal: For iPad users, display a list of MicroStrategy Cloud Personal dashboards that have recently been shared with the user, as well as the user's own MicroStrategy Cloud Personal dashboards.

7 To add a new button, click Add a button. The button is displayed in the preview.

8 To delete a button, select the button and click Remove a button.

9 To move a button up or down in the display, select the button and click Move down or Move up.

Specify the contents of the home screen selector

10 Select the check box next to each item that you want to appear in the Home screen:

• Reports view: Adds Reports to the home screen selector. Tapping Reports displays the reports and documents the user has subscribed to.

• Settings: Adds Settings to the menu on the iPad or the menu button on an Android tablet. Tapping Settings displays version information and the status of the application. If the Allow users to access Settings check box (in the iPad Settings or Tablet Settings tab of the Mobile Configuration page) is selected, the Settings screen also displays configuration settings such as the memory limit.
• **Help**: Adds Help to the menu on the iPad or the menu button on an Android tablet. Tapping Help displays the Help for the application.

11 When you are ready to save the custom home screen with the configuration, click **Save**. The configuration and the custom home screen are saved.

### Generating a URL for a configuration

Once you have created a configuration for a mobile device, you need to apply that configuration to the device. To do this, you first generate a URL for the configuration.

Email the URL to your Mobile users. When these users tap the URL in the email client on their mobile device, the configuration is automatically applied to the device.

For Android users, you must create an HTML page that includes the URLs as links. When Android users tap the URL in the HTML page using the browser on their mobile device, the configuration is automatically applied to the device. To email the link to Android users, you must create a short link.

User logins and passwords included with a configuration should be used only for demonstration purposes, as the configuration is not transmitted or stored securely.

### To generate a URL for a configuration

1. In the MicroStrategy Mobile Server page, from the pane on the left, select **Mobile Configuration**.

2. For the configuration you want to generate a link for, click **Generate URL**. A Generate Configuration URL dialog box opens.

3. In the **Server Name** field, type the fully qualified host name of the machine hosting the Mobile Server that the configuration is stored on.

   If you are using trusted authentication, in this field, type the name of the trusted authentication provider machine.

4. By default, the port number used by Mobile Server is included in the URL. If you do not want to include the port number in the URL, clear the **Include port** check box.
5 If you are including the port number in the URL, select the Include port check box, and in the text box next to it, type the port number used by Mobile Server. The default is 80.

6 By default, the request type is set to HTTP. If you are using a secure connection, select HTTPS from the Request Type drop-down list.

7 From the Authentication Mode drop-down list, select an authentication mode. When the user taps the URL, she will have to provide a username and password to log in to Mobile Server using this authentication mode.

8 For Android devices, you must shorten the configuration URL before you insert it as a clickable link in an email. To do this, click Use Short URL.

9 To generate the URL, click Generate URL. The URL is generated and displayed in the dialog box. You can then copy and paste the URL into an email for iPhone and iPad users.

   Due to a limitation of the Android OS, you must use one of the following methods to send the configuration URL to users:

   • Embed the link in an HTML file
   • Create a URL using an online URL-shortening service

10 To save the URL settings, click Save. The Generate Configuration URL dialog box closes, and the authentication mode and host are saved for the next time you generate a URL for this configuration.

**Configuring the application from the device**

You can also configure MicroStrategy Mobile for iPhone, iPad, and Android through the Settings screen in the application. You need to add the connection information for the MicroStrategy Mobile server, and then configure the projects that you want to receive reports from, as described in the procedures below.

   If you have applied a configuration to the device and that configuration does not allow users to view or change the device settings, you will not be able to configure the application from your device. Contact your system administrator if you need to change your configuration settings.
To configure MicroStrategy Mobile on an iPhone, iPad, or Android device

1. Open the Settings screen:
   - On an iPhone, tap the **Settings** button.
   - On an iPad, tap **Settings**.
   - On Android, tap your device’s menu button.

   Depending on your configuration, you may not be able to access the Settings screen, or you may only be able to view the About MicroStrategy Mobile information.

2. To configure an existing server, tap the server name or IP address. To add a new server, tap **Add Mobile Server**. Specify the settings for the server as described in **Configure the connectivity settings, page 140**.

3. To configure the application settings, tap **Advanced Settings**. Specify the settings for the application as described in **Configure the iPhone or iPad settings, page 128** or **Configuring MicroStrategy Mobile for Android, page 135**.

   **Downloading a client certificate from the certificate server**

4. Click **Get Certificate**.

5. In the Authentication screen, log in using your MicroStrategy login and password. The certificate will download and display in the Advanced Settings screen.

6. To exit the settings screen and return to the Home screen, tap **Home**.

**Configuring MicroStrategy Mobile for iPhone or iPad to receive push notifications**

You can use alert-based subscriptions to ensure that users automatically receive notifications on an iPhone or iPad with MicroStrategy Mobile when a metric on a report meets specific threshold conditions. You can create an alert-based subscription using the Alerts Editor in Web. For information on creating alert-based subscriptions, see the **MicroStrategy Web Help**.
These alerts are “pushed” to MicroStrategy Mobile for iPhone or iPad by Intelligence Server. For information about how these push notifications are displayed on the device, see the MicroStrategy Mobile Analysis Guide.

The following high-level procedure provides steps to enable push notifications for MicroStrategy Mobile on an iPhone or iPad.

Prerequisites

- MicroStrategy delivers alert notifications through the Apple Push Notification Service (APNS). Therefore, you must have an Apple iOS developer license to send mobile push notifications. For information about the various iOS developer licenses available, see http://developer.apple.com/programs/.

- You must have MicroStrategy Distribution Services to use push notifications with MicroStrategy. For information about purchasing a Distribution Services license, contact your MicroStrategy account executive.

- Push notifications must be enabled on an iPhone or iPad for the device to receive MicroStrategy push notifications. In addition, the first time MicroStrategy Mobile for iPhone or iPad is opened on a device, the user is prompted to allow the application to receive push notifications.

High-level steps to enable MicroStrategy push notifications for iPhone or iPad

1. Install the APNS certificate on the Intelligence Server machine that provides the push notifications. For instructions, see the documentation provided with your iOS developer license.

2. In Desktop, create a Distribution Services device for iPhone or iPad. For detailed instructions, see the Scheduling Jobs and Administrative Tasks chapter in the MicroStrategy System Administration Guide, or see the Desktop Help.

3. Create a configuration for the application (see Configuring MicroStrategy Mobile for iPhone or iPad, page 127). In the iPhone Settings or iPad Settings tab of the configuration, make sure that you select the Enable Push Notification check box.

4. The first time the user opens MicroStrategy Mobile for iPhone or iPad on a device, the user is prompted to allow push notifications for MicroStrategy Mobile. The user must select Allow push notifications.
Installing MicroStrategy Mobile for BlackBerry

For a list of supported BlackBerry devices and operating systems, see the MicroStrategy Readmes.

The MicroStrategy Mobile application is written in Java Micro Edition (J2ME). Multiple versions of the Java .cod files are available to support the application on various BlackBerry operating systems. The library file MSTRMobile.alx automatically detects which version of the files should be installed on a given BlackBerry. By default, the application is stored on your server in the folder C:\ Program Files\MicroStrategy\Mobile Clients\BlackBerry Client. The folder C:\ Program Files\MicroStrategy\Mobile Clients\BlackBerry Client for Browser Deployment contains additional files necessary for deploying the application over the web.

There are several ways to install the MicroStrategy Mobile application:

- The recommended method is to deploy the application to multiple devices at once, through the BlackBerry Enterprise Server (BES). For more information on using the BES to deploy the application, see *Installing the application on multiple devices simultaneously, page 161.*

- You can also make the application available on your company network for individual users to download onto their devices. For more information on setting up this browser-based deployment, see *Installing the application from a website, page 161.*

- Individual users can use BlackBerry Desktop Manager to install the application onto a BlackBerry. For more information about this method of installation, see *Installing the application on individual devices, page 162.*

⚠️ If you have previously installed a demonstration version of MicroStrategy Mobile on a mobile device, you must uninstall the demonstration version before installing the full version of MicroStrategy Mobile.
Installing the application on multiple devices simultaneously

If you have administrator access to your company's BlackBerry Enterprise Server (BES), you can use the BES to push the MicroStrategy Mobile application to the devices that require it. This is the recommended method of installing the application for several reasons:

- The application can be quickly installed on multiple devices simultaneously, instead of having to be installed on each device individually.
- Updates to the application can be easily distributed to all users.
- Control over which users have installed the application is fully in the hands of the administrator.
- IT policies that control Mobile Server, authentication information, and BI applications can be configured and enforced without requiring end-user interaction. For information on configuring IT Policies over the BES, see Configuring multiple devices automatically, page 164.

Distributing the application to users by means of the BES takes between three and four hours. For detailed instructions on how to deploy an application using the BES, see the documentation provided with the BES.

Installing the application from a website

If you are unable to install the application by means of the BES, you can set up an internal website containing the MicroStrategy Mobile application installation package. Mobile device users can then individually download and install the MicroStrategy Mobile application by pointing the BlackBerry Browser to the website.

The files for browser-based deployment are stored in a subdirectory of the default installation directory: \BlackBerry Client for Browser Deployment. Multiple versions of these files are available for various BlackBerry operating systems. Each version consists of several Java .cod files and a .jad file. In addition, the directory contains two web pages, installMSTRMobile.aspx and installMSTRMobile.jsp. The user opens one of these files in the BlackBerry Browser to install the application.

To configure the MicroStrategy Mobile application for browser-based deployment, the web server administrator places the application files on the web server and installs either installMSTRMobile.aspx (for a .NET-based web server) or installMSTRMobile.jsp (for a J2EE-based
web server). The `installMSTRMobile` file must be installed in the same
directory as the application files. The administrator also creates the following
MIME type associations on the web server:

- `.jad`: text/vnd.sun.j2me.app-descriptor
- `.cod`: application/vnd.rim.cod

For instructions on deploying files to your web server and creating
MIME type associations, see the web server’s documentation.

The Blackberry user points the BlackBerry Browser to the installed
`installMSTRMobile` file. The words “Click here to install MicroStrategy
Mobile on your BlackBerry device.” appear on the screen. Clicking the link
opens a dialog box with information about the MicroStrategy Mobile
application. The user clicks the **Download** button, and the application is
downloaded and installed onto the user’s BlackBerry.

**Installing the application on individual devices**

Individual users can also tether their BlackBerry to a computer and use
BlackBerry Desktop Manager to install the MicroStrategy Mobile
application. The library file `MSTRMobile.alx` must be loaded onto the
BlackBerry. This file automatically loads the appropriate Java files to run the
application. For instructions on how to install an application on a BlackBerry
with BlackBerry Desktop Manager, see the documentation provided with
BlackBerry Desktop Manager.

BlackBerry Desktop Manager must be using the same or later version
of the BlackBerry software as the device. For example, if Desktop
Manager is version 4.1 and the BlackBerry is version 4.2, you will be
unable to load the MicroStrategy Mobile application onto the device.

**Configuring MicroStrategy Mobile for BlackBerry**

After installing the MicroStrategy Mobile application, you must configure it
so that it can communicate with your MicroStrategy system.

The BlackBerry Enterprise Server (BES) enables you to set an IT Policy for its
client applications. With this IT Policy, you can configure all the devices at
once. For details on the settings for the MicroStrategy Mobile application IT
Policy, see *Configuring multiple devices automatically, page 164*. For
detailed instructions on how to deploy an IT Policy over the BES, see the
documentation provided with the BES.
If you are not using an IT Policy, you can create a Mobile configuration from the Mobile Server Administrator page, or you can configure individual devices through the Mobile application’s Preferences screen. For instructions on creating a Mobile configuration, see Configuring the application from Mobile Server Administrator. For instructions on configuring an application manually, see Configuring the application from the BlackBerry device, page 174.

Information needed to configure the application

To retrieve report data from a Mobile Server, you must specify the following information about that server:

- The server name
- The port the server is running on
- The path to the MicroStrategy Mobile application
- The application type (ASP.NET for Mobile, or J2EE for Mobile Universal)
- The authentication mode (anonymous, basic, or Windows) and login information used to access the server’s virtual directory
- Whether the requests are sent as HTTP (unsecured) or HTTPS (secured)

For more information about the difference between HTTP and HTTPS, see SSL encryption, page 117.

In addition, you must provide the following information for each project containing reports or documents to be viewed in Mobile:

- The project’s name
- The name of the Intelligence Server that hosts the project
- The port number for that Intelligence Server
- The authentication mode and login information used to access the reports or documents in the project

By default, MicroStrategy Mobile uses standard MicroStrategy authentication to identify the user logging in to projects on the MicroStrategy Mobile Server. However, you can use any of the supported forms of authentication to log in to the server: standard authentication, Windows credentials, warehouse authentication, or LDAP authentication. For details about the different authentication modes, see the Setting up User Security chapter in the MicroStrategy System Administration Guide.
Configuring multiple devices automatically

The BlackBerry Enterprise Server (BES) enables administrators to set IT Policies for the different applications configured via the BES. For instructions on how to set IT Policies over the BES, see the documentation provided with the BES.

The settings you can configure for the MicroStrategy Mobile Client IT Policy are listed in the following table. When reviewing the table, be aware of the following markings:

- Settings marked with † are required in the IT Policy. Other settings are optional and can be omitted.
- Settings marked with * cannot be changed on the Mobile device once they have been set with the IT Policy.
- Settings marked with ** cannot be changed on the Mobile device if the MSTRWebServersLocked property in the IT Policy is set to True.

<table>
<thead>
<tr>
<th>Policy Item Name</th>
<th>Value and definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSTRUpdateWindowStartTime</td>
<td>Time of day at which the Mobile application begins retrieving reports from the Mobile Server, in the format hh:mm.</td>
</tr>
</tbody>
</table>
| MSTRUpdateWindowStartTimeType    | Determines whether the update window’s start time is based on a fixed time zone or the time zone of the device.  
  • 1 for fixed time zone  
  • 2 for device time zone        |
| MSTRUpdateWindowStartTimeZone    | The name of the time zone used to determine the update window’s start time, if the update window is not based on the device’s time zone.  
  • Example: America/New York  
  • Example: Asia/Tokyo           |
| MSTRUpdateWindowLength           | The length of the update window, in hours, from 1 to 24.                             |
| MSTRUpdateWindowMode             | Determines whether the Mobile application updates reports and documents automatically.  
  • 1 to enable automatic reconciliation  
  • 0 to disable automatic reconciliation |
<p>| * MSTRMinimumDeviceFreeMem       | Percentage of device memory that is guaranteed to not be used by the Mobile application. Possible values are 1, 5, 10, 15, 25, 30. For more information, see the MicroStrategy Mobile Analysis Guide. |</p>
<table>
<thead>
<tr>
<th>Policy Item Name</th>
<th>Value and definition</th>
</tr>
</thead>
</table>
| MSTRDisplaySizeInReportList | Determines whether the size (in KB) of each report or document is displayed in the list of reports.  
• 1 to display size  
• 0 to not display size |
| * MSTRDefaultWebServerAuthenticationMode | Use the value corresponding to the type of authentication necessary to access the MicroStrategy Mobile Server's virtual directory. For an explanation of the different authentication modes, see your web server's documentation.  
• 1 for Anonymous  
• 2 for Basic  
• 3 for Windows |
| MSTRDefaultWebServerLogin | The default login name used for the web server. |
| MSTRDefaultWebServerPassword | The password used for the default login above. |
| * MSTRTCPConnectionMode | Use the value corresponding to your web server's TCP connection mode. For an explanation of the different connection modes, see your web server's documentation.  
• 1 for Default  
• 2 for MDS Proxy  
• 3 for Direct |
| * MSTRTLSConnectionMode | Use the value corresponding to your web server's TLS connection mode. For an explanation of the different connection modes, see your web server's documentation. This setting is only relevant if at least one MicroStrategy Mobile Server uses https.  
• 1 for Default  
• 2 for End-to-End TLS Desired  
• 3 for End-to-End TLS Required |
| * MSTRWebServerCredentialsSubmissionMode | Use the value corresponding to your web server's credential submission mode. For an explanation of the different modes, see your web server's documentation. This setting is only relevant if at least one MicroStrategy Mobile Server uses Basic authentication and the BlackBerry MDS is configured to support HTTP authentication.  
• 1 for Only When Challenged  
• 2 for On Every Request |
<p>| * MSTRReportSizeLimit | Reports larger than this value (in KB) are not downloaded from the server. If this value is set to 0, all reports are downloaded from the server. |
| * MSTRMaxDataSize | Set this value to a few thousand bytes less than the Mobile Data Service Maximum Data Size. For example, if the Mobile Data Service Maximum Data Size is 128 KB, this value should be around 125000. |</p>
<table>
<thead>
<tr>
<th>Policy Item Name</th>
<th>Value and definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStrategy Mobile Servers and Projects</strong></td>
<td></td>
</tr>
<tr>
<td>† * MSTRWebServerCount</td>
<td>The number of Mobile Servers that MicroStrategy Mobile can connect to. If this setting is defined, the application looks for $i$ groups of IT Policy items named <code>MSTRWebServer$&lt;SETTING&gt;$</code>, with values of $i$ from 0 to $(MSTRWebServerCount - 1)$.</td>
</tr>
<tr>
<td>* MSTRWebServersLocked</td>
<td>If this setting is False, the user can add, remove, or modify the MicroStrategy Mobile Servers and projects that are configured on the device. If this setting is True or is not defined, all MicroStrategy Mobile Server and project settings are read-only on the device. <strong>Note</strong>: If this setting is False, the IT Policy will only be applied to the Mobile Server list if the user has not previously modified any of the server settings on the application.</td>
</tr>
<tr>
<td>† ** MSTRWebServer/Name</td>
<td>The name or IP address of a MicroStrategy Mobile Server that the device connects to.</td>
</tr>
<tr>
<td>† ** MSTRWebServer/Port</td>
<td>The port used by this MicroStrategy Mobile Server. The default value is 80.</td>
</tr>
<tr>
<td>† ** MSTRWebServer/Path</td>
<td>The path this MicroStrategy Mobile Server is installed to. • For MicroStrategy Web, this is the IIS virtual directory name. • For MicroStrategy Web Universal, this is the J2EE application.</td>
</tr>
<tr>
<td>† ** MSTRWebServer/Type</td>
<td>Indicates whether this server is running MicroStrategy Web or MicroStrategy Web Universal. • 0 for MicroStrategy Web Universal • 1 for MicroStrategy Web</td>
</tr>
<tr>
<td>† ** MSTRWebServer/Protocol</td>
<td>Set this to <code>http</code> for no encryption or <code>https</code> for SSL encryption. For an explanation of SSL encryption, see <a href="#">SSL encryption, page 117</a>.</td>
</tr>
<tr>
<td>† ** MSTRWebServer/AuthenticationMode</td>
<td>Use the value corresponding to the type of authentication necessary to access this MicroStrategy Mobile Server’s virtual directory. For an explanation of the different authentication modes, see your web server’s documentation. • 1 for Anonymous • 2 for Basic • 3 for Windows</td>
</tr>
<tr>
<td>† MSTRWebServer/Login</td>
<td>The login for this Mobile Server, if different from the default.</td>
</tr>
<tr>
<td>† MSTRWebServer/Password</td>
<td>The password for the login, if the login is different from the default.</td>
</tr>
<tr>
<td>Policy Item Name</td>
<td>Value and definition</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| ** MSTRWebServer/Default AuthenticationMode          | Use the value corresponding to the default type of authentication used to log in to projects on this MicroStrategy Mobile Server. For an explanation of the different authentication modes, see the Setting up User Security chapter in the MicroStrategy System Administration Guide.  
• 1 for Standard  
• 2 for Windows  
• 16 for LDAP  
• 32 for Warehouse Passthrough                                                                                       |
| MSTRWebServer/DefaultLogin                           | The MicroStrategy login used by default to access Mobile reports and documents on this MicroStrategy Mobile Server.                                                                                                     |
| MSTRWebServer/DefaultPassword                         | The password for the default login above.                                                                                                                                                                                  |
| † ** MSTRWebServer/ProjectCount                      | The number of projects configured on this Mobile Server that MicroStrategy Mobile retrieves reports and documents from. If this setting is defined, the application looks for \( j \) groups of IT Policy items named MSTRWebServer\{Project\}<SETTING>, with values of \( j \) from 0 to (MSTRWebServer\{ProjectCount\} - 1) |
| † ** MSTRWebServer/Project\{Name\}                   | The name of a project from which reports and documents are retrieved. Note: This field is case-sensitive.                                                                                                               |
| † ** MSTRWebServer/Project\{ServerName\}             | The name or IP address of the Intelligence Server that hosts the project.                                                                                                                                               |
| † ** MSTRWebServer/Project\{ServerPort\}             | The port use by the Intelligence Server hosting the project.                                                                                                                                                           |
| † ** MSTRWebServer/Project\{AuthenticationMode\}      | Use the value corresponding to the type of authentication necessary for the user to log in to this project on the MicroStrategy Mobile Server. For an explanation of the different authentication modes, see the Setting up User Security chapter in the MicroStrategy System Administration Guide.  
• 1 for Standard  
• 2 for Windows  
• 16 for LDAP  
• 32 for Warehouse Passthrough                                                                              |
| † MSTRWebServer/Project\{Login\}                     | The MicroStrategy login used to access Mobile reports and documents in this project, if different from the default.                                                                                                   |
| † MSTRWebServer/Project\{Password\}                  | The password for the login above.                                                                                                                                                                                       |
## Sample BES IT Policy

The table below contains a sample BES IT Policy for a BlackBerry that can access two Mobile Servers and three projects.

<table>
<thead>
<tr>
<th>Policy Item Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSTRUpdateWindowStartTime</td>
<td>05:00</td>
</tr>
<tr>
<td>MSTRUpdateWindowStartTimeType</td>
<td>1</td>
</tr>
<tr>
<td>MSTRUpdateWindowStartTimeZone</td>
<td>America/New York</td>
</tr>
<tr>
<td>MSTRUpdateWindowLength</td>
<td>3</td>
</tr>
<tr>
<td>MSTRUpdateWindowMode</td>
<td>1</td>
</tr>
<tr>
<td>MSTRMinimumDeviceFreeMem</td>
<td>25</td>
</tr>
<tr>
<td>MSTRDisplaySizeInReportList</td>
<td>1</td>
</tr>
<tr>
<td>MSTRTCPConnectionMode</td>
<td>1</td>
</tr>
<tr>
<td>MSTRTLSConnectionMode</td>
<td>1</td>
</tr>
<tr>
<td>MSTRWebServerCredentialsSubmissionMode</td>
<td>2</td>
</tr>
<tr>
<td>MSTRReportSizeLimit</td>
<td>128</td>
</tr>
<tr>
<td>MSTRMaxDataSize</td>
<td>125000</td>
</tr>
<tr>
<td>MSTRWebServerCount</td>
<td>2</td>
</tr>
<tr>
<td>MSTRWebServersLocked</td>
<td>True</td>
</tr>
<tr>
<td>MSTRWebServer0Name</td>
<td>mobilereportserver</td>
</tr>
<tr>
<td>MSTRWebServer0Port</td>
<td>80</td>
</tr>
<tr>
<td>MSTRWebServer0Path</td>
<td>MicroStrategyMobile</td>
</tr>
<tr>
<td>MSTRWebServer0Type</td>
<td>1</td>
</tr>
<tr>
<td>MSTRWebServer0Protocol</td>
<td>http</td>
</tr>
<tr>
<td>MSTRWebServer0AuthenticationMode</td>
<td>3</td>
</tr>
<tr>
<td>MSTRWebServer0Login</td>
<td>NETWORK\jdoe</td>
</tr>
<tr>
<td>MSTRWebServer0Password</td>
<td>networkpassword123</td>
</tr>
<tr>
<td>MSTRWebServer0ProjectCount</td>
<td>2</td>
</tr>
<tr>
<td>MSTRWebServer0Project0Name</td>
<td>Human Resources Analysis</td>
</tr>
<tr>
<td>MSTRWebServer0Project0ServerName</td>
<td>archimedes</td>
</tr>
<tr>
<td>MSTRWebServer0Project0ServerPort</td>
<td>80</td>
</tr>
<tr>
<td>MSTRWebServer0Project0AuthenticationMode</td>
<td>1</td>
</tr>
</tbody>
</table>
Configuring the application from Mobile Server Administrator

If you do not have access to the BlackBerry Enterprise Server, you can configure the Mobile application through MicroStrategy Mobile Server. This creates a configuration, that is, an XML file containing mobile device

<table>
<thead>
<tr>
<th>Policy Item Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSTRWebServer0Project0Login</td>
<td>hzhou</td>
</tr>
<tr>
<td>MSTRWebServer0Project0Password</td>
<td>zhoupassword123</td>
</tr>
<tr>
<td>MSTRWebServer0Project1Name</td>
<td>Sales Analysis</td>
</tr>
<tr>
<td>MSTRWebServer0Project1ServerName</td>
<td>archimedes</td>
</tr>
<tr>
<td>MSTRWebServer0Project1ServerPort</td>
<td>80</td>
</tr>
<tr>
<td>MSTRWebServer0Project1AuthenticationMode</td>
<td>2</td>
</tr>
<tr>
<td>MSTRWebServer0Project1Login</td>
<td>NETWORK\hzhou</td>
</tr>
<tr>
<td>MSTRWebServer0Project1Password</td>
<td>networkpassword123</td>
</tr>
<tr>
<td>MSTRWebServer1Name</td>
<td>mobiletestserver</td>
</tr>
<tr>
<td>MSTRWebServer1Port</td>
<td>80</td>
</tr>
<tr>
<td>MSTRWebServer1Path</td>
<td>MicroStrategyMobile</td>
</tr>
<tr>
<td>MSTRWebServer1Type</td>
<td>1</td>
</tr>
<tr>
<td>MSTRWebServer1Protocol</td>
<td>http</td>
</tr>
<tr>
<td>MSTRWebServer1AuthenticationMode</td>
<td>1</td>
</tr>
<tr>
<td>(Note: Since this Web Server uses anonymous authentication, the login and password are not required.)</td>
<td></td>
</tr>
<tr>
<td>MSTRWebServer1ProjectCount</td>
<td>1</td>
</tr>
<tr>
<td>MSTRWebServer1Project0Name</td>
<td>DevelopmentProject</td>
</tr>
<tr>
<td>MSTRWebServer1Project0ServerName</td>
<td>sophocles</td>
</tr>
<tr>
<td>MSTRWebServer1Project0ServerPort</td>
<td>80</td>
</tr>
<tr>
<td>MSTRWebServer1Project0AuthenticationMode</td>
<td>1</td>
</tr>
<tr>
<td>MSTRWebServer1Project0Login</td>
<td>dev_jdoe</td>
</tr>
<tr>
<td>MSTRWebServer1Project0Password</td>
<td>dev123</td>
</tr>
</tbody>
</table>
configuration instructions, in Mobile Server. You can create a URL for a configuration and then post that URL to an HTML page, or email it to users. Mobile users can click the URL to configure their devices. When users open the URL on their mobile devices, the application is automatically configured using the settings in the configuration.

You can create and save multiple configurations. Each configuration can have its own login credentials and list of projects. For example, you can create one configuration for regional sales managers, providing access to only those projects that report on sales data. You can then create another configuration for executives, which gives them access to all projects currently in production.

User logins and passwords included with a configuration should be used only for demonstration purposes, as the configuration is not transmitted or stored securely.

To create a BlackBerry configuration

1. Access the Mobile Server Administrator page:
   - In Windows: From the Start menu, point to Programs, then MicroStrategy, then Mobile, then Mobile Server, then select Mobile Administrator. The Mobile Server Administrator web page opens.
   - In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log on to the mstrMobileAdmin servlet using proper authentication, the Mobile Server Administrator web page opens. The default location of the Administrator servlet varies depending on the platform that you are using.

2. From the pane on the left, select Mobile Configuration.

3. Click Define New Configuration. The Create Configuration page opens.

4. From the Device drop-down list, select BlackBerry.

5. In the Configuration Name field, type the name of the configuration. This name is displayed in the list of all saved configurations.

Configure the BlackBerry settings

6. Select the BlackBerry Settings tab.
By default, users can modify configuration settings from their mobile devices. To restrict user access to configuration settings on mobile devices, clear the **Allow users to modify settings from the device** check box.

To allow users to configure real-time updates, select the **Allow users to configure Real-Time Updates** check box.

From the **Device Minimum Free Memory** drop-down list, select the percentage of device memory that is not accessible by the Mobile application for report storage. Possible values are 1, 5, 10, 15, 25, or 30. The default minimum is 5%.

To view advanced settings, click **Show Advanced Settings**.

**Configure network parameters**

Select your web server’s TCP connection mode from the **TCP Connection Mode** drop-down list. Possible values are Default, MDS Proxy, or Direct. The default TCP connection mode is MDS Proxy. For an explanation of the different connection modes, see your web server’s documentation.

If at least one Mobile Server uses HTTPS, select your web server’s TLS connection mode from the **TLS Connection Mode** drop-down list. Possible values are Default, End-to-End TLS Desired, or End-to-End TLS Required. The default TLS connection mode is Default. For an explanation of the TLS connection modes, see your web server’s documentation.

In the **Request Timeout** field, specify the number of seconds that clients must wait before giving up on establishing a connection with the Mobile Server. The default timeout is 120 seconds.

In the **Push Listen Port** field, specify a port between 0 and 65535 for the Mobile application to use to listen for push notifications. The default port is 31851.

Ensure that the port that you enter is free and not in use by another application.
Configure web server authentication settings

15 To specify when the device submits web server credentials, select either *Submit Web Server Credentials Only When Challenged* or *Submit Web Server Credentials On Every Request*.

This setting is only relevant if at least one Mobile Server uses Basic authentication and the BlackBerry MDS is configured to support HTTP authentication.

Configure client memory management settings

16 In the **Maximum Report Size** field, specify a limit, in kilobytes, for a compressed report XML file that can be downloaded on the client device. To allow reports of any size to be downloaded, select the **No Limit** check box. The default maximum is 125 KB.

17 By default, when the Mobile application receives a low memory notification, reports that are currently loading are aborted. To allow reports to load when a low memory notification is received, clear the **Stop on Low Memory Notification** check box.

18 In the **Rows Per Page** field, specify the maximum number of rows that are displayed on each page for a report. The default value is 50 rows. To remove the limit for the number of rows on a page, select the **No Limit** check box.

   The Rows Per Page value must be less than or equal to the Maximum Rows in Memory value.

19 In the **Maximum Rows in Memory** field, specify the number of rows that can be loaded into memory for a report. The default value is 500 rows.

   The Maximum Rows in Memory value must be greater than or equal to the Rows Per page value.

20 In the **Status History** field, specify the maximum number of completed tasks that are shown in the status list. The default limit is 10 tasks. To remove the limit for completed tasks in the status list, select the **No Limit** check box.

21 When a mobile device is busy executing, up to 500 pending tasks can be queued in its memory by default. To specify a new limit for pending tasks, type the desired maximum in the **Task Queue Size** field. To remove the limit for pending tasks, select the **No Limit** check box.
Configuring data retrieval settings

22 In the **Segment Size** field, specify the maximum size, in kilobytes, of a single unit of data that can be transferred from the Mobile Server to a mobile client. The default value is 4 KB.

* The Segment Size value must be less than or equal to the Maximum Request Size value.

23 By default, when a mobile client sends a request to the Mobile Server, the size of the response body is limited to 250 kilobytes. To alter this value, type the desired limit, in kilobytes, in the **Maximum Request Size** field.

* The Maximum Request Size value must be greater than or equal to the Segment Size value.

24 By default, the target time for a single HTTP request is 15 seconds. This value, along with the running average data rate, is used to calculate the amount of data that can be downloaded in a given request. To alter this value, type the desired target time, in seconds, in the **Request Target Time** field.

25 The Data Rate Smoothing Coefficient indicates the weight that is assigned to the average data rate when calculating the amount of data that can be downloaded in a given request. The default smoothing coefficient is 0.65. To alter this value, type the desired smoothing coefficient, between 0 and 1, in the **Data Rate Smoothing Coefficient** field.

26 By default, a mobile client must wait 5 seconds between sending requests to poll the Intelligence Server for results. To change this value, type the desired number of seconds in the **Server Polling Frequency** field.

27 By default, a mobile client can execute a report or document up to 3 times if execution fails. This limit is used to cap the number of executions in case successive execution requests time out. To alter this setting, type the desired limit in the **Result Set Execution Limit** field.

28 When a mobile client makes a connection with a Mobile Server, it checks the Mobile Server version to ensure that it is compatible. To skip this check, select the **Disable Server Version Check** check box.

Configuring conservative mode settings

Conservative mode settings affect the Mobile application’s behavior when it is operating in the background.
29 In the **Request Target Time** field, specify the target time, in seconds, for a single HTTP request in conservative mode. The default value is 5 seconds.

30 In the **Wait Between Requests** field, specify the number of seconds that the client waits between HTTP requests in conservative mode. The default value is 5 seconds.

31 In the **Device Idle Time Limit** field, specify the maximum number of seconds that the device can be idle before it switches out of conservative mode. The default value is 30 seconds.

**Configuring connectivity settings**

32 Click the **Connectivity Settings** tab, and specify the connectivity settings for your BlackBerry devices. For detailed instructions on configuring these settings, see *Configuring connectivity settings for iPhone, iPad, Android, and BlackBerry devices, page 140.*

33 Click **Save** to save your Mobile configuration.

**Generate a URL for your Mobile configuration**

34 Generate a URL for your Mobile configuration, and email it to your BlackBerry users. For detailed instructions on generating a URL for your Mobile configuration, see *Generating a URL for a configuration, page 156.*

**Configuring the application from the BlackBerry device**

If you do not have access to the BlackBerry Enterprise Server, you can configure the Mobile application through the Preferences screen. You need to add the connection information for the MicroStrategy Mobile Server, and then configure the projects that you want to receive reports from, as described in the procedures below.

---

**To manually configure MicroStrategy Mobile with MicroStrategy Mobile Server information**

1 In MicroStrategy Mobile, click the trackball/trackwheel and select **Preferences**. The Preferences screen opens.

2 Scroll to the area labeled **Mobile Servers Configured**.
3 Click the trackball/trackwheel and select Add Mobile Server. The Mobile Server Setup screen opens.

4 Enter the information for each option:

- **Name**: the MicroStrategy Mobile Server, by DNS name or IP address.
- **Port**: the port that the MicroStrategy Mobile Server uses.
- **Path**: the path that the MicroStrategy Mobile Server is installed to.
- **Type**: select either ASP.NET for MicroStrategy Mobile or J2EE for MicroStrategy Mobile Universal.
- **Request Type**: select HTTP for no encryption or HTTPS for SSL encryption. For an explanation of SSL encryption, see SSL encryption, page 117.

5 To use the default authentication settings, select the Use Default check box. Otherwise, specify the Mobile Server authentication settings:

   a Under Authentication, clear the Use Default check box.

   b Scroll to the area entitled Authentication Mode.

   c Click the trackball/trackwheel and select the authentication mode to use to log in to the Mobile Server machine.

   d For basic or Windows authentication, in the Login field, type the user name.

   e For basic or Windows authentication, in the Password field, type the password for the login.

   The default authentication mode is set from the Preferences screen, in the Default Mobile Server Authentication section.

6 Scroll to the area labeled Default Project Authentication. The options in this area determine the default authentication mode for all projects configured for this server.

7 Enter the information for each option:

- **Mode**: select either Standard, Windows, LDAP, or Database
- **Login**: the user name that you use to access the Intelligence Server
- **Password**: the password for the Login above
Click the trackball/trackwheel and select Close. The Mobile Server Setup screen closes.

Click the trackball/trackwheel and select Save. The new Mobile Server information is saved.

Once you have configured a Mobile Server, you need to add information about the projects that contain the reports and documents you are subscribed to.

---

**To add a project to MicroStrategy Mobile**

1. In MicroStrategy Mobile, click the trackball/trackwheel and select Preferences. The Preferences screen opens.

2. Scroll to the area entitled **Mobile Servers Configured**.

3. Highlight the MicroStrategy Mobile Server that you want to add a project for.

4. Click the trackball/trackwheel and select **Edit Mobile Server**. The Mobile Server Setup screen opens.

5. Scroll to the area entitled **Projects Configured**.

6. Click the trackball/trackwheel and select **Add Project**. The Project Setup screen opens.

7. Enter the information for each option:
   - **Project Name**: the name of the MicroStrategy project. This field is case-sensitive.
   - **Server Name**: the Intelligence Server that contains the project, by DNS name or IP address.
   - **Server Port**: the Intelligence Server port number.

8. To use the default authentication mode and credentials for the project, under Authentication, select the Use Default check box. To use a different authentication method, use the following procedure:
   a. Under Authentication, clear the Use Default check box.
   b. Scroll to the area entitled **Mode**.
c Click the trackball/trackwheel and select the type of authentication for the project.

d In the Login field, enter the login name for the project.

e In the Password field, enter the password associated with your login for the project.

9 Click the trackball/trackwheel and select Close. The Project Setup screen closes and the project is now listed under Projects Configured.

10 Click the trackball/trackwheel and select Close. The Mobile Server Setup screen closes.

11 Click the trackball/trackwheel and select Save. The project configuration information is saved.

The Mobile subscription workflow

There are three steps in the MicroStrategy Mobile subscription workflow. These steps, detailed below, explain how Mobile retrieves a report from Intelligence Server:

- First, a subscription to the report is created. Any prompts are answered, and the scheduled event or time is set. Subscriptions can be created by an administrator or Mobile user in MicroStrategy Desktop or Command Manager, or, in MicroStrategy Mobile for BlackBerry, by the user on their mobile device.

For more information about how an administrator schedules a report to be delivered, see Scheduling the report or document, page 178.

For more information about how a user subscribes to a report or document from their device, see the MicroStrategy Mobile Analysis Guide.

- Second, the report is executed when the scheduled event or time is triggered. Upon execution of the report, the new report cache is sent to the MicroStrategy history list. For more information, see Executing the report on Intelligence Server, page 178.

- Finally, the user retrieves the report from Mobile Server, and it is available on the user's mobile device. For more information, see Retrieving the report in MicroStrategy Mobile, page 178.
Scheduling the report or document

The Mobile user or an administrator selects the reports or Report Services documents to be viewed in MicroStrategy Mobile. They then schedule these reports for delivery to Mobile, and answers any prompts in the reports. For instructions on scheduling report subscriptions for Mobile, see Managing Mobile report subscriptions, page 179.

In addition, the Mobile user schedules an update time window for the mobile device to automatically retrieve the reports. For instructions, see the section on choosing when to update the Report List in the MicroStrategy Mobile Analysis Guide.

Executing the report on Intelligence Server

When the schedule associated with a report is triggered, that report is executed by Intelligence Server. The report is then sent to the History List, to reduce the load on Intelligence Server. For a detailed explanation of the History List, see the Caching chapter in the MicroStrategy System Administration Guide.

Reports available in Mobile are only updated when the associated schedule is triggered, or (in MicroStrategy Mobile for BlackBerry) when the Reset option is selected in the Mobile application. (For instructions on how to reset a report, see the MicroStrategy Mobile Analysis Guide.) In particular, editing the report through MicroStrategy Web or Desktop does not update the report’s History List message. If you are concerned that Mobile users may not have the most recent version of a report, you should either update the History List message, or inform the users that they need to reset that report.

If the user has made changes to the report on the Mobile device and saved those changes, any changes made to the report in MicroStrategy Web or Desktop are not applied to the report on the Mobile device until the user resets the report.

Retrieving the report in MicroStrategy Mobile

Once a report has been sent to the History List, it is available on Mobile Server. Mobile then retrieves the report from the server, either during its scheduled update time or during a manual update. To schedule when reports
are retrieved from Mobile Server, and to retrieve reports immediately, see the *MicroStrategy Mobile Analysis Guide*.

Mobile retrieves reports from Mobile Server by report ID (a unique 32-character identifier) and report type. Graph reports are stored on the mobile device as JPG image files. Other types of reports are compressed to roughly one-tenth their original size, using LZW compression. This keeps the memory footprint of each individual report as small as possible, and also reduces the amount of bandwidth that the reports use during reconciliation.

In MicroStrategy Mobile for iPhone, iPad, or Android, the administrator can control how much memory is available for use by reports in the **Memory Limit** setting in the device configuration. For instructions on changing this setting, see *Configuring MicroStrategy Mobile for iPhone or iPad, page 127* or *Configuring MicroStrategy Mobile for Android, page 135*.

In MicroStrategy Mobile for BlackBerry, if the available memory on the device begins to run low, Mobile can store reports in extended device memory, such as on SD memory cards. For instructions on how to enable extended device memory, see the *MicroStrategy Mobile Analysis Guide*.

**Data security in Mobile**

The data in the reports and documents that you view on your mobile device is secured by MicroStrategy. This means that the data you can view and work with is controlled by the same security mechanisms that control access to the data in other MicroStrategy products. Security settings can limit your data access to specific projects, certain reports within a project, the ability to use specific objects on reports, and how you can explore some data. If you have any questions about any data you expect to be able to access but cannot, see your MicroStrategy administrator.

MicroStrategy also secures the data in your reports and documents by ensuring that other applications on your mobile device cannot access it.

**Managing Mobile report subscriptions**

To receive reports and Report Services documents on a mobile device, the device’s user must be subscribed to those reports. Each Mobile subscription is associated with a MicroStrategy schedule that controls how often the report or document is updated. For detailed information about schedules
and subscriptions, including instructions on how to create schedules, see the *Scheduling Jobs and Administrative Tasks* chapter in the *MicroStrategy System Administration Guide*.

### Before you subscribe

Keep the following items in mind when you configure MicroStrategy Mobile subscriptions, either for yourself or for other users:

- To view reports in the MicroStrategy Mobile application, users must have the Use MicroStrategy Mobile privilege for all projects containing reports they want to view.

- To view Report Services documents in MicroStrategy Mobile, users must have the Mobile View Documents privilege for all projects containing documents they want to view.

- When subscribing a user to a report, be certain that the user has the proper permissions to view the report and the objects it contains.

  For additional information about report and report object permissions in the MicroStrategy security model, see the *Setting Up User Security* chapter in the *MicroStrategy System Administration Guide*.

- MicroStrategy has a number of recommended best practices for designing reports to be viewed in MicroStrategy Mobile. Reports designed according to these best practices load quickly and are easy to read on mobile devices. For a list of these best practices, see *Chapter 2, Designing Reports and Documents for a BlackBerry*.

### Managing subscriptions

Both administrators and MicroStrategy Mobile users can manage subscriptions in Mobile. There are several different ways to manage MicroStrategy Mobile report and document subscriptions:

- **Subscribing multiple users**

  You can subscribe multiple users to reports or documents in MicroStrategy Desktop. The Subscription Manager allows you to manage all the subscriptions for a project from one interface. For specific information about how to manage Mobile subscriptions using Desktop, see *Managing multiple subscriptions at once with Desktop, page 182*. 

• **Using MicroStrategy Command Manager**

You can use MicroStrategy Command Manager to manage any number of subscriptions. Command Manager is a script-based tool for administering MicroStrategy systems. For specific information about how to manage Mobile subscriptions using Command Manager, see *Managing subscriptions using Command Manager, page 186*. For general information about Command Manager, including detailed instructions, see the *Automating Administrative Tasks with Command Manager* chapter in the *MicroStrategy System Administration Guide*, or see the Help for Command Manager.

• **Individual users managing personal subscriptions**

  ▪ **In MicroStrategy Web**

  Individual users can manage their subscriptions in MicroStrategy Web. For specific information about managing individual MicroStrategy Mobile subscriptions, including how to subscribe to reports, see *Managing your subscriptions through MicroStrategy Web, page 187*. For general information about managing subscriptions using MicroStrategy Web, see the MicroStrategy Web online help.

  ▪ **In Desktop**

  Individual users can also manage their subscriptions through MicroStrategy Desktop. Specifically, the Subscription Wizard in Desktop offers users a way to subscribe to multiple reports simultaneously, without having to open each individual report. Users can also subscribe to individual reports by using the report’s Properties page. For specific information about managing individual MicroStrategy Mobile subscriptions in Desktop, including how to subscribe to reports, see *Managing subscriptions in MicroStrategy Desktop, page 189*. For general information about managing subscriptions using MicroStrategy Desktop, see the MicroStrategy Desktop online help (press F1 from within Desktop).

  ▪ **In MicroStrategy Mobile**

  Individual users can manage their subscriptions on their mobile devices. They can subscribe to any report or document that they have access to, answer prompts, and define the schedule or event that will determine when the report or document is sent to the device. Users can also edit their existing subscriptions on their device. For specific information about editing and subscribing to reports and documents on a mobile device, see the *MicroStrategy Mobile Analysis Guide*. 
Managing multiple subscriptions at once with Desktop

The Subscription Manager allows you to manage all the subscriptions for a project from one interface. It is a convenient, central location that displays every subscription, and allows you to filter on various criteria.

To access the Subscription Manager, log in to Desktop and expand Administration, then Configuration Managers, and then select Subscriptions. For detailed information about the Subscription Manager, see the MicroStrategy Desktop online help.

In Desktop, the administrator can subscribe multiple MicroStrategy Mobile users to a single report at once, or subscribe a single user to multiple reports by using the Subscription Creation Wizard.

For more information about using the Subscription Creation Wizard, refer to the MicroStrategy Desktop Help.

To subscribe one or more users to one or more reports

1. From the Administration menu, point to Scheduling and then select Subscription Creation Wizard. The Subscription Wizard opens.

2. Review the information on the Introduction dialog box and click Next. The Specify Characteristics dialog box opens, as shown below:

![Subscription Wizard - Specify Characteristics dialog box](image-url)
3 From the **Choose a project from which reports/documents will be delivered to the recipients** drop-down list, select the project that contains the reports that you want to create a subscription to.

4 From the **Choose a delivery type** drop-down list, select **Mobile** to send the report directly to the Mobile device, select **Cache Update** to update server side caches for reports and documents that use the pre-caching feature, or select **History List** to deliver the report to a Mobile device using the History List.

   Use cache update subscriptions to update server side caches for your iPhone or iPad precached reports and documents. For instructions on configuring the pre-cache option for reports and documents, see *Configuring the home screen for iPhone and Android Phone, page 148* or *Configuring the home screen for iPad or Android Tablet, page 153*.

5 Click **Next**. The Choose Reports/Documents dialog box opens, as shown below:

6 Browse to the reports/documents to be delivered and click the right arrow to add them to the Selected objects. Click **Next**.

7 Answer any prompts for the selected reports/documents.

   You cannot schedule reports with prompts unless the report has default answers.
8  Click **Next**. The Choose Recipients dialog box opens, as shown below:

![Subscription Wizard - Choose Recipients](image)

9  From the **Schedule** drop-down list, select the schedule to execute the reports/documents.

10 Click **To...** to open the Select Recipients dialog box, as shown below:

![Select Recipients](image)
11 Browse to the recipients of the subscription and click the right arrow > to add them to the **Selected recipients**. Click **OK** to return to the Subscription Wizard - Choose Recipients dialog box.

12 If you are creating a history list subscription for a document, choose the form of export to generate from the **Pre-generate export** drop-down list. The options for this setting are an HTML page, a PDF document, or an Excel spreadsheet.

13 If you are creating a Mobile delivery, choose BlackBerry, iPhone, or iPad from the **Mobile device type** drop-down list.

14 If you are creating a cache update subscription for pre-cached reports and documents, select either **Phone** or **Tablet** from the **Delivery Format** drop-down list.

15 To send the report to the selected recipients immediately after creating the subscription, select the **Run subscription immediately** check box.

16 Click **Next**. The Specify Subscription Properties dialog box opens, as shown below:

![Subscription Wizard - Specify Subscription Properties](image)

17 **Specify your subscription properties as follows:**

- Depending on the reports or documents selected, one or more options may be grayed out and unavailable. For details on these options and when they are available, see the **System Administration Guide**.
• To configure a date when the subscription will stop sending reports, select the **Expired subscription on** check box and select a date.

• If you are creating a History List delivery, you can have an automated delivery notification email sent when the report is delivered. To do this, select the **Send notification to default email address of each recipient** check box.

• If you are creating a History List delivery, to ensure that previous versions of the report in the recipients’ delivery location are replaced with the most recent version, select the **The new scheduled report will overwrite older versions of itself** check box. If this check box is not selected, the older versions remain.

• To ignore any existing report or document caches and ensure that the report or document always has the latest data, select the **Re-run against the warehouse** check box.

• To update History List caches and not Matching caches, select the **Do not create or update matching caches** check box. For an explanation of Matching and History caches, see the **Caching** chapter of the *MicroStrategy System Administration Guide*.

18 Click **Next**. The Summary dialog box opens.

19 Review the settings and click **Finish**. The subscription is created and available for viewing in the Subscription Manager.

### Managing subscriptions using Command Manager

MicroStrategy Command Manager is a script-based tool for automating Intelligence Server administration. You can compose Command Manager scripts to manage user subscriptions. In some situations this may be more efficient than navigating the Desktop GUI, since you can quickly change the names of reports, users, or projects with Command Manager scripts.

To configure subscriptions with Command Manager, you must have the **Use Command Manager** privilege.

To start Command Manager, from the **Start** menu point to **Programs**, then **MicroStrategy**, then **Command Manager**, and then select **Command Manager**.
The Command Manager statement syntax for creating a mobile subscription is:

```
CREATE MOBILESUBSCRIPTION subscription_name [FOR OWNER login_name] SCHEDULE schedule_name USER user_name CONTENT report_or_document_name IN FOLDER location_name IN PROJECT project_name [OVERWRITEOLDERVERSION (TRUE|FALSE)] [EXPIRATIONDATE mm/dd/yyyy] [RUNFRESH (TRUE|FALSE)] [CREATEUPDATECACHE (TRUE|FALSE)] [MODIFICATIONBYRECIPIENTS (TRUE|FALSE)];
```

For more information about Command Manager, including detailed instructions, see the *Automating Administrative Tasks with Command Manager* chapter in the *MicroStrategy System Administration Guide*, or see the Help for Command Manager.

**Managing your subscriptions through MicroStrategy Web**

There are a variety of ways to manage your MicroStrategy Mobile subscriptions using MicroStrategy Web.

MicroStrategy Web’s subscription interface enables you to subscribe to a new report or document, or to unsubscribe from a report or document that you no longer need to view. You can also change the update schedule for a subscription. Finally, you can change the prompt answers for a report or document that is delivered to your mobile device. See the following sections for procedures:

- *To subscribe to a report or document in MicroStrategy Web, page 188*
- *To unsubscribe from a report, page 188*
- *To change the update schedule for a subscription in MicroStrategy Web, page 189*
- *To change the personalized prompt answers for a report or document, page 189*

To manage your Mobile subscriptions through MicroStrategy Web, you must have the Web Scheduled Reports privilege as well as the Use MicroStrategy Mobile privilege. In addition, to subscribe to a document you must have the Mobile View Document privilege.
To subscribe to a report or document in MicroStrategy Web

1. Open the report or document in MicroStrategy Web.

2. Answer any prompts that the report or document contains and click **Run Report**.

   Your answers to the prompts are saved and used to personalize your subscription to that report or document. To change these answers later, open the report or document again and, from the Data menu, select **Re-prompt**.

3. From the Home menu, point to **Subscribe to**, and then select **Mobile**. The Subscribe to Mobile dialog box opens.

4. Type a name for the subscription in the **Name** text field.

5. Select a schedule or event from the **Schedule** drop-down list.

6. Click **To** to choose the subscription recipients.

7. Choose the subscription device from the **Device type** drop-down list.

8. To run the subscription immediately following its creation, select the **Run subscription immediately** check box.

9. To choose an end date for the subscription, expand **Advanced Options**, select the **Do not deliver after** check box, and click the **Calendar** drop-down menu to choose a date.

10. Click **OK**. The Subscribe to Mobile dialog box closes.

11. To verify that you are subscribed to the report or document, at the top of the page, click **My Subscriptions**. Note that the report appears in your list of subscriptions, in the Mobile Subscriptions section.

To unsubscribe from a report

1. Open MicroStrategy Web and log into a project.

2. At the top of the page, click **My Subscriptions**. The Subscriptions screen opens, with a list of all your subscriptions for that project.
In the **Unsubscribe** column, select the check box for any reports that you no longer want to receive on your mobile device.

Click **Unsubscribe**. Any selected reports are removed from your subscription list.

---

**To change the update schedule for a subscription in MicroStrategy Web**

1. Open MicroStrategy Web and log into a project.
2. At the top of the page, click **My Subscriptions**. The Subscriptions page opens, with a list of all your subscriptions for that project.
3. In the Action column, click **Edit** for the subscription you want to edit. The Edit Subscription page for that subscription opens.
4. From the drop-down list, select the new schedule.
5. Click **OK**. The Edit Subscription dialog box closes.

---

**To change the personalized prompt answers for a report or document**

1. Open the report or document in MicroStrategy Web.
2. From the **Data** menu, select **Re-prompt**.
3. Answer the prompts in the report or document.
4. When you are satisfied with your prompt answers, click **Run Report**. The report executes with your prompt answers, and your answers are saved and used to personalize your subscription to the report.

---

**Managing subscriptions in MicroStrategy Desktop**

You can manage your subscriptions to individual reports. Steps for these procedures are below.

To manage subscriptions in bulk, and for steps to use the command line tool Command Manager, see the *System Administration Guide*. 

© 2012 MicroStrategy, Inc.
To manage your Mobile subscriptions through MicroStrategy Desktop, you must have the Use Desktop privilege as well as the Use MicroStrategy Mobile privilege. In addition, to subscribe to a document you must have the Mobile View Document privilege.

To unsubscribe from a report or document delivery, you must either have created the subscription originally (you are the owner of the subscription), or else the creator must have selected Allow Unsubscribe when she created the subscription. If neither of these is true, then only an administrator or the subscription’s owner can unsubscribe users from the report/document delivery.

To subscribe to a single report or document

1. In Desktop, right-click the report/document, select Schedule delivery to, and select Mobile.
2. Type the name of the subscription in the Name text field.
3. Select the schedule that you want the report/document to be delivered based on, by selecting it from the drop-down list.
4. Click To to choose the subscription recipients.
5. Select the desired mobile device from the Mobile device type drop-down list.
6. To run the subscription immediately following its creation, select the Run subscription immediately check box.
7. Click OK. The dialog box closes.

To unsubscribe from a single report or document

1. In Desktop, from the Tools menu, select My Subscriptions.
2. Right-click the subscription and select Unsubscribe.
   
   If the Unsubscribe option is not available, the subscription can only be deleted by the subscription’s owner or by an administrator.
3. Confirm that you want to delete the subscription by clicking Yes. The subscription is deleted.
Enabling real time updates for BlackBerry

In MicroStrategy Mobile for BlackBerry, it is possible to allow the device to automatically update reports and documents when they change on the server. This ensures that users always have the most current data. To enable this option, certain configurations must be made in the project, to the user, and by the user on their device.

To enable real time updates in MicroStrategy Mobile for BlackBerry, follow these high-level steps.

**High-level steps to enable automatic updates in MicroStrategy Mobile**

1. Enable project-level settings in MicroStrategy Desktop. For details, see *Enabling real time updates in the project, page 191*.

2. In the User Manager, create a Mobile BES device address. For details, see *Enabling real time updates for the user, page 192*.

### Enabling real time updates in the project

To enable real time updates in MicroStrategy Mobile, the project that MicroStrategy Mobile connects to must have real-time updates enabled. To enable real time updates in the project, you must do the following:

- Enable real time updates in the Project Configuration Editor. For steps, see *To enable real time updates using the Project Configuration Editor, page 191*.

- Configure the Mobile BES device using the Delivery Manager. For steps, see *To configure the Mobile BES device using the Delivery Manager, page 192*.

### To enable real time updates using the Project Configuration Editor

1. Log in to MicroStrategy Desktop as a user with administrative privileges.

2. Right-click the project that you want to enable real-time updates for, and select **Project Configuration**. The Project Configuration Editor opens.
3 On the left, expand Deliveries, then Mobile Delivery, and select Real time updates.

4 On the right, select the Enable Real Time updates for mobile delivery check box.

5 Click OK. The Project Configuration Editor closes.

---

To configure the Mobile BES device using the Delivery Manager

1 Log in to MicroStrategy Desktop as a user with administrative privileges.

2 Under the project source, expand Administration, then Delivery Managers, and select Devices.

3 Right-click the Mobile BES device and select Edit. The Device Editor opens.

4 To rename the device, type a name in the Name field.

5 To change the description of the device, type text in the Description field.

6 In the BlackBerry Enterprise Server section, in the IP Address area, enter the IP address for the machine hosting the BlackBerry Enterprise Server.

7 In the Port Number area, enter the port number to use to access the BlackBerry Enterprise Server.

8 In the Client Port area, enter the port number of the client machine.

9 Click OK. The Device Editor closes.

---

Enabling real time updates for the user

After real time updates have been enabled in the project, a Mobile Client Address must be registered for the user to receive real time updates. There are two ways that this can be done:

- The user registers a Mobile Client Address from their Mobile device. For details, see the MicroStrategy Mobile Analysis Guide.
The administrator registers a Mobile Client Address using the User Manager. For steps, see *To enable real time updates for a user, page 193.*

If you delete this address, a warning message is displayed, stating that if you delete the address, real time updates for the user will be disabled. To restart real time updates for the user, the address can be registered for the user again.

### To enable real time updates for a user

1. Log in to MicroStrategy Desktop as a user with administrative privileges.
2. Under the project source, expand *Administration,* then *User Manager.*
3. Browse to the user that you want to enable real time updates for, right-click the user and select *Edit.* The User Editor opens.
4. On the left, expand *Deliveries,* then select *Addresses.*
5. On the right side of the User Editor, click *New.* A new address is created.
6. To rename the address, type a name in the *Name* field.
7. In the *Physical Address* field, enter the unique PIN for the user’s mobile device. For steps to determine this number, see *To determine a device’s PIN, page 193.*
8. From the *Delivery Type* drop-down list, select *MobileClient.*
9. From the *Device* drop-down list, select *MobileBES.*
10. To set this address as the user’s default address, select the *Set as default* check box.
11. Click *Save.* The address is saved.
12. Click *OK.* The User Editor closes.

### To determine a device’s PIN

The third-party products discussed below are manufactured by vendors independent of MicroStrategy, and the information provided
is subject to change. Refer to the appropriate third-party vendor
documentation for updated BlackBerry device information.

1  On the BlackBerry Device, select **Options**. The Options screen is
displayed.

2  Select **Status**. The Status screen is displayed.

3  Scroll to **PIN**. The device’s unique PIN is displayed.

**Troubleshooting MicroStrategy Mobile**

This section provides guidance for finding and fixing trouble spots in the
system. While the material in this section does not go into great detail, it
does provide references to the relevant portions of the documentation where
the topic or remedy is discussed in more detail.

**Troubleshooting connection issues**

When you create a configuration for a mobile device (see *Configuring
MicroStrategy Mobile for iPhone or iPad, page 127*), you must specify the
Mobile Server machine by its fully qualified name so that the Mobile device
can locate the machine on the network.

**Troubleshooting reports and documents**

- MicroStrategy recommends that caching be enabled for all reports and
documents intended to be viewed on a mobile device. For information on
report and document caching, including instructions on how to enable
caching for specific reports and documents, see the *Caching* chapter of
the *MicroStrategy System Administration Guide*.

- If subscribed reports and documents are loading slowly on an iPhone or
iPad, enable the **Automatically Pre-Load Caches** setting. This setting
causes cached reports/documents to be loaded onto the device when the
application is launched. This setting is found in the **iPhone Settings** or
**iPad Settings** tab of the Mobile Configuration Editor, or in the device’s
**Settings** screen if the device is configured for users to have access to the settings. For information about configuring your device, see *Configuring MicroStrategy Mobile for iPhone or iPad, page 127*.

### Troubleshooting prompt answers

To support the scanning of barcodes using MicroStrategy Mobile for iPhone, you must store the barcode data used in the associated prompt with a database data type that supports text data. MicroStrategy recommends using the VarChar data type for your database to store the barcode data. For information about setting up your database, see the *MicroStrategy Project Design Guide* and the *MicroStrategy Installation and Configuration Guide*. 
GLOSSARY

access control list A list of users, groups and the access permissions that each has for an object.

attribute A data level defined by the system architect and associated with one or more columns in a data warehouse lookup table. Attributes include data classifications like Region, Order, Customer, Age, Item, City, and Year. They provide a means for aggregating and filtering at a given level.

See also:
- attribute element
- attribute form
- child attribute
- derived attribute
- parent attribute

attribute element A value of any of the attribute forms of an attribute. For example, New York and Dallas are elements of the attribute City; January, February, and March are elements of the attribute Month.

attribute form One of several columns associated with an attribute that are different aspects of the same thing. ID, Name, Last Name, Long Description, and Abbreviation could be forms of the
attribute Customer. Every attribute supports its own collection of forms.

**banding** A method of organizing values according to a set of descriptive or meaningful data ranges called buckets. For example, customers in the age ranges of 10–20, 21–30, and 31–40, where each set of ages is a band. Banding is also used for display purposes, where every other row is a different color and the two colors alternate.

Compare **consolidation**.

**cache** A special data store holding recently accessed information for quick future access. This is normally done for frequently requested reports, whose execution is faster because they need not run against the database. Results from the data warehouse are stored separately and can be used by new job requests that require the same data. In the MicroStrategy environment, when a user runs a report for the first time, the job is submitted to the database for processing. However, if the results of that report are cached, the results can be returned immediately without having to wait for the database to process the job the next time that the report is run.

**category** In a graph, the set of data along the X-axis. Categories generally correspond to the rows of a grid report. An example of a category is a bar in a bar graph.

**child attribute** The lower-level attribute in an attribute relationship.

See also:

- **parent attribute**
- **relationship**

**consolidation** An object that can be placed on a report and is made up of an ordered collection of elements called consolidation elements. Each element is a grouping of attribute elements that accommodates inter-row arithmetic operations.

Compare **custom group**.
**custom group** An object that can be placed on a template and is made up of an ordered collection of elements called custom group elements. Each element contains its own set of filtering qualifications.

See also: *qualification*.

**dashboard** A visually intuitive display of data that summarizes key business indicators for a quick status check. A special type of document, dashboards usually provide interactive features that let users change how they view the dashboard’s data.

**derived attribute** An attribute calculated from a mathematical operation on columns in a warehouse table. For example, Age can be calculated from the expression \([\text{Current Date} - \text{Birth Date}]\).

See also:

- *attribute*
- *implicit attribute*

**derived metric** A metric based on data already available on the report. It is calculated on the Intelligence Server, not in the database. Use a derived metric to perform column math, that is, calculations on other metrics, on report data after it has been returned from the database.

**dimensionality** See *level*.

**drill** A method of obtaining supplementary information after a report has been executed. The new data is retrieved by requering the Intelligent Cube or database at a different attribute or fact level.

See also:

- *page-by*
- *pivot*
- *sort*
• **subtotal**

**fact** 1) A measurement value, often numeric and typically aggregatable, stored in a data warehouse.

2) A schema object representing a column in a data warehouse table and containing basic or aggregated numbers—usually prices, sales in dollars, or inventory quantities in counts.

See also: **metric**.

**filter** A MicroStrategy object that specifies the conditions that the data must meet to be included in the report results. Using a filter on a report narrows the data to consider only the information that is relevant to answer your business question, since a report queries the database against all the data stored in the data warehouse.

A filter is composed of at least one qualification, which is the actual condition that must be met for the data to be included on a report. Multiple qualifications in a single filter are combined using logical operators. Examples include “Region = Northeast” or “Revenue > $1 million”.

A filter is normally implemented in the SQL WHERE clause.

**grid unit** The individual attributes, metrics, consolidations, and custom groups that can be placed on a report grid.

**hierarchy** A set of attributes defining a meaningful path for element browsing or drilling. The order of the attributes is typically—though not always—defined such that a higher attribute has a one-to-many relationship with its child attributes.

See also: **user hierarchy**.

**HTML document** 1) A compound report displaying multiple grids and graphs.

2) The MicroStrategy object that supports such a report.
**implicit attribute** An attribute that does not physically exist in the database level.

1) In a data warehouse, facts are said to be stored at a particular level defined by the attribute IDs present in the fact table. For example, if a fact table has a Date column, an Item_ID column, and a fact column, that fact is stored at the Date/Item level.

2) With regard to metric calculation, the level is the level of calculation for the metric. For example, a metric on a report with Year and Store attributes would be calculated at the Year/Store level.

See also: **level of aggregation**.

**level** 1) In a data warehouse, facts are said to be stored at a particular level defined by the attribute IDs present in the fact table. For example, if a fact table has a Date column, an Item_ID column, and a fact column, that fact is stored at the Date/Item level.

2) In a metric calculation, the level is the granularity of where an attribute appears in its hierarchy, where that attribute defines how a related metric is calculated. For example, a metric on a report with Year and Store attributes would be calculated at the Year/Store level.

See also: **level of aggregation**.

**level of aggregation** The point in an attribute hierarchy where aggregation is performed. For example, in the geographical State--City--Store hierarchy there are three possible levels of aggregation.

**link** A connection in one report or document to another report or document. A link lets an analyst execute another document or report (the target) from a document or report (the source), and to pass parameters to answer any prompts that are in the target.
many-to-many  An attribute relationship in which multiple elements of a parent attribute can relate to multiple elements of a child attribute, and vice versa.

See also:
- relationship
- one-to-many
- many-to-one

many-to-one  An attribute relationship in which (1) multiple elements of a parent attribute relate to only one element of a child attribute, and (2) every element of the child attribute can relate to multiple elements of the parent.

See also:
- one-to-one
- one-to-many
- many-to-many
- relationship

metadata  A repository whose data associates the tables and columns of a data warehouse with user-defined attributes and facts to enable the mapping of the business view, terms, and needs to the underlying database structure. Metadata can reside on the same server as the data warehouse or on a different database server. It can even be held in a different RDBMS.

metric  1) A business calculation defined by an expression built with functions, facts, attributes, or other metrics. For example: \( \text{Sum(dollar\_sales)} \) or \([\text{Sales}] - [\text{Cost}]\).

2) The MicroStrategy object that contains the metric definition. It represents a business measure or key performance indicator.

See also fact.
**one-to-many** An attribute relationship in which every element of a parent attribute can relate to multiple elements of a child attribute, while every element of the child attribute relates to only one element of the parent. The one-to-many attribute relationship is the most common in data models.

See also:
- one-to-one
- many-to-many
- many-to-one
- relationship

**one-to-one** An attribute relationship in which every element of the parent attribute relates to exactly one element of the child attribute, and vice versa.

See also:
- one-to-many
- many-to-one
- many-to-many
- relationship

**page-by** Segmenting data in a grid report by placing available attributes, consolidations, and metrics on a third axis called the Page axis. Since a grid is two-dimensional, only a slice of the cube can be seen at any one time. The slice is characterized by the choice of elements on the Page axis. By varying the selection of elements, the user can page through the cube.

See also:
- drill
- pivot
- sort
- subtotal
**parent attribute**  The higher-level attribute in an attribute relationship with one or more children.

See also:

- child attribute
- relationship

**partial relationship**  An attribute relationship in which elements of one attribute relate to elements of a second attribute, while the opposite is not necessarily true.

See also:

- relationship
- one-to-many
- many-to-one
- many-to-many

**permission**  Defines for each object the degree of control that a user has over them.

**pivot**  To reconfigure data on a grid report by placing report objects (attributes, metrics, consolidations) on different axes. Also, to reconfigure a grid report by interchanging row and column headers, and hence the associated data. Subset of cross-tab.

See also:

- drill
- page-by
- sort
- subtotal

**privilege**  Defines what types of operations certain users and user groups can perform in the MicroStrategy system. For example, which objects a given user can create and which applications and editors he can use.
prompt  1) MicroStrategy object in the report definition that is incomplete by design. The user is asked during the resolution phase of report execution to provide an answer that completes the query. A typical example with a filter is choosing a specific attribute on which to qualify.

   2) In general, a window requesting user input, as in "type login ID and password at the prompt."

qualification  The actual condition that must be met for data to be included on a report. Examples include “Region = Northeast” or “Revenue > $1 million”. Qualifications are used in filters and custom groups. You can create multiple qualifications for a single filter or custom group, and then set how to combine the qualifications using the logical operators AND, AND NOT, OR, and OR NOT.

See also:
• filter
• custom group

relationship  An association specifying the nature of the connection between one attribute (the parent) and one or more other attributes (the children). For example, City is a child attribute of State.

See also:
• parent attribute
• child attribute
• partial relationship
• one-to-one
• one-to-many
• many-to-one
• many-to-many
**report**  The central focus of any decision support investigation, a report allows users to query for data, analyze that data, and then present it in a visually pleasing manner.

See also:

- **filter**
- **template**

**report creation**  The process of building reports from existing, predesigned reports in MicroStrategy Desktop or in MicroStrategy Web.

**report design**  The process of building reports from basic report components using the Report Editor in MicroStrategy Desktop or MicroStrategy Web.

**schema**  1) The set of tables in a data warehouse associated with a logical data model. The attribute and fact columns in those tables are considered part of the schema itself.

   2) The layout or structure of a database system. In relational databases, the schema defines the tables, the fields in each table, and the relationships between fields and tables.

**scorecard**  A popular means of displaying and distributing data from business intelligence projects. Scorecards typically follow a specific methodology and are focused on key metrics within a business area.

**series**  In a graph, it generally corresponds to the rows of a grid report. Series are represented as legend items in a graph.

**sort**  Arranging data according to some characteristic of the data itself (alphabetical descending, numeric ascending, and so forth).
source system  Any system or file that captures or holds data of interest.

subtotal  A totaling operation performed for a portion of a result set.

See also:
•  drill
•  page-by
•  pivot
•  subtotal

threshold  Used to create conditional formatting for metric values. For example, if revenue is greater than $200, format that cell to have a blue background with bold type.

user hierarchy  Named sets of attributes and their relationships, arranged in specific sequences for a logical business organization. They are user-defined and do not need to follow the logical model.

See also hierarchy.

view definition  Report execution steps which represent how the data is viewed and manipulated in the Intelligence Server. The view definition determines how the final report data set generated in the data definition steps is manipulated.
INDEX

A

access control list 116
Android
  configuring 135
  installing 134
Android application
  opening in a document 90
Android configuration 135, 169
  authentication 140, 142
  cache settings 137
attribute element prompt 31
  Barcode Reader prompt 36
  creating 33
  Geo Location prompt 35
  types 31
attribute element prompt (iPhone)
  display styles 33
audience xiii
authentication (Android) 140, 142
authentication (iPad) 140, 142
authentication (iPhone) 140, 142
authentication (Mobile Server) 117

B

Barcode Reader prompt 35
  attribute element prompt 36
  value prompt 36
best practices
  designing documents for MicroStrategy Mobile for Android 2
  designing documents for MicroStrategy Mobile for iPad 2
  designing documents for MicroStrategy Mobile for iPhone 2
  designing documents for MicroStrategy Mobile for the BlackBerry 110
  designing reports for MicroStrategy Mobile for the BlackBerry 108
BlackBerry Browser 161
BlackBerry Desktop Manager 162
BlackBerry Enterprise Server (BES)
  configuring Mobile 164
  installing Mobile 161
BlackBerry mobile device
  encrypted communication 117
Java .cod file for 161
C

caching
  installation settings (Android)  137
  installation settings (iPad)  129, 137
  installation settings (iPhone and iPad)  130
subscription and  186
troubleshooting  194
updating reports and  178
certificate server  117
client authentication  117
configuring
  MicroStrategy Mobile for Android  135
  MicroStrategy Mobile for BlackBerry  162
  MicroStrategy Mobile for iPhone  127
  MicroStrategy Mobile from the iPhone  157
creating
  Android configuration  135, 169
  iPhone configuration  127
creating a Mobile report subscription
  MicroStrategy Desktop and  190
  MicroStrategy Web and  188
customizing the Home Screen
  (iPhone)  146

document
  link to documents and reports  95
document (Android)
  designing for MicroStrategy Mobile  2
  formatting  10, 17
  link to documents and reports  95
document (BlackBerry)
  data view  111
  designing for MicroStrategy Mobile  110
document (iPad)
  designing for MicroStrategy Mobile  2
  formatting  10, 17
document (iPhone)
  designing for MicroStrategy Mobile  2
  formatting  10, 17
  link to documents and reports  95
document layout
  formatting  15

E

enabling real time updates
  (BlackBerry)  191
encrypted communication  117
example
  how to find  xi
  Image Viewer widget  46
  Information Window
    iPhone  53
    Map widget (iPhone)  61
  Interactive Grid widget  49
  Map widget
    iPhone  53
  Microcharts widget (iPad and Android)  70
  Multimedia widget  74
  Photo Uploader widget  75
  RSS Reader widget (iPhone)  79
Time Series widget \[82\]
Timeline widget (iPad) \[85\]

F
formatting
Android document \[10\]
BlackBerry document \[109, 111\]
document layout \[15\]
iPad document \[10\]
iPhone document \[10\]
Mobile View \[10\]

G
generating a URL for iPhone
configuration \[156\]
Geo Location prompt \[34\]
attribute element prompt \[35\]
value prompt \[35\]
Graph Matrix visualization (iPad) \[43\]

H
Heat Map widget (iPad) \[45\]
History List \[178\]
Home Screen (iPhone)
configuring \[145\]
customizing \[146\]

I
Image Viewer widget
creating in a document \[46\]
in a document \[46\]
Information Window (iPad)
creating \[21\]
Information Window (iPhone) \[61\]
installing
MicroStrategy Mobile client \[123\]
MicroStrategy Mobile client (Android) \[134\]
MicroStrategy Mobile client (BlackBerry) \[160\]
MicroStrategy Mobile client (iPhone) \[123\]
MicroStrategy Mobile for Android \[134\]
MicroStrategy Mobile for BlackBerry
client on a single device \[161\]
MicroStrategy Mobile for BlackBerry
client on individual devices \[162\]
MicroStrategy Mobile for BlackBerry
client on multiple devices \[161\]
MicroStrategy Mobile for iPhone \[123\]
MicroStrategy Mobile for the
BlackBerry \[160\]
MicroStrategy Mobile on Intelligence
Server \[115\]
Intelligence Server \[127, 135\]
Interactive Grid widget
creating in a document \[51\]
document \[49\]
international support \[xxii\]
iPad
document display when rotated \[10\]
iPad application
opening in a document \[90\]
iPad configuration
authentication \[140, 142\]
cache settings \[130\]
iPhone
document display when rotated \[10\]
iPhone application
opening in a document \[90\]
iPhone configuration \[127\]
authentication \[140, 142\]
cache settings \[130\]
Home Screen \[145\]
logging level \[129\]
URL 156

L
link (Android)
document to documents and reports 95
link (iPad)
document to documents and reports 95
link (iPhone)
document to documents and reports 95
logging level for iPhone configuration 129

M
managing Mobile report subscriptions 179
MicroStrategy Command Manager and 186
MicroStrategy Desktop and 182
MicroStrategy Web and 187, 189
prerequisites 180
Map widget
creating in a document 56
Geo Location prompt on 63
in a document 53
Information Window 61
Microcharts widget (iPad and Android)
creating in a document 71
in a document 70
KPI List mode 72
single column display 73
MicroStrategy Command Manager, subscription management through 186
MicroStrategy Desktop
privilege for managing subscriptions 190
subscribing multiple users to a report 182
subscribing to a report through 190
subscription management through 182
MicroStrategy Mobile
data security 179
displaying a report as a widget 36
document display when rotated 10
installing 115
Mobile View 10
opening a mobile device application 90
report subscription 179
MicroStrategy Mobile for Android
calling from a document 92
configuring 135
directions from a document 93
document design for 2
emailing from a document 92
formatting document for 10, 17
installing 134
mapping current location 92
opening a video from a document 93
texting from a document 92
MicroStrategy Mobile for iPad
directions from a document 93
displaying a web page from a document 93
document design for 2
emailing from a document 92
formatting document for 10, 17
mapping current location 92
opening a video from a document 93
MicroStrategy Mobile for iPhone
calling from a document 92
configuring 127, 157
directions from a document 93
document design for 2
<table>
<thead>
<tr>
<th>Emailing from a document</th>
<th>92</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting document for</td>
<td>10, 17</td>
</tr>
<tr>
<td>Installing</td>
<td>123</td>
</tr>
<tr>
<td>Mapping current location</td>
<td>92</td>
</tr>
<tr>
<td>Opening a video from a document</td>
<td>93</td>
</tr>
<tr>
<td>Settings screen</td>
<td>157</td>
</tr>
<tr>
<td>Texting from a document</td>
<td>92</td>
</tr>
<tr>
<td>MicroStrategy Mobile for the BlackBerry</td>
<td></td>
</tr>
<tr>
<td>Adding a project to</td>
<td>176</td>
</tr>
<tr>
<td>Configuring</td>
<td>162</td>
</tr>
<tr>
<td>Configuring from the BlackBerry</td>
<td>174</td>
</tr>
<tr>
<td>Configuring multiple devices automatically</td>
<td>164</td>
</tr>
<tr>
<td>Document design for</td>
<td>110</td>
</tr>
<tr>
<td>Installing</td>
<td>160</td>
</tr>
<tr>
<td>Installing on a single device</td>
<td>161</td>
</tr>
<tr>
<td>Installing on individual devices</td>
<td>162</td>
</tr>
<tr>
<td>Installing on multiple devices simultaneously</td>
<td>161</td>
</tr>
<tr>
<td>Real time updates</td>
<td>191</td>
</tr>
<tr>
<td>Report design for</td>
<td>108</td>
</tr>
<tr>
<td>Sample IT policy</td>
<td>168</td>
</tr>
<tr>
<td>MicroStrategy Web</td>
<td></td>
</tr>
<tr>
<td>Privilege for managing subscriptions</td>
<td>187</td>
</tr>
<tr>
<td>Subscribing to a report through</td>
<td>188</td>
</tr>
<tr>
<td>Subscription management through</td>
<td>187, 189</td>
</tr>
<tr>
<td>Mobile Server</td>
<td>127, 135</td>
</tr>
<tr>
<td>Mobile View</td>
<td>10</td>
</tr>
<tr>
<td>Multimedia widget</td>
<td></td>
</tr>
<tr>
<td>Creating in a document</td>
<td>74</td>
</tr>
<tr>
<td>In a document</td>
<td>74</td>
</tr>
</tbody>
</table>

### P

<table>
<thead>
<tr>
<th>Page-by on a report BlackBerry</th>
<th>108</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPad and</td>
<td>5</td>
</tr>
<tr>
<td>Panel stack</td>
<td>18</td>
</tr>
<tr>
<td>Permissions</td>
<td>116, 180</td>
</tr>
<tr>
<td>Photo Uploader widget</td>
<td></td>
</tr>
<tr>
<td>Creating in a document</td>
<td>75</td>
</tr>
<tr>
<td>In a document</td>
<td>75</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>xiii</td>
</tr>
<tr>
<td>Administering MicroStrategy Mobile</td>
<td>114</td>
</tr>
<tr>
<td>Permissions</td>
<td>116</td>
</tr>
<tr>
<td>Privilege</td>
<td>116</td>
</tr>
<tr>
<td>Privilege administrator</td>
<td>114</td>
</tr>
<tr>
<td>Command Manager</td>
<td>186</td>
</tr>
<tr>
<td>Managing subscriptions through MicroStrategy Desktop</td>
<td>190</td>
</tr>
<tr>
<td>Managing subscriptions through MicroStrategy Web</td>
<td>187</td>
</tr>
<tr>
<td>MicroStrategy Mobile client</td>
<td>116</td>
</tr>
<tr>
<td>Project</td>
<td>180</td>
</tr>
<tr>
<td>Viewing a document</td>
<td>180</td>
</tr>
<tr>
<td>Viewing a report</td>
<td>180</td>
</tr>
<tr>
<td>Project, adding to MicroStrategy Mobile for BlackBerry</td>
<td>176</td>
</tr>
<tr>
<td>Prompt</td>
<td></td>
</tr>
<tr>
<td>Android</td>
<td>25</td>
</tr>
<tr>
<td>Attribute element</td>
<td>31</td>
</tr>
<tr>
<td>Barcode Reader</td>
<td>35</td>
</tr>
<tr>
<td>Geo Location</td>
<td>34</td>
</tr>
<tr>
<td>iPad</td>
<td>25</td>
</tr>
<tr>
<td>iPhone</td>
<td>25</td>
</tr>
<tr>
<td>Value</td>
<td>27</td>
</tr>
<tr>
<td>Prompt (Android)</td>
<td></td>
</tr>
<tr>
<td>Geo Location on Map widget</td>
<td>63</td>
</tr>
<tr>
<td>Prompt (iPad)</td>
<td></td>
</tr>
<tr>
<td>Geo Location on Map widget</td>
<td>63</td>
</tr>
<tr>
<td>Prompt (iPhone)</td>
<td></td>
</tr>
<tr>
<td>Geo Location on Map widget</td>
<td>63</td>
</tr>
</tbody>
</table>
report
  access control list 116
  displaying as widget 36
  page-by navigation (iPad) 5
  security filter 116
  storing 179
  subscription 179
report (BlackBerry)
  data view 111
  designing for MicroStrategy Mobile 108
  page-by 108
report subscription
  creating in MicroStrategy Desktop 190
  creating through MicroStrategy Web 188
  managing 179
  managing through MicroStrategy Command Manager 186
  managing through MicroStrategy Desktop 182
  managing through MicroStrategy Web 187, 189
  prerequisites 180
  schedule 179
  subscribing multiple users to a report 182
support
  international xxii
  support. See technical support.
system administrator 114

time series widget
  creating in a document 82
  in a document 82
Time Series widget (iPad)
  creating in a document 85
Timeline widget (iPad)
  creating in a document 85
Transaction Services 25
trusted authentication 140, 141, 142, 143

un
  updating (BlackBerry)
    in real time 191
URL for iPhone configuration 156
V

value prompt 27
   Barcode Reader prompt 36
   creating 29
   Geo Location prompt 35

W

widget 36
   Data Cloud (iPad) 39
   Data Cloud (iPhone) 39
   Date Selection (iPad) 40
   Graph Matrix visualization (iPad) 43
   Heat Map (iPad) 45
   Image Viewer 46
   Interactive Grid 49
   Map 53
   Microcharts (iPad and Android) 70
   Multimedia 74
   Photo Uploader 75
   Time Series 82
   Timeline (iPad) 85